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Using This Guide

The Avid ISIS® media network provides a high-performance distributed file system that contains
high-capacity shared media storage for workgroups of connected Avid® editing workstations.

% This document describes the features for all Avid ISIS 7000 shared storage networks. Therefore,

your system might not contain certain features that are covered in the documentation.

Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

AN
Ja

(Windows), (Windows
only), (Macintosh), or
(Macintosh only)

Bold font

Italic font

Courier Bold font

A note provides important related information, reminders,
recommendations, and strong suggestions.

A caution means that a specific action you take could cause harm to
your computer or cause you to lose data.

A warning describes an action that could cause you physical harm.
Follow the guidelines in this document or on the unit itself when
handling electrical equipment.

This symbol indicates menu commands (and subcommands) in the
order you select them. For example, File > Import means to open the
File menu and then select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list
indicate that you perform one of the actions listed.

This text indicates that the information applies only to the specified
operating system, either Windows or Macintosh OS X.

Bold font is primarily used in task instructions to identify user interface
items and keyboard sequences.

Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font identifies text that you type.



If You Need Help

Symbol or Convention Meaning or Action

Ctrl+key or mouse action  Press and hold the first key while you press the last key or perform the
mouse action. For example, Command+Option+C or Ctrl-+drag.

If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is
especially important to check each step of your workflow.

2. Check the latest information that might have become available after the documentation was
published.

New information would be found in the ReadMe file supplied on your Avid software
installation kit as a PDF document and is also available online.

You should always check online for the most up-to-date release notes or ReadMe
because the online version is updated whenever new information becomes available. To
view the online versions, visit the Knowledge Base at www.avid.com/US/support.

3. Check the documentation that came with your Avid application or your hardware for
maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/US/support. Online services are
available 24 hours per day, 7 days per week. Search this online Knowledge Base to find
answers, to view error messages, to access troubleshooting tips, to download updates, and to
read or join online message-board discussions.

Accessing the Online Documentation

The Avid ISIS online documentation contains all the product documentation in PDF format. You
can access the documentation in the AvidISISDocumentation folder on the Avid ISIS installer
kit. You need to download and install Acrobat Reader on your Avid ISIS 5000 before you can
access the PDF documentation.

You need to download and install Acrobat Reader on your Avid ISIS 5000 before you can access
the PDF documentation.
To access the online documentation from the installer kit:

1. Insert your Avid ISIS USB flash drive with the Avid ISIS software kit into the USB port.

2. Navigate to the [USB flash drive]:\.AvidISISDocumentation folder, and double-click the
PDF file for the document you want to view.
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Avid Training Services
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Avid makes lifelong learning, career advancement, and personal development easy and
convenient. Avid understands that the knowledge you need to differentiate yourself is always
changing, and Avid continually updates course content and offers new training delivery
methods that accommodate your pressured and competitive work environment.

For information on courses/schedules, training centers, certifications, courseware, and
books, please visit www.avid.com/support and follow the Training links, or call Avid Sales
at 800-949-AVID (800-949-2843).


http://www.avid.com/support
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Avid Software and Hardware Install
Checklist

The following checklists summarizes the major steps for upgrading your software and hardware.
These checklists are for experienced administrators that acts as a reminder of the tasks that need
to be done in each upgrade. If you are not experienced with Avid ISIS, you should read this
entire book first before installing or configuring the Avid ISIS.

Each Avid ISIS release could have different upgrade requirements, you must read the
upgrade details in the ReadMe for each software release.

For detailed instructions on performing upgrades, see “Avid ISIS 7000 Upgrade Guidelines” on
page 137.

Software Upgrade

This section list the components and procedures to follow when performing a software upgrade
from Avid ISIS v1.4 and later to the current release. This does not include adding hardware. In
Avid ISIS v2.1.1 and later, Avid ISIS clients need to be upgraded before you upgrade the
infrastructure. This is necessary because ISIS client software before v2.1.1 is not supported in
the ISIS v2.1.1 infrastructure. Although, v2.1.1 client software is supported in v1.4 and later
infrastructures. Once the clients have been upgraded, you can upgrade Avid ISIS v2.1.1
infrastructure.

If you are upgrading from a version earlier than Avid ISIS v1.4, you must first upgrade to Avid
ISIS v1.4 before upgrading to v2.1.1, For instructions, see the vi.4 documentation.

The clients are defined as follows:

*  Avid editing applications

* Interplay Assist and Instinct

* Interplay Access

*  Avid Approved Applications Initiative such as Pro Tools and Final Cut Pro
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The infrastructure is defined as follows:

System Director — System Director software and upgrade Storage Blades (ISBs) and
Switch Blades (ISS/ISXs) in the Avid ISIS engines to the v2.1.1 firmware

Interplay servers — Interplay Engine, Interplay Media Indexer, Interplay Transfer, and
CaptureManager

Capture devices — AirSpeed, AirSpeed Multi Stream, and Avid Interplay Low-Res

Use the following checklist for a software upgrade:

Avid ISIS Software Upgrade

Complete

To be done

Q

Upgrade your Avid ISIS Clients, see “Loading Client Software” on page 98.

Before installing the new client software, save the client settings and preferences.
Depending on your Avid ISIS version, different Preferences settings are saved when
upgrading. For more information on what is saved per version, see the Avid ISIS 7000
ReadMe.

Perform a Failover first to make sure both subnetworks are functioning and have
updated metadata.

Shut down the Standby System Director Service first, then shut down the Active
System Director Service.

% This checklist assumes you have two System Directors. Completely update one
of the System Directors (allowing it to become the Active after it restarts), then
repeat the procedure on the second System Director (allowing it to become the
Standby). If you do not have two System Directors, you need only install the
software once.

Uninstall the Avid ISIS System Director software using the Windows Control Panel >
Add or Remove Programs.

Uninstall the “AvidUnityISISInstallers” using the Windows Control Panel > Add or
Remove Programs.

If you do not uninstall the old Avid ISIS Installers, the old installers remain in
the list with the new installers. Only the latest client software installers should
be available from the ISIS Management Console.

Check ReadMe to see if your Java Runtime is at the supported version for the new
software and update as necessary. You might need to update the Adobe®™ Flash®
software and Intel® network interface driver as well.



Hardware Upgrade

Avid ISIS Software Upgrade

Complete

To be done

Q

Q

Install your Avid ISIS software on the System Director, see “Loading the Software”
on page 87 and “Software Upgrade” on page 139.

Copy your Avid ISIS client installers on your System Director, see “Loading Client
Software” on page 98.

Upgrade all your ISBs, ISSs, and IXSs. Using the ISIS Management Console, select
all the ISBs and click Upgrade Storage Blades and then select all your ISSs and IXSs
and click Upgrade Switch Blades. You do not need to wait for the ISBs to be finished.
ISBs, ISSs, and IXSs can be upgrading at the same time. For more information, see
“Installing Software on the Engines” on page 94.

Watch the upgrade in the Monitoring tool.

ISIS v2.0 — wait until every ISS is at the “Install Waiting” state and then power
down all the Avid ISIS engines.

Power on the Avid ISIS engines in 1 minute intervals starting with the chassis that has
the IXSs. This reduces stress on the stack.

After the Avid ISIS engines restart, the ISSs continue with the install (no additional
user intervention is necessary).

For information on the Monitoring tool, see the Avid ISIS 7000 Administration Guide.

Make the newly upgraded System Director your Active System Director.

Perform these same procedures on the Standby System Director.

Hardware Upgrade

The firmware in the Avid ISIS hardware (ISBs and ISSs) is updated during the software upgrade.
The firmware is updated using the ISIS Management Console. You select all the ISBs and click
Upgrade Storage Blades and then select all your ISSs and click Upgrade Switch Blades. ISBs
and ISSs can be upgrading at the same time. For more information, see “Installing Software on
the Engines” on page 94.

If adding an engine to an existing system, see “Adding an Engine” on page 187.
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New System Director and Engine Installation

18

Use the following checklist when setting up an Avid ISIS for the first time:

Avid ISIS New Installation

Complete

To be done

Q
Q

Determine Network Address Scheme

Configure SD IP Addresses, see “IP Addressing Overview” on page 8§3.
o ISIS Left
» ISIS Right

* Management Port

In the 64-bit System Director, you need to change your default Internet Explorer 7
Security and Advance tab settings:

Click Tools > Internet Options and change the Security to the following:
* Internet - Medium

e Trusted - Low

Click the Advanced tab and change the following:

* Phishing Filter - Disabled

e Use SSL 2.0 - Enabled (checked)

e Use TLS 1.0 - Disabled (unchecked)

Install System Director and Installers, see “Software Installation” on page 87.

Create File Systems, see the Avid ISIS 7000 Administration Guide.
*  Open System Director Control Panel

*  Click “Stop System Director”

*  Go to “Configuration” tab

¢ Click “Create New Active”

Configure the first Engine (IP Addresses), see the Avid ISIS 7000 Administration
Guide.

e Start ISS Agent via Management port
* Under System > Basic set IP Address

Connect the System Director to Engine numberl, see “Connecting ISIS Hardware”
on page 70.



Switch and ISB Upgrade Utility

Avid ISIS New Installation

Complete To be done

Add Additional engine, see “Adding an Engine” on page 187.

Upgrade ISB and ISS, see “Installing Software on the Engines” on page 94.
Add Storage Elements, see the Avid ISIS 7000 Administration Guide.
Create Storage Groups, see the Avid ISIS 7000 Administration Guide.

Create Workspaces, see the Avid ISIS 7000 Administration Guide.

00000 Oo

Create Users, see the Avid ISIS 7000 Administration Guide.

Switch and ISB Upgrade Utility

The Switch and ISB Upgrade Ultility is a stand-alone application that allows field engineers to
perform switch and ISB upgrades from a laptop connected to Avid ISIS through the management
port, and monitor the upgrade progress. This utility does not replace the current upgrade process.
Its primary function is for upgrading a switch or a pair of switches that is incompatible with an
existing stacked network. Insertion of these switches into the network before the upgrade could
disrupt or compromise the network’s operation.

The typical procedure for loading the firmware on switches consists of selecting them with the
Avid ISIS Management Console and initiating an automated upgrade. This process is very useful
when upgrading a new or very interoperable Avid ISIS switch stack, see “Installing Software on
the Engines” on page 94.

To start the utility, insert the Avid ISIS installer DVD into a laptop’s DVD drive and double-click
AvidUtilityISISTool.msi located in the following location.

DVD drive\ISISUtilities

For Instructions on using the utility, see “Avid ISIS Upgrade Utility” on page 165.
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Recreating a File Systems

Deleting and creating a new file system is not common but if it is needed, this checklist
provides the order and tasks to be completed. All of the tasks listed in this checklist are
described in the Avid ISIS 7000 Administration Guide.

Use the following checklist when deleting and recreating a new file system:

Deleting and Creating a File System

Complete To be done

a Delete all files in all Workspace
[ | Delete Workspaces

a Delete Storage Group

Qa Remove Storage Elements

a Delete / Create New Active

20
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The Avid ISIS® system enables multiple clients to capture, play, and edit video and audio media.
This chapter provides an overview of the Avid ISIS 7000 system and the basic function of each
Avid hardware component within the system.

This guide describes how to connect cables between components that create a basic system and
then how to connect more than one basic system together to create a larger, redundant system.

For a explanation of what you need to do to prepare your site for installation of a Avid ISIS
system, see the Avid Products and Network Site Preparation Guide on the Avid Knowledge Base
or included in the documentation folder on the top level of the Avid ISIS installer software
installer kit.

Hardware Overview and Naming Convention

Each system component has a specific Avid name that define their function. It is important that
you are familiar with these terms while using the documentation. The following table, used in
conjunction with the figure that follows the table, provides the actual nomenclature and the terms
used in this guide to describe that nomenclature:

Product Nomenclature

Product name Term used and description

Avid ISIS shared storage network System or shared network storage environment

The Avid ISIS consist of the hardware, Avid
software, and other hardware supplied by the
customer, such as external Ethernet® switches.

Avid ISIS client Client, defined as a user’s workstation or server with
Avid ISIS client software that allows that system to
mount workspaces

Avid ISIS storage blade ISIS Storage Blade (ISB)

(labeled 1500, 11000, i2000) This hot swappable sled is accessible from the front

of the ISIS engine and contains two SATA drives.
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Product Nomenclature

Product name

Term used and description

Avid ISIS Integrated Ethernet switch blade

Avid ISIS Expansion Integrated Ethernet
switch blade

Integrated power supply and cooling fans

Avid ISIS engine

Avid ISIS System Director (Active and
standby)

ISIS Integrated Switch (ISS)

This hot swappable switch is accessible from the
rear of the ISIS engine and connects 1 Gb and 10 Gb
clients. The ISS2000 indicates second generation
hardware; first generation hardware is labeled
1SS1000.

ISIS Expansion Switch (IXS)

This hot swappable switch is accessible from the
rear of the ISIS engine is used to stack multiple ISIS
engines. The IXS2000 indicates second generation
hardware; first generation hardware is labeled
1XS1000.

Power supplies

Three hot swappable power supplies are accessible
from the rear of the ISIS engine. Two power supplies
is required to power the ISIS engines.

Called Chassis in the software interface

Contains the ISBs, ISSs, IXSs, power supplies, and
an internal midplane.

System Director, a server connected to the ISIS
engine to manage the data and portions of the
metadata

Although there are many components in Avid ISIS shared storage network, the basic
components needed to create the system are a System Director, an engine containing ISIS
Integrated Switch (ISS), ISIS Expansion Switch (IXS), ISIS Storage Blades (ISB), and one

or more clients.

The second generation ISIS switches are branded with an ISX2000 and ISS2000 silk-screen.
These switches cannot be mixed in ISIS engines with earlier versions of the switches
(labeled ISX1000 and ISS1000). If your ISX and ISS switches are not labeled, consider

them the earlier versions.

You cannot mix new switches (labeled ISX2000 and ISS2000) with original switch
hardware (labeled ISX1000 and ISS1000). All switches in the engine, and engines in the
stack must be from the same generation of hardware.



System Director

The Avid ISIS documentation refers to ISX2000 and ISS2000 switches as v2.x hardware and
ISX1000 and ISS1000 switches as v1.x hardware.

Basic Avid ISIS 7000 Shared Storage Network Hardware

Rear view Front view

\/\~<« ;}-
ISIS Integrated Expansion Switch (IXS) 24O\

ISIS Storage Blade (ISB) ——__ &

ISIS Integrated Switch (ISS)
Engine

System Director front view

The following sections explain these components and some basic client configurations:
*  System Director

*  Engine

»  Storage Configurations

*  Automatic Redistribution on Disk Failure

*  Client

*  Network Zone Configurations

* Cabling

System Director

The System Director is 1U in size (see “System Director Front Panel” on page 24) and manages
the metadata by storing directory information and file attributes. The System Director does not
store the data used by share clients (for example media files), these data files are stored on the
ISBs within the engine.
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%

The System Director password is preset to is-admin. Not not to be confused with the System
Director Web Page Administrator user whose default password is blank.

You can have two System Directors configured in a redundant configuration, one Active the
other Standby. If the Active System Director goes down, the Standby System Director takes
over. You need at least one System Director to run the Avid ISIS system.

System Directors, workgroup servers, and clients must all be synchronized with a common
time-of-day. For information on setting the Network Time Protocol (NTP), see “Setting-Up
Network Addresses In the Stack™ on page 71.

The System Director provides a location to coordinate file access modes (read/write), file
locking, range locking, performance data collection, logging, file lookup, and directory
change tracking for client systems. Examples of what the System Director is able to provide
to a client or storage element are:

» Identity of all storage elements connected to the system

* Information about the ISS and IXS modules in the configuration.
» List of workspaces to include name and their unique ID number
» List of users and groups within the system

* Identity of all System Directors in the system (if you have more than one System
Director)

System Director Front Panel
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The following figure shows the front view and control panel of the System Director.
System Director Front View
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System disk (ID 0)  System disk (ID 1)

The following table describes the control panel shown in the previous figure.



System Control Panel

System Director

Letter Component

Description

A

Universal Serial Bus (USB) port

Halt or Non-maskable interrupt
(NMI) button

System reset button

Four green network activity
LEDs

Red System error LED

System Drive activity LED

System ID button

Power button

USB 2.0 device port on the front of the system supports one USB
device. Recommended for use when re-imaging the system drives or
loading software. Two more USB ports are located on the back of the
system.

The halt or NMI signal halts the processor, which effectively halts
the server. A NMI is the highest priority interrupt and cannot be
masked by software.

If the Halt/NMI button is pressed, the NMI signal locks the
system and the system must be restarted to clear the
interrupt.

Preforms a soft reset when pressed. Do not use this button unless the
system has had a fatal error and you need to restart. A soft reset
restarts the system; it clears all active program memory (you lose
unsaved work) and shuts down all active programs.

Illuminates green when a good network connection is established and
blinks when there is network activity on the four built-in 1-GB
network ports.

The number beside the LED corresponds with the number beside the
network port on the rear of the enclosure. For example, Connector 1
is LED 1 on the front. See “System Director Rear Panel” on page 26.

[lluminates red when an error is detected with the system (fan, power
supply, temperature, voltage).

Indicates drive activity from the onboard SATA controller and blinks
when either of the system drives is being accessed.

When pressed it illuminates (blinks) blue and also illuminates an
LED on the rear of the enclosure. The rear LED is also blue and is
visible on the lower left-hand side of the Ethernet ports inside of the
enclosure. It is used to identify a system for servicing when it is
installed in a high-density rack/cabinet populated with several other
similar systems.

Press to power on the enclosure. Power button illuminates green
when the power is on.
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System Director Rear Panel

The following figure shows the rear panel of the System Director and the function of each
connection.

System Director Rear View

Power supplies Slots not used
@
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OOOOOO(E 00000000000000000000
0000 ‘ [PPLPLP |

1 Gb Ethernet USB Video Serial

Second System Director

You can purchase a second System Director and configure it on the same subnets as the
original System Director. This provides a redundant System Director that is in constant
contact with the original System Director. The second System Director automatically takes
over if the original System Director fails (called failover).

For true redundancy it is recommended that you connect the second System Director to a

different engine than the first System Director. The Active and the Standby System Directors
must be the same model server, you cannot mix SR2400s, SR2500s, and AS3000 servers.
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Engine

Engine

The engine contains the ISBs, ISSs, IXSs, power supplies, and an internal midplane. The engine
stores the data created and shared by the clients. The data is passed in and out of the engine
through the switches.

The engine contains:

* ISBs can support either 250 GB, 500 GB, or 1 terabytes (TB) drives, with two drives in each
ISB. The size of the drives are identified by the label on the front of the ISB (1500, 11000, or
12000, respectively). As technology advances, the storage capacity of the drives could
increase, allowing the total storage per ISB/engine to increase.

* An ISS provides connections for clients via 1000BASE-T Ethernet ports. A 10-Gb Ethernet
port using SFP+ transceivers connects clients or serves as an uplink port. There is an engine
interconnect port and a management port for configuration. See “Integrated Ethernet
Switches” on page 29.

* An IXS used when you have more than two engines (need an IXS for each subnet), allowing
you to connect multiple engines providing up to 384 TB of storage, or 192 TB of mirrored
storage. See “Integrated Ethernet Switches” on page 29.

Engine Front View

The front of the engine allows access to the 16 ISBs. The first is in the upper left portion of the
front and the last ISB is in the lower right.
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Each ISB can be removed and replaced separately with the power on.

If you replace an ISB with power on, the LEDs in all of the ISBs go off momentarily. This does
not represent a problem. All functions are still active and working properly.
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Engine Rear View

The following figure shows the rear of the engine in a configuration that contains the
following:

e Three power supplies (with fans)

* Integrated Switch blade (ISS)

* Integrated Expansion Switch blade (IXS)

In a basic configuration containing two engines, each of the engines contains two ISS

modules. The IXS module is used with an ISS module in an engine only when the
configuration goes beyond two engines.
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ISS module IXS module

Power Supplies
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The power supplies are powered on when the power cord is plugged in; they do not have
power switches. The power supplies not only provide power, but they also contain fans that
cool the system. The system only needs two of three power supplies to supply the needed
power to function properly. You can remove and replace a power supply temporarily while
the system is running if one fails.

You should leave the failing power supply in place until you replace the failing power
supply. Replace the power supply as soon as possible to maintain the proper airflow. Do
not remove the failing supply until immediately before you replace it.

Only trained Avid technicians should remove and replace the power supply while the
system is running. Since power to the system is still applied internally to the midplane
you must always keep your hands external to the engine when a power supply is
missing from the engine.



Engine

Integrated Ethernet Switches

The two integrated Ethernet switches, ISS and IXS, serve different purposes and contain
different types of connections. You must have at least two switches in each engine for the system
to operate.

ISS Module

The connections on the ISS module are used for the following:

*  Management connection — used to configure the Avid ISIS 7000 engine hardware during
installation. This information is used by Avid representatives to originally configure your
system before turning it over to you.

e 1-Gb (RJ-45 cable) — direct connect for clients and the System Directors.

*  High speed engine interconnect (CX-4 cable) — proprietary Avid bus that connects switch
blades between engines allowing subnets to connect between the engines.

*  10-Gb XFP or SFP+ MSA form factor transceiver (for Optical cable) — used for a 10-Gb
connection to a switch or 10-Gb Ethernet clients.

@ Only an Avid recommended SFP+ transceiver should be used in the 10-Gb XFP
connection, and only Avid trained representatives should remove and replace the XFP
transceiver. Currently supported XFP are the Picolight XFP and Foundry® XFP.

Link  Activity

Activity Link
in

Status

S e -
Jorrrrrrrress)

Manage.ment 1-Gb connections High speed engine  10-Gb connection
connection interconnect (Hi-Gig)
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=

IXS Module

The IXS is needed only if you are connecting three or more engines. When connecting three
or more engines, two IXS modules are installed in one engine. The IXS offers the following
connections:

*  Management connection — used to configure the switch during installation and monitor
switch functions.

*  High speed engine interconnect (Hi-Gig) — proprietary Avid interconnection that
stacks the switches to create one large virtual switch.

Activity
/
Link

O (= |@| |@| |@| |@| |@|
@fﬁ]

Management o .
connection Engine interconnections

In a basic configuration containing one or two engines, each of the engines contains two ISS
modules. The IXS module is used with an ISS module in an engine only when the
configuration goes beyond two engines.

Storage Configurations

A maximum of twelve Avid ISIS Engines can be stacked and populated with either 250 GB,
500 GB, or 1 terabytes (TB) SATA drives. A fully populated Avid ISIS system with 1 TB
drives provides up to 384 terabytes (TB) of storage, or 192 TB of mirrored storage.

You can have mixed ISB drive sizes in an engine (250 GB, 500 GB, and 1 TB drives). You
can even mix the different size ISBs in a Storage Group. Although, the larger ISBs in the
mixed Storage Group only use the amount of storage that is available in the smaller ISBs.

Storage Group Size

30

Storage elements are combined to create Storage Groups in the ISIS file system. These
Storage Groups can be configured to either operate using 512 KB (default) or 256 KB chunk
sizes. Earlier Avid ISIS releases used 256 KB chunk sizes. For more information about
setting the chunk size, see the Avid ISIS 7000 Administration Guide.



Storage Configurations

% Avid ISIS 7000 switch hardware shipped with vi.x (ISS1000 and 1XS1000) does not support 512
KB chunk sizes. If you have Avid ISIS 7000 v2.x software running on v1.x switches, you must
select the 256KB chunk size when adding storage elements to the file system to create Storage
Groups.

You cannot change the chunk size of a Storage Group once the Storage Group has been created.
To change the chunk size of an existing Storage Group, you must delete the Storage Group and
create a new Storage Group with the desired chunk size. The chunk size selection is only
available when adding the storage elements.

& When you delete Storage Groups all data on that Storage Group is lost.
Chunk Size Support With ISB

All ISBs (1500, 11000, and 12000) support the 512 KB chunk size. Although you must have the
new v2.x switch hardware (ISS2000 and 1XS2000) to use the 512 KB chunk size.

Adding an ISB to the File System

If you add an ISB (displays as an available storage element) to your file system, make sure you
match the chunk size of the new storage element to the chunk size of the existing storage group.
New storage elements are added with a default chunk size of 512 KB. You cannot mix chunk
sizes within a Storage Group. To change the chunk size of an ISB, you must remove the new

storage element from the file system and add the storage element again choosing the correct
chunk size.

Adding or Removing ISBs (Mirrored or RAID)

When permanently adding or removing ISBs from an ISIS Storage Group it is recommended to
do a full redistribution for all workspaces in the Storage Group. The full redistribution should be
done after the ISB add or remove is complete. Examples of permanent changes would be adding
or removing an engine to the storage stack.

The full redistribution makes sure all blocks in the Storage Group are optimally distributed based
on the new permanent configuration. Doing a full redistribution immediately after the permanent
adds or removes minimizes the chances of running into issues if a full redistribution is required
in the future. One potential issue would be the storage blades getting full during a full
redistribution and requiring the user to delete files to allow the redistribution to complete.

This recommendation does not apply to the case of removing and then replacing failed storage
blades. For other examples of symmetric and non-symmetric redistributions, see the Avid ISIS
Performance and Redistribution Guide on the Knowledge Base at www.avid.com/US/support.
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Moving Workspaces Between Storage Groups

You can move workspaces between Storage Groups that use the same chunk sizes.
Workspaces cannot be moved between Storage Groups of different chunk sizes (256 KB and
512 KB chunk sizes),

A Tech Alert has been written describing the process for moving data from a 256 KB chunk
size workspace to a 512 KB chunk size workspace. Search the Avid Knowledge Base at
www.avid.com/onlinesupport/ for Avid ISIS v2.x Moving Workspaces using RichCopy in the
Avid ISIS Tech Alerts.

Clients should not access workspaces that are in the process of being moved when it is a
256 KB chunk size workspace being moved into a Storage Group with a 512 KB chunk size.
Avid recommends that clients unmount these workspaces until the move is complete to avoid
an unintentional access. Once the move begins, it cannot be cancelled.

Mirrored Storage Groups, Single ISB Failure

32

It is considered an “unprotected state” if you have a single ISB failure in a mirrored Storage
Group. In an unprotected state with no additional failures, read operations continue to
function normally.

However, in an unprotected state a subsequent or infrastructure failure will cause operational
issues which could result in failures when writing new data or prevent you from accessing
data in the Storage Group. An additional ISB failure creates a situation in which data
accessibility has been compromised. Networking issues, on the other hand, will not cause
accessibility issues on previously written data but might prevent the successful completion
of the active write operation.

This issue only applies when the Storage Group is in an unprotected state and the remove
redistribution process on the failed ISBs has not been initiated. Therefore, it is highly
recommended that the remove redistribution process is initiated immediately upon
confirmation of any ISB failure. This ensures immediate protection (RAID or mirroring) of
new data being written, and full protection of all stored data at the earliest possible time.
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Storage Configurations

RAID-6 Storage Groups

Avid ISIS supports a two types of data protection. Besides mirrored Storage Groups, you can
create redundant array of independent disks (RAID) Storage Groups. RAID storage offers more
value in that it provides more storage at a lower cost per GB. Using the Avid Interplay
Copy/Move service, data files can be moved from mirrored Storage Groups to and from RAID
Storage Groups. The following are two obvious advantages to using RAID Storage Groups:

Migration from mirrored to RAID workspaces can become part of your normal workflow.
You can move the data that is no longer used in the mirrored workspaces to RAID
workspaces for longer term storage. This frees up faster storage elements (mirrored) for
higher performance work.

RAID Storage Groups allow you to work on a lower resolution workflow at less cost.

RAID Storage Groups increases available GB per physical engine from 50% in mirrored to
75% in RAID of installed capacity.

The following is a list of RAID workspace restrictions:

Requires a Storage Group with a 512 KB chunk size (256 KB chunk sizes are not
supported).

Requires ISIS v2.x generation switches (ISS2000/IXS2000) in the ISIS Engines (these
switches are also required for 512 KB chunk sizes).

Avid recommends RAID Storage Groups have a minimum of 16 ISBs (one engine). The
Management Console allows you to create and use RAID Storage Groups with eight ISBs
but with in a RAID Storage Group of eight, you must add an ISB before you can remove an
ISB.

Avid ISIS client software versions before v2.1.1 are not supported with RAID.

RAID workflows require specific releases of Avid products that support the workflow
(AirSpeed Multi Stream, Avid editing applications, and Interplay), see the Avid ISIS 7000
ReadMe.

Supports only resolutions that draw 16 MB/s (50 Mb/s) or less.

For example, you can run two streams of DV 50 or DNxHD 36. Bandwidths are listed by
resolution and number of streams on the Avid Knowledge Base. Search the Avid Knowledge Base

for the Avid ISIS Performance and Redistribution Guide.

If a RAID Storage Group experiences two disk failures, no writes to any of the workspaces
in that Storage Group are supported until the error condition is corrected.

If you need to do a non-symmetrical full redistribution, you must first limit the bandwidth
used by your clients in that Storage Group. For more detailed guidance, see the Avid ISIS
Performance and Redistribution Guide on the Knowledge Base at
www.avid.com/US/support.
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Avid does not recommend a non-symmetric redistribution when your RAID Storage
Group capacity exceeds 80%.

RAID-6 Storage Groups, Single ISB Failure

When there is a single ISB failure in an ISIS Storage Group configured with RAID
protection, the Storage Group continues to function normally at a lower bandwidth. For
mirrored Storage Groups, see “Mirrored Storage Groups, Single ISB Failure” on page 32.

After confirming the failure of an ISB, it is highly recommended that you initiate the remove
redistribution process of the failed ISB immediately. There are two benefits to doing this:

»  First, immediately upon initiation of the remove redistribution, all new writes to the
Storage Group have the full benefit of RAID-6 protection (dual-parity protection).

* Second, upon completion of the remove redistribution process, existing data in the
Storage Group is once again fully protected. Prior to completion, if another ISB were to
fail, the Storage Group would be in an unprotected state (though no data would be lost).

RAID-6 Storage Groups, Dual ISB Failure

It is considered an “unprotected state” if you are with two failed ISBs in a RAID-6 Storage
Group. In an unprotected state with no additional failures, read operations continue to
function normally at a lower bandwidth.

However, in an unprotected state, due to the distributed architecture of the ISIS file system
(optimized for real-time performance), it is possible under certain circumstances that the
system would not be able to correctly update the parity information when writing new data.
As a result under these circumstances, the file system could return a failure status when
writing. While the failure rate percentage on the total number of write operations is low,
heavy workloads on the system would result in enough write failures to disrupt operations.

This issue only applies when the Storage Group is in an unprotected state and the remove
redistribution process on the failed ISBs has not been initiated. Therefore, it is highly
recommended that the remove redistribution process is initiated immediately upon
confirmation of any ISB failure. This ensures immediate protection (RAID or mirroring) of
new data being written, and full protection of all stored data at the earliest possible time.

Automatic Redistribution on Disk Failure
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Avid ISIS performs an automatic redistribution on Disk Failure notification. Storage
Elements continuously monitors disk status and sends a “Disk Failed” notification to the
System Director upon determination that a disk is not usable. The System Director then
removes the Storage Element from its associated Storage Group. The removal of the Storage
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Element from the Storage Group initiates redistributions on all workspaces associated with that
Storage Group. The System Director then prevents the Storage Element that reported the disk
failure from being added to a Storage Group.

The Automatic Removal feature is controlled by a system preference that is configured using the
ISIS Management Console Preferences tool. The preference is called “Auto Remove
Redistribution on Disk Failure” The default setting is “enabled.” The Storage Element is only
removed from the Storage Group. It is not unbound from the ISIS Systems for the following
reasons:

*  The Storage Element participates in the removal redistribution. This is required to prevent
data loss when there are un-protected workspaces or when full redundancy has not been
attained for all data blocks.

* The Storage Element continues to report status, such as physically replacing the blade.

Auto removal status is reported by way of the System Event Log. A sequence of event log entries
are generated for the initial report of the failure, the decision to remove the Storage Element, and
subsequent success or failure. Events are also logged for the start and stop of all the workspace
redistributions.

The following are important considerations when using Automatic Redistribution:

*  When automatic redistribution is enabled, be sure to keep at least 7% of your Storage Group
unused at all times. Failure to do so can cause the system to run out of space after an
automatic redistribution has initiated and cause a client outage.

« If an automatic redistribution of a Storage Group is started during a critical time the overall
system performance can degrade significantly and be disruptive. For more information on
understanding the performance characteristics during remove redistribution, see the Avid
ISIS Performance and Redistribution Guide.

* An automatic redistribution removes the Storage Element from the Storage Group but not
from the file system. Once an automatic redistribution has occurred and completed, the
removed Storage Element should be removed from the file system. You must first removed
the Storage Element with the software and then physically replace it. A replacement ISB
must then be added to the file system and then the Storage Group, triggering another
redistribution.

* Ifunmirrored workspaces are in use, the data will be damaged on those workspaces in that
Storage Group.
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Client

A client uses services provided by the Avid ISIS architecture. The client system, using a

1 Gb or 10 Gb Ethernet connection, communicates with the ISBs through the ISS to create,
modify, and read files stored in the actual ISB. Avid ISIS 7000 supports up to 330 clients
(150 active clients), each using dual-stream video and up to 8 tracks of audio.

A client uses mechanisms specific to the operating system to display, create, and delete files
within the Avid ISIS shared storage network system. For example, when viewed from a
Windows operating system, the system sees a server containing many shares that are mapped
to drive letters.

Network Zone Configurations
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All clients in the shared storage network are classified by zones, depending on how they
connect to the network. The following list defines the clients in each network layer by their
zone classification:

A System Director must be attached to both subnets, but can only be attached once to each
subnet.

* Zone 1 Client — Connected to ISIS VLANSs via an ISS 1 Gb or 10 Gb port (direct
connect)

*  Zone 2 Client — Connected to ISIS VLANs viaa 1 Gb or 10 Gb port on an Avid
qualified layer-2 switch (non-routed)

*  Zone 3 Client — Connected to an Avid qualified layer-3 switch (routed) with known
Quality of Service (QoS); traffic routed to ISIS (one hop) and load-balanced across ISIS
VLANSs (approximately a 60/40 ratio)

*  Zone 4 Client — Connected to the house network using an edge or a core switch with
unknown QoS; traffic routed to Avid ISIS (measured by the number of hops) and
load-balanced across ISIS VLLANSs (approximately a 60/40 ratio)

Clients which can connect to one zone can run in any lower-numbered zone — for example,
a Zone 3 client can also run as a Zone 2 or Zone 1 client.

Support for different client and device types vary by zone:

* Zone 1 — AirSpeed playout, Transfer Manager

» Zone 2 — AirSpeed ingest, editors, MediaManager, Interplay
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*  Zone 3 — MediaManager Select, Instinct, Assist, certain editors (for example,
Avid NewsCutter); typical formats include DV25, DV50/IMX-50, MPEG-2 proxy (2 Mb/s)

*  Zone 4 — MediaManager Select, Instinct, Assist; typical formats include DV25, MPEG-2
proxy (2 Mb/s)

The following four examples show different types of Avid ISIS 7000 configurations.

Zone 1 Clients (Direct Connected)

Any client that is connected directly to an ISIS is considered a Zone 1 or direct connected client.
Each Integrated Switch Blade has a total of eight, 1 Gb Ethernet ports and one 10 Gb Ethernet
port. A single engine has the capacity to support 18 clients or servers, subtracting any ports that
are to be used by the System Director(s). The following table defines the total number of 1 Gb
ports in Zone 1 based on what is available by the number of engines and System Directors in the
configuration. In addition, each ISS2000 provides a 10 Gb Ethernet port connection for one 10
Gb client.

Connect TransferManagers and AirSpeed servers to Zone 1 or Zone 2.

A Zone 1 (direct connect) configuration consists of a group of clients connected directly to the
1-Gb and 10-Gb connections of the ISS in the engine. The System Director also connects to both
subnets via both ISS modules using a 1-Gb port.

Avid ISIS 7000 Zone 1 Network Configuration

Intel Pro 1000
Client systems MT/PT board
in Zone 1 /

10 GB board 10 GB board
~
=
[m] [m] [m]

[m] [m]
S p——
10 GB ethernet > 10 GB ethernet
=SS e = 1 GB ethernet

Engine
ISS | | |
< Chassis

interconnect

Engine
ISS | | 1SS
1

| System Director |
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1 Gb Ports in Zone 1

1SS1000 and 1XS1000 Switches

1SS2000 and 1XS2000 Switches

Number Two System Two System
of ISIS One System Directors One System Directors
Engines Director (failover) Director (failover)
1 14 12 14 12

2 30 28 30 28

3 307 287 30a 28a

4 46 44 46 44

5 62 60 62 60

6 78 76 78 76

7 94 92 94 92

8 110 108 110 108

9 110° 108b 126 124

10 126 124 142 140

11 142 140 158 156

12 158 156 174 172

a. This is due to the use of IXS switches instead of an ISSs.
b. This is due to the use of two more IXS1000 switches instead of an ISS.

Zone 2 Clients (Indirect Connect) Configuration

38

There is support for external switches connected through the 10-Gb port on each ISS.
Clients that are connected to an external switch are referred to as Zone 2 clients. For a list of
supported switches, search the online Knowledge Base at www.avid.com/onlinesupport.

A Zone 2 (indirect connect) configuration consists of group of clients connected to an
Ethernet switch with a 10-Gb port connected to an ISS located in the engine. The System
Director also connects to both subnets via both ISS modules using a 1-Gb port. Depending
upon the switch configuration, each client shown connected to the external switch is
connected to one of the two subnets through one of the two 10-Gb connections.
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Network Zone Configurations
Avid ISIS 7000 Zone 2 Network Configuration

Client systems Intel Pro 1000
in Zone 2 MT/PT board

5t el
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External Switch with two 10-Gb Ports
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g u] Intel Pro 1000

ISS [ | Client system MIEbeatd
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interconnect

1 GB ethernet
\%

Engine
| | s
1 1

| System Director | zone 1

IS

As an example, you can configure a 24-port switch for three VLANs with Gigabit (Gb) Ethernet
ports 1 to 12 and 10-Gb Ethernet port 25 reserved for VLAN 10 (default ISIS VLAN
configuration). Gigabit Ethernet ports 13 to 23 and 10-Gb port 26 are reserved for VLAN 20
(default ISIS VLAN configuration) and Gb port 24 is reserved for the switch’s default VLAN.
The 10-Gb ports connected to the ISIS are also serving as uplinks to the ISIS for clients on either
VLAN. Each VLAN on the switch is connected to the appropriate VLAN in the shared storage
network using the 10-Gb port.

Zone 2 Switch

10-Gb ports 1-Gb ports
O Ports 1 - 12 Ports 13 - 24 O

Port 25 Port 26 EH Eg

O o®e (MMM Port24 O
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Zone 1

40

Each VLAN on the switch is allowed to support up to 12 connections but the size of the
Storage Groups and engine determine the overall client count. Changing the switch
configuration to increase the number of clients on a single VLAN is not supported and can
result in unpredictable system performance. Client count can be scaled according to the
number of available switches.

The following table provides possibilities of Zone 2 client counts based on the number of
ISIS engine and switches. For each engine listed in the table, there is an associated 24-port
switch. The exception is with three engines, in which the IXS does not provide additional
ports.

Available Zone 2 Ports

Number of Engines 24-Port Switch Count External Switch Ports
1 1 23
2 2 46
3 2 46°
4 3 69

a. This is due to the use of an IXS board instead of an ISS.

The previous table does not reflect the use of Zone 1 Clients (Direct Connect), which at a
minimum could consist of one System Director, AirSpeed devices, and TransferManagers.
Mixing Zone 1 and Zone 2 clients in an ISIS shared storage network is discussed in the next
section.

There is no current support for an external switch to be connected with the use of a 1 Gb
connection as performance for multiple clients cannot be guaranteed over a single 1 Gb
connection.

and Zone 2 Clients Mixed Configuration

The number of ports available on the ISS (Zone 1) makes it necessary to add another layer of
clients through a qualified network switch to create a (Zone 2) in the ISIS shared storage
network.

A mixed configuration (Zone 1 and Zone 2) consists of clients connected directly and
indirectly through ports on the engine’s ISS. Also shown are two System Directors that
connect to the engine via two separate ISS 1-Gb ports for use as a redundant System
Director in case of a failure. Both System Directors also connect to each other through the
onboard Ethernet connections to monitor if one of the System Director fails.



Network Zone Configurations
Avid ISIS 7000 Zone 1 and Zone 2 Mixed Network Configuration
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% Although it is not shown in the previous diagram, to ensure high availability, whenever possible,
the System Directors should be connected to two different subnets through two different engines.

Zone 3 and Zone 4 Client Configuration

A Zone 3 (indirect connect) configuration consist of a group of clients connected to an Avid
qualified layer-3 switch (routed) with known Quality of Service (QoS); traffic routed to ISIS
(one hop) and load-balanced across ISIS VLANSs (approximately a 60/40 ratio)

A Zone 4 (indirect connect) configuration consists of group of clients using an edge or a house
Ethernet switch with unknown QoS; traffic routed to Avid ISIS (measured by the number of
hops) and load-balanced across ISIS VLANSs (approximately a 60/40 ratio)

This switch is normally connected to a house switch that has uplinks to the Avid Production
Network through an Ethernet switch that contains a 10-Gb port connected to an ISS located in
the engine. The System Director connects to the both subnets via both ISS modules using a 1-Gb
port.
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Avid ISIS 7000 Zone 3 and Zone 4 Network Configuration
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A link aggregation configuration supports Zone 2, Zone 3, and Zone 4 clients.
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Cabling

For a list of cables qualified with the Avid ISIS system, see “Supported Cabling” on page 206.
The following sections provide cabling information you should know when cabling your Avid
ISIS stack.

Connecting the Engine CX-4 Cable

The CX-4 cable is referred to as the Avid engine interconnect cable. It connects the engines
through the integrated Ethernet switches (ISS and IXS) to create the Avid ISIS stack.

To connect the cable:

P Place it in the connector at the rear of the system.

You hear a snap, and the cable is connected.

Damage can occur when disconnecting the Avid engine interconnect cable from the switch
board if not done properly.

% Care should be taken to reduce strain on the ISS switch blades by organizing and dressing the
ethernet cables and CX-4 cables. When dressing the cables do not block removable switch and
power components.

Removing the Avid Engine Interconnect Cable

The following explanation and illustration explain how to properly remove the engine
interconnect cable.

& If you attempt disconnect the cable by pulling the blue cable release towards you and
pulling the cable out from the connector at the same time you can cause the cable and or
connector to be damaged.
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To remove the Avid engine interconnect Cable from the Rear Connector:

1. While the cable is in the connector, use your bottom hand to grab the cable (or the metal
portion of the connector) and push the cable (or metal portion of the cable) towards the
connector at the rear of the engine.

2. While keeping the pressure towards the engine connector using the cable (or the metal
portion of the connector), use the top hand to pull the blue portion of the cable directly
back. This dislodges the connection of the cable from the connector.

Bottom hand
pushing cable

Pull back on blue
cable release

towards engine

3. Pull back with both hands to remove the cable.

10-Gb Link Aggregation Overview
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%

The 10-Gb Link Aggregation functionality supported by the Avid ISIS 7000 software is
described in the following sections. For a procedure on creating a Link Aggregation Group,
see “Configuring a 10-Gb Link Aggregation Group” on page 102. When configuring a
Hi-Gb link aggregation for ten- and twelve-engines, see “Hi-Gig Link Aggregation Group”
on page 82.

Link aggregation is a method of combining physical network links into a single logical link
for increased bandwidth. With Link aggregation, your are able to increase the capacity and
availability of the communication channel between devices (both switches and clients) using
existing Ethernet technologies. Two or more 10-Gb Ethernet connections can be combined
to increase the bandwidth capability and to create resilient and redundant links. Link
aggregation is sometimes known as “Trunking.”

Link aggregation also provides load balancing across several links in a link aggregation so
that no single link is overwhelmed.

You must disable link aggregation before creating or modifying your Avid ISIS stack. After
your stack has been created, reconfigure your Link Aggregation Groups.
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Supported in Link Aggregation

Avid ISIS 7000 supports 10-Gb link aggregation (between the ISS and the Avid Production
Network switch) and Hi-Gig link aggregation (between two IXS). Avid ISIS software supports
the link aggregation standard clause 43 of 802.3-2005 (also known as 802.3ad).

Number of Groups Supported

A link aggregation group refers to a number of links that combine together to form a single link
aggregation. The number of link aggregation groups supported in Avid ISIS 7000 is five.

Number of Members Supported

A link aggregation group can have a maximum of eight members. This means no more than eight
10-Gb links can be combined into one link aggregation group per VLAN. The minimum number
of link aggregation members in a group is 2.

For performance reasons, Avid recommends that you maintain an even number of link
aggregation members. So for an eight engine stack, you can have a link aggregation group with
two, four, and six members. For a ten or twelve engine stack, there can be two, four, six, and
eight members in a link aggregation group.

If a member is already part of a link aggregation group, it cannot be part of another link
aggregation group. You also cannot create a link aggregation group with a single member.

Load Balancing

The software balances the load across multiple 10-Gb aggregated links based on source and
destination IP addresses.

Failover

If a 10-Gb trunk link fails, the software load balances the traffic among the remaining trunk
links. For example in a four-way 10-Gb trunk if a single 10-Gb link fails, the traffic is load
balanced among the remaining three links. This also means that the average traffic distribution
increases from 25% with the four links, to 33% in the three links. Therefore, it is strongly
advised that network planners setup the trunks to handle the additional load if a link or a set of
links should fail in a trunk configuration. The traffic automatically re-balances the load when a
trunk link returns.

Warning messages are sent to ISIS Management Console notifying you that a 10-Gb aggregation
link status has changed. Switch diagnostics also provides errors when you have a failed link in a
trunk.
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The engine menu within the ISIS Management Console flashes a yellow warning triangle
notifying you that a 10-Gb Link Aggregation link has changed. The specific engine displays
a yellow warning circle, and the Switch Blade Status displays “1 Error(s).” Details on the
engine switch displays a status of “Link Warning.” You can then open the Switch Agent page
via the “info” button on the engines details page, and look at the Port Status page to verify
the 10-Gb Link Status.

This failover feature functionality can be disable in switch agent page.

Recommended Topologies

For the best performance in stacks with two IXSs, the link aggregation members need to be
evenly distributed between the ISSs that are connected to each IXS. For example, with a four
link group; two are connected to ISSs that are connected to IXS A, and the other two links
are connected to ISSs that are connected to IXS B.

Supported Functionality

46

From the Link Aggregation menu in the switch agent, you can:

View current settings — This displays the current link aggregation configurations,
showing all currently configured groups. The user may also modify a group or delete a
group from this page.

Create a new link aggregation group — This allows you to define a new link aggregation
group.

Enable or disable link aggregation configuration — This allows you to disable or enable
the current link aggregation configuration. The configuration is preserved.

Restart the link aggregation configuration — This allows you to request that the stack
restart its link aggregation configuration. This removes and rebuilds the link aggregation
groups as defined in the current configuration.

Delete the link aggregation configuration — This disables link aggregation and removes
any existing link aggregation configuration. The configuration is not recoverable. This
can be used to set link aggregation settings back to factory defaults.
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Other Functionality

Every time a switch is introduced to the stack (by connecting the stacking cable) or removed
from the stack (by disconnecting the stacking cable), the link aggregation software clears the
link aggregation information from the switches and re-programs them again.

If the switches are being programmed with link aggregation information for the first time,
link aggregation needs to be enabled. This is done by clicking on “Enable or Disable link
aggregation configuration.”
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This chapter explains how to rackmount and connect the system hardware. To do this, a system
installation check list is provided to help you perform the installation in the correct order. The
installation check list continues past the information in this chapter and points you to the correct
area in this document or the ReadMe file to continue the installation.

This chapter contains the following information:

*  Rack-Mounting the Equipment

* Installing Blades and Power Supplies

*  Connecting Power to Equipment

*  Connecting a Keyboard, Monitor, and Mouse

*  Connecting the Application Key

*  Connecting ISIS Hardware

For information on connecting and configuring two System Directors for failover, see
“Configuring the System for Failover” on page 116.

Rack-Mounting the Equipment

A

This chapter describes how to install and connect the System Director and other workgroup
hardware.

Information concerning power, airflow, and dimensions are explained completely in the
Avid Products and Network Site Preparation Guide located on the documentation DVD. You
should understand the basic power configurations explained in “Connecting Power to
Equipment” on page 66.

Before you start the procedures in this chapter, you should be familiar the previous
chapters in this document.
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Rack-Mounting Examples

Avid supports more than one Avid ISIS rack configuration. You should have discussed the layout
for your system with an Avid representative prior to purchase.

The following examples show a few of the supported rack configurations.

Single Rack - Two Engines - One System Director
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Single Rack - Four Engines - One System Director
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Rack-Mounting the Equipment

Dual Rack - Four Engines - Failover System
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Installing Rack-Mount Rails and Brackets

The System Director is designed for 19-inch (483-mm) rack configurations and requires one EIA
rack units (1U), or 1.75 inches (44.45 mm) of rack space. The rail kit installs into rails that are
between 23-inches (584.2-mm) to 31-inches (787.4-mm) inches deep. An optional rail kit is
available for racks that are up to 37 inches deep.

The System Director includes rack mounting slide rails. If instructions are included with your
rail kit, use them instead of the instructions included in this section. The standard rail
configuration is for racks with square mounting holes. Optional brackets are included for racks
with round holes. The rack-mounting kit requires inner slide rails be mounted to the server and
the outer slide rails are mounted to the rack. Once both the inner and outer rails are in place, slide
the server with the inner rails attached into the outer rails. Secure the server in the front of the
rack using the supplied screws so it does not slide forward.
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A
ia\

The System Director is designed to be installed horizontally in a rack. Installing the
System Director on an angle or in a sloped console causes the internal drives to wear
faster than the intended life of the drive.

To ensure the stability of the rack enclosure, start with heaviest equipment installed at
the bottom of the rack enclosure. Lighter equipment goes towards the middle and top.

The following are recommendations you should take into account prior to rack-mounting
Avid ISIS equipment:

*  Avid recommends that you leave a 1U or .5U space between each piece of equipment
mounted in the racks. This allows for better airflow and cable access, and helps stop
vibration in any equipment being transferred to spaces above and below.

The 1U System Director has vent holes on the top of the enclosure. Avid has performed
thermal testing with the top vent holes blocked, and the results indicated that even with the
top vent holes blocked, the 1U System Director still operates within the temperature
tolerances.

*  Avid recommends that you leave an 8 to 12 inch space at the bottom of the rack. This
allows for better airflow and lowers the possibility of dust or dirt being picked up by the
devices.

* Ifyou have a redundant configuration, you might place equipment in different racks.
Place the System Director and Failover System Director in different racks, separate the
storage elements between racks, place redundant Ethernet switches in different racks,
and have the power from each rack connected to different circuits.

e For normal operation, you’ll need to maintain approximately 2 feet (0.6 meters) of open
space in front of and behind the rack. This allows free access to the components in the
rack for operating changes or adjustments. For service, you need approximately 3 feet
(1 meter) of open space in front of the rack and 2 feet (0.6 meters) of open space behind
the rack. This allows for the removal of any component that needs to be replaced.

Rack-mount Requirements
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*  Elevated Operating Ambient — If installed in a closed or multi-unit rack assembly, the
operating ambient temperature of the rack environment might be greater than room
ambient. Therefore, consider installing the equipment in an environment compatible
with the maximum ambient temperature (Tma) specified by the manufacturer.
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Rack-Mounting the Equipment

Reduced Air Flow — Installation of the equipment in a rack should be such that the amount
of air flow required for safe operation of the equipment is not compromised.

Avid ISIS airflow is from the front of the enclosure to the rear. Make allowances for cooling
air to be available to the front panel surface and no restrictions at the rear.
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Mechanical Loading — Mounting of the equipment in the rack should be such that a
hazardous condition is not achieved due to uneven mechanical loading.

Make sure your rack enclosure is stable enough to prevent tipping over when one or more
Avid ISIS servers are extended on the sliding rails.
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Circuit Overloading — Consideration should be given to the connection of the equipment to
the supply circuit and the effect that overloading of the circuits might have on overcurrent
protection and supply wiring. Appropriate consideration of equipment nameplate ratings
should be used when addressing this concern.
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Reliable Grounding — Reliable grounding of rack-mounted equipment should be
maintained. Particular attention should be given to supply connections other than direct
connections to the branch circuit (for example, use of power strips).
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Inside Enclosure Access — If you want to extend the enclosure, and remove the top cover,
you must allow 0.5 in (1.3 ¢cm) clearance on top of the enclosure for cover removal.
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2 Connecting the ISIS Equipment

Positioning the server in the Rack

The following information helps you decide where to install the System Director in the rack.

To position the System Director in the rack enclosure:

» Select a position in the rack where the System Director is at the proper baseline position.

Positioning the System Director

__— Rack mounting rail

Rack mounting rail 5/8in
hole spacing 5/8in

—“ 1/2in

5/8in

System Director
front panel mounting hole

13/4in
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13/4in
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Y
EIA rack unit / -
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Baseline position is between
two 1/2inch holes.
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Rack-Mounting the Equipment

Separating the Slide Rails

You need to separate the slide rails and attach the inner “movable” section to the System Director
and the outer “fixed” section to the rack rails.

To separate the slide rails:
1. Slide the slide rail completely open.

2. Press the spring clip on the inner slide rail as shown in the illustration.
The blowup of the spring clip shown in the illustration is on the bottom side of the slide rail.

Separating the Slide Rails

3. Pull and separate the two halves.

4. Repeat these steps to separate the second slide rail.
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2 Connecting the ISIS Equipment

Attaching Inner Slide Rails to the System Director

Attach the inner slide rails that were separated from the outer slide rails to the System
Director.

To attach the inner slide rails:

1. Position the inner slide rail against the side of the server so that the screw holes are
toward the rear of the server, and front of the slide rail fits over the tab at the front of the
server.

2. Secure the inner slide rail to the server with two of the small screws.
You might find more screws in the rail kit than is needed, and described in this procedure.

Attaching the Inner Slide Rails

3. Repeat this procedure to attach the other inner slide rail on the other side of the server.

Attaching the Outer Rails to a Square-Hole Rack

After separating the slide rails as previously described (see “Separating the Slide Rails” on
page 55), perform the following procedure. If your mounting rails have round holes, see
“Attaching the Outer Rails to a Round-Hole Rack” on page 58.

To attach the outer slide rails to the rack with square holes:

1. Align the outer slide rail bracket assembly with the front rack-mounding holes.

% You should have someone helping you hold the slide rails level while you are positioning
them in the rack.
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Rack-Mounting the Equipment

2. Slide the square tabs through the holes in the front, vertical rack-mounting rail.

Positioning the Outer Slide Rail with the Front Rack-Mounting Rail
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3. Push the outer rail towards the outside of the rack, to secure the outer rail in place

Insert the Outer Slide Rail to the Front Rack-Mounting Rail
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4. Adjust the outer slide rail bracket assembly to the rear mounting rail.
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2 Connecting the ISIS Equipment

5. Secure the rear outer slide rail bracket assembly to the rear mounting rail as you did for
the front rack-mounting rail.

Securing the Outer Slide Rail to the Rear Rack-Mounting Rail

%4 N

G 2

z 1

6. Repeat this procedure to attach the second outer slide rail on the other side of the rack.

Attaching the Outer Rails to a Round-Hole Rack
After separating the slide rails as previously described (see “Separating the Slide Rails” on

page 55), perform the following procedure. If your mounting rails have round holes, you
first need to clip on the round hole adapter.
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Rack-Mounting the Equipment

To attach the outer slide rails to the rack with round holes:

1. Locate the four round hole adapters (which ship in the accessory kit's plastic bag, not in the
rack mount kit box) and position the adapter on the end of the outer slide rail bracket
assembly as shown in the following illustration.

Attaching the Round Hole Adapter to the Bracket Assembly

Outer slide rail bracket assembly

ﬁ
Bracket assembly tabs I

Round hole adapter

2. With the bracket assembly tabs aligning with the cut-out in the round hole adapter, swing the
adapter so that the holes face the front of the bracket assemble as shown in the following

llustration.

Positioning the Round Hole Adapter
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2 Connecting the ISIS Equipment
3. Slide the outer slide rail bracket assembly onto the side rack-mounting rail so that the
round hole adapter is over the rack rail.

% You should have someone helping you hold the slide rails level while you are positioning
them in the rack.

Insert the Outer Slide Rail to the Front Rack-Mounting Rail
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4. Insert the small (10-32) Phillips-head screws through the round-hole adapter and
mounting rail, into the bracket. If the rack holes are different size, you need to supply
your own screws

Securing the Outer Slide Rail to the Rack-Mounting Rail
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Rack-Mounting the Equipment

5. Adjust the outer slide rail bracket assembly to the rear mounting rail.

6. Secure the rear outer slide rail bracket assembly to the rear mounting rail as you did for the
front rack-mounting rail.

7. Repeat this procedure to attach the second outer slide rail on the other side of the rack.

Securing the System Director in a Rack

You should have someone helping you lift the System Director while you are positioning it
into the slide rails.

To secure the server to the rack enclosure:

1. Lift and position the server so that the inner slide rails (secured to the System Director) are
aligned with the outer slide rails secured to the rack.

2. Push the front of the System Director server flush against the front mounting rail. The holes
in the server front panel align with the holes in the front mounting rail.

3. From the front of the rack enclosure, insert the large Phillips-head screw through the System
Director and front mounting rail.

- Square hole racks — the middle hole of the outer rail kit is where the screw anchors the
server front panel to the vertical rail. A M6x10 screw in the parts kit is included to
secure the front panel with square hole racks.

- Round hole racks — the server front panel attaches to the vertical rail of the rack. Use a
truss head screw or hardware that come with your rack to secure the front panel with
round hole racks.

Front Panel Screws

azaﬂaaaaaaaA

Rack enclosure
front mounting rail

YV YV Y Y YYYYYYYYYY

o
$S005555565600
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2 Connecting the ISIS Equipment

Mounting the Engine

& Lifting the engine with the blades and power supplies installed can cause an injury.
The engine must have the blades and power supplies removed prior to lifting. Avid
recommends that two people be used whenever lifting the empty engine.
To mount the engine into the rack:

1. Screw the brackets to the rear of the rack as shown in the following figure.
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2. Make sure that the blades and power supplies are not in the engine.

3. Using two people, lift the engine and place the rear of the engine onto the brackets as
shown in the following figure.
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Installing Blades and Power Supplies

4. Screw the engine to the front of the rack through the ears of the engine as shown in the
preceding figure.

Installing Blades and Power Supplies

Once the engine has been mounted you can install the power supplies and blades.

Only trained Avid technicians should remove and replace the power supply when power is
applied to the system. Since power to the system is still on, you must always keep your
hands external to the engine when a power supply is missing from the engine.
To place the power supplies and blades into the engine:

1. Unpack each ISB and turn it so you can properly read the Avid name.

2. Pull open the plastic handle (with drive size label) on the front of the ISB.

3. Place the ISB into the slot and slowly push the ISB completely into the slot.

4. Push the plastic handle (with drive size label) closed, to lock the ISB into the slot.
5. Repeat step 1 through step 4 until all blades are installed.
6. Carefully unpack each power supply.

Avid recommends that two persons be used to install the power supplies. You could be
injured if you dropped a power supply on any part of your body.
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2 Connecting the ISIS Equipment

7. Place the power supply into the engine as shown in the following figure and slowly push
the power supply into the slot.
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Screws

8. Turn the screws until tight.

9. Repeat step 6 through step 8 until all power supplies are installed.

Installing IXS and ISS Switches

The location of the ISS and IXS switches in the stack are very important. If you have only
one or two engines you should only be installing ISS switches into the engines, see
“Two-Engine Stacking” on page 73.

If you have more than two engines, you need to install two IXSs in the first engine at the top
of the stack, depending on your the version of the hardware, the following is needed:

*  Youneed two IXS2000s in three- to twelve-engine configurations with v2.x hardware,
see “Three- to Twelve-Engine Stacking Summary With v2.x Switches” on page 75.

e Ifyou are installing a system with v1.x hardware, see the v2.1.1 (or earlier) Avid ISIS
Setup Guide for detailed procedures.

To install your IXS or ISS:
1. Unpack the switch and insert the switch edges into the internal engine slides.

2. Carefully push the switch into the midplane of the engine until the connection is made.
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Connecting a Keyboard, Monitor, and Mouse

3. Tighten the thumbscrew on each side of the switch.

Thumbscrews

Connecting a Keyboard, Monitor, and Mouse

A

An industry standard USB keyboard, USB mouse and VGA monitor are use to access the System
Director. When installed in a rack with several servers an optional KVM switch can also be used.
The keyboard, monitor, and mouse connections use the same ports described in the following
procedure. Follow the instruction supplied with your KVM switch. You need to supply KVM
cables that are compatible with your KVM switch.

There are only two USB ports on the rear of the System Director. One of the ports is typically
used for the application key. When you purchase your KVM switch make sure it includes a USB
splitter cable so that both your keyboard and mouse can plug into the splitter cable and use a
single USB port on the Engine.
To connect a keyboard, monitor, and mouse to the Avid ISIS:
1. Install your KVM switch in a suitable slot next to the System Director in the rack.
You can also place the monitor on a shelf, and the keyboard and mouse on a sliding tray in
the rack. These items are optional and can be purchased locally or from Avid.

Do not place the monitor on top of the Avid ISIS.

2. Attach the VGA connector on the monitor cable to the 15-pin video port on the back of the
Avid ISIS. Secure the connector with the thumbscrews on the connector. For exact locations
see “System Director Rear Panel” on page 26.

3. Insert the connector on the keyboard and mouse cables into a USB splitter cable.

If you do not have a USB splitter cable, plug your keyboard and mouse cables directly into the
USB ports on the rear of the System Director.
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2 Connecting the ISIS Equipment

4. Insert the other end of the USB splitter cable into a USB connector on the back of the
System Director.

Connecting the Application Key

Before you start the System Director, you need to connect the Avid ISIS system USB
application key (also called a dongle). The USB application key determines how many Avid
ISIS 7000 clients can simultaneously use your system.

Do not lose the USB application key. Your Avid ISIS system does not function without
it. If you lose the USB application key, you must purchase another one from Avid to use
your Avid ISIS system software.
To connect the application key to your Avid ISIS system:

1. Locate the USB application key in your Avid ISIS system kit.

2. Attach the USB application key to one of the rear USB ports of the System Director; see
“System Director Rear Panel” on page 26.

& Do not use the built-in USB connector on the front of the System Director.

Connecting Power to Equipment
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The Avid ISIS 7000 hardware includes three power supplies using an N+1 configuration for
redundancy. The three power supplies “load share” to allow the balanced distribution of V ac
power into each Avid ISIS 7000 engine. Usually, a minimum of two of the three power
supplies must be operational at one time for the engine to function properly. The fans in each
power supply cool the supply and provides airflow for the engine. If a power supply fails,
leave it in place until you have a replacement.

Each power supply is rated at 5 amps of current capacity at 120 Vac. You can have up to one
power supply from each of the three engines on one 20-amp circuit. This allows the system
to continue running if one of the three power supplies fails, with the two remaining
load-sharing power supplies drawing slightly less than 10 amps.



Connecting Power to Equipment

% Each System Director has two power supplies rated at 5.8 amps each. Avid recommends each
power supplies be on a separated 20-amp circuit.

An engine can operate on two power supplies for a period of time to allow you to protect data.
The following illustration shows an example of how the power should be connected to protect
data.

Addresses In the Stack” on page 71.

Use this section to determine how you should connect power to the engines. Place the power
cords into the engines when you place them into the rack as explained in “Rack-Mounting
the Equipment” on page 48, but do not plug them into the outlets until told to do so later in
the document.

Do not connect the power cords to the engines until instructed to do so in “Setting-Up Network

See the following sections:

e Three 20-Amp V AC Circuits for Three Engines
e Three 20-Amp V AC Circuits for Two Engines

*  Two 20-Amp V AC Circuits for Two Engines

Connecting Power Cords

When using two System Directors, two 20-amp circuits should be supplied and configured as
follows:

To connect the power cords to the System Director:

P Plug two power cords into the back of the server and then plug the other ends into power
outlets on separate circuits.

Power Connections

Power supplies
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2 Connecting the ISIS Equipment

Three 20-Amp V AC Circuits for Three Engines

When you are using three 20-amp circuits for three engines, they are configured as follows:

Basic Power Connection for Three ISIS Engines

© A B C O‘

(@)

Engine

Q@O

Engine

oo

Engine|

I I
20 Amp Oﬁ,:@ 20 Amp

oo

Three 20-Amp V AC Circuits for Two Engines

When using three 20-amp circuits for the engine, they are configured as follows:

First Example of Power Connection for Two ISIS Engines

Engine

A B C b
O

Engine
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Connecting Power to Equipment

% The 20-amp circuits shown for the System Directors should remain the same for both the three
and two 20-amp circuit examples.

Two 20-Amp V AC Circuits for Two Engines

& The following configuration is not recommended by Avid, but some locations might need to
connect in this manner.

When using two 20-amp circuits for the engine, they are configured as follows:

Second Example of Power Connection for Two ISIS Engines

Engine

Engine

AI_‘ o H @ ,_L
20 Amp 20 Amp

% The 20-amp circuits shown for the System Directors should remain the same for both the three
and two 20-amp circuit examples.

Turning System On and Off

To turn the system on or off, use the following procedures. Do not turn off the Avid ISIS
components until they have completely powered on.
To turn your system on:

1. Turn on your engines one at a time by plugging at least two power cords into two power
supplies at the same time. Plug the third power cord into the third power supply soon after
the first two powers supplies have been given V ac power. Allow enough time for all lights
on the front panel to turn Green.

2. Turn on the System Directors and to start the Avid ISIS system.

3. Clients should restart there systems and use the Client Manager software to log on and
mount workspaces.
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2 Connecting the ISIS Equipment

To turn your system off:
1. Exit the Client Manager on all clients.

2. Stop the secondary System Director using the System Director Control Panel if you are
set up for failover.

3. Stop the Active System Director using the System Director Control Panel.
4. Turn off the System Directors.

5. Turn off the engines one at a time by unplugging the three power cords for each engine.

Connecting ISIS Hardware
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The process of connecting the engines to the Avid ISIS network is a two step process. First
you logically configure the addresses for the engine, then you physically make the
connection to complete the process. If you need to install software, see “Installing Software
and Configuring 10-Gb Link Aggregation” on page 83.

The engines are powered on when two or three power supplies are plugged into an V ac
power source. When the engines are on, and the interconnect cables are attached, the
network tries to identify the new connection before it should. Do not connect the
interconnect cables until told to do so in the procedures.

The 64-bit System Directors introduce in Avid ISIS 7000 v2.0 can be used with v2.x and
v1.x generation switches in the engines. The two v2.x switches are branded with an IXS2000
and ISS2000 silk-screen. The v2.x switches cannot be mixed in ISIS engines with earlier
versions (v1.x) of the switches (labeled IXS1000 and ISS1000). All the switches in the
engines need to be of the same generation.

You cannot mix new switches (labeled IXS2000 and ISS2000) with original switch
hardware (labeled ISX1000 and ISS1000). All switches in the engine, and engines in the
stack must be from the same generation of hardware.

The procedures provided in this guide describe the AS3000 System Directors and Avid ISIS
2.x hardware. You will need the following:
¢  Windows computer (laptop or System Director)

*  CAT5e or CAT6 Ethernet cable to run between the Windows computer and the
Management port of the ISS or IXS

»  Two or more engine interconnect cables (when using more than one engine)

*  System Director ISIS software kit



Connecting ISIS Hardware

Engine Configuration v2.x Hardware Guidelines

Although there are a few ways to physically connect and enable the engines, Avid recommends
the process described in this section for consistency and dependability. In smaller configurations
different switch blades are used:

* ISS — Only the ISS blades are used when you are connecting two engines.

* IXS — When connecting three to twelve engines, two IXS2000 blades are used in the first
engine (one for each subnet) to connect the next eleven engines.

Engine configurations are described in the following sections:
*  “Two-Engine Stacking” on page 73.
o “Three- to Twelve-Engine Stacking Summary With v2.x Switches” on page 75

You must disable link aggregation before creating or modifying your Avid ISIS stack. After your
stack has been created, reconfigure your link aggregation.

Use the following list to help you when you connect the System Director, laptop for
configuration, and clients to the Avid ISIS 7000 system.

* A laptop (or any computer running a Windows operating system) is used in the following
examples for configuring the engine at the beginning of the installation or for maintenance
by an Avid representative. You can use the 1-Gb connection on the System Director for
configuring the engine at the beginning if needed, but do not leave it connected or use it for a
maintenance connection.

*  All clients connected to the switches on the left side of the engine are connected to one
subnet, while clients connected to the switches on right side of the box are connected to the
second subnet.

*  When you are connecting the System Director to the ISS module using the dual port
Ethernet board, Avid recommends that you connect the left port to the left side of the engine
and the right port to the right side of the engine. Where the left side corresponds to the
VLAN 10 subnet and right side corresponds to the VLAN 20 subnet. However, it also
functions properly the other way.

You should rename the left side, to “Left Side, VLAN 10” and the right side, to “Right Side,
VLAN 20” in the Network Properties of your System Director.

Setting-Up Network Addresses In the Stack

Regardless of the number of engines you are planning in your Avid ISIS stack. The following
procedure describes how to configure the first engine.
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2 Connecting the ISIS Equipment

To configure the engine:

1. Connect the power cords that are connected to the System Director to the V ac circuit
and turn on the System Director.

The System Director password is preset to is-admin. Not not to be confused with the System
Director Web Page Administrator user whose default password is blank.

2. Connect the power cords from at least two of the engine’s power supplies to V ac circuit
at the same time. Then connect the third power supply.

It should take about 2 minutes for the engines to reach ready status. Wait for all the
LEDS on the engine to be green.

3. Power on all the engines in the stack.

Power cords are plugged into the engines early in the process to speed up the installation
time. Engines can take a minute or two to become ready. If the engines are ready when it is
time to add them to the stack, the installation takes less time. Do not plug the interconnect
cables into the engines until instructed to do so.

4. Using a laptop (or computer running a Windows operating system), assign a static P
address of 192.168.0.100 to the network adapter (NIC) and attach it to the
management port of left switch.

5. Open a browser and navigate to the Switch Agent Web page via the following address:
https://192.168.0.10:5015.

6. You are asked for the default password. Type se-admin.
The Avid ISIS 7000 Integrated Switch Blade Window appears.
7. Type the following into the Chassis Configuration window:

- Starting IP addresses. Enter the IP addresses for both subnets, see “IP Addressing
Overview” on page 83.

- Subnet mask

- Ending IP address should be the last address of the engine in the system. Remember
that each engine has 17 IP addresses on each side, for a total of 34. Set the ending
address high enough to cover the last engine and any possible near term future
needs.

If you are going to be using a Zone 3 environment you must set the default gateway
addresses for both sides of the engine. These addresses must come from the site’s IS
department.

% Make sure there are no DHCP servers connected to the network segments that assign
addresses in the Avid ISIS range.
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Connecting ISIS Hardware

- Date, Time, and Time Zone or Enable network time protocol

If your network has a network time protocol (NTP) server, you can enter the IP address
of that server in the Chassis Configuration window. NTP Server 1 is for the primary
NTP server and if you have a secondary NTP server, enter the secondary IP address in
NTP Server 2.

Once the NTP is configured on a switch, the information propagates to all the other switches
automatically. The time is also automatically synchronized onto the storage blades after the NTP
is configured on the switch.
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8. Click Submit.

A Dialog box might appear with an informational warning and can be disregarded. The first
engine is now properly addressed.

Two-Engine Stacking

To stack two engines:
1. Complete the procedure “Setting-Up Network Addresses In the Stack” on page 71.
2. Open a left-side Switch Web page.
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2 Connecting the ISIS Equipment

3. Go to System > Configuration > Add/Remove chassis.
4. Click Add and wait for the progress bar to complete.

5. Connect the interconnect cable from the left side of the stack to the new engine. The
switch then picks up the addresses and stacking information.

Wait 5 minutes and refresh the page.

6. Verify that the serial number of the second engine is now in the Add a chassis list.

117.26 / iss2-single-user

Tools  Logging anced Logout
SYSEEN pdd a chassis
Overview Submit a request to add a chassis into the system
Configuration Add
Basic

Set stack password
» AddRemove chassis
Rehoot a chassis Serial Number Chassis ID  Action

Reset an ISB
e CRIS1604300 0 Delets |

Flush chassis manager

Remove a chassis

logs CRIG49063 1 Delete |
Set chassis manager log
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10 Gb Link Aggregation

7. Attach the right interconnect cable.

8. Assign appropriate static IP address to the left and right network ports of the System
Director.
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Connecting ISIS Hardware

9. Attach the System Director to the left and right switches and verify that all four switches can
be pinged on their client IP address.

The following example shows the physical connections between two engines, a System
Director, and clients. These are direct connections to the client system and not connected
through switches. For a procedure of this connection, see “Setting-Up Network Addresses In
the Stack” on page 71.

Two-Engine Connections

To client - RJ45 connector, CAT 5e or CAT 6

e Left side Right side

Inter-engine connection
CX-4 connector
Avid interconnect cable
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Three- to Twelve-Engine Stacking Summary With v2.x Switches

When connecting three- to twelve-engines, connect and add the switches to the VLAN 10 subnet
(left side) first and then connect the engines to the VLAN 20 (right side) subnet. When accessing
the Agent Web pages for the engines, use your laptop through the Management port or the
Switch Agent Web through the Avid ISIS 7000 software on your System Director. Information
on installing the software on the system Director is described in “Software Installation” on
page 87.
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2 Connecting the ISIS Equipment

In three- to twelve-engine configurations with ISX2000 switches, two IXSs are installed in
the first engine, see “Three- to Twelve-Engine Connections With v2.x Switches” on page 76.
The IXS2000 ports 1 through 11 are referred to from left to right as shown in the following
figure.

IXS2000 Engine Port Numbering

|~ IXS module
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1 2 3 4 5 6 |
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Management
connection 11 Engine interconnections

Avid strongly recommends you keep your engines and IP addresses in order in conjunction
with the order of the ports used on the IXSs. When the IP address of the engines are in order
with how they are mounted in the rack, support personnel can better identify the connections
and components in the network. For an overview of the recommended IP addressing, see “IP
Addressing Overview” on page 83.

Three- to Twelve-Engine Connections With v2.x Switches
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The following procedure describes cabling up to twelve engines and might not represent
your actual rack configuration. The cabling is the same when using IXSs regardless of the
number of engines in your configuration.

To connect the VLAN 10 subnet (left side):

1. Loosen the thumb screws on all the right side switches (IXS and ISS) and pull the right
side switches out about an inch of all the engines (so they are not electrically connected
in the engine).

2. Connect the power cords from at least two of the engine’s power supplies to V ac circuit
at the same time. Then connect the third power supply.

It should take about 2 minutes for the engines to reach ready status. Wait for all the
LEDS on the engine to be green.

3. Power on all the engines in the stack.
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Power cords are plugged into the engines early in the process to speed up the installation time.
Engines can take a minute or two to become ready. If the engines are ready when it is time to add
them to the stack, the installation takes less time. Do not plug the interconnect cables into the
engines until instructed to do so.

4. Using a laptop (or computer running a Windows operating system), assign a static IP address
of 192.168.0.100 to the network adapter (NIC) and attach it to the management port of left
IXS.

5. Open a browser and navigate to the Switch Agent Web page via the following address:
https://192.168.0.10:5015.

6. You are asked for the default password. Type se-admin.
The Avid ISIS 7000 Integrated Switch Blade Window appears.
7. Type the following into the Chassis Configuration window:

- Starting IP addresses. Enter the IP addresses for both subnets, see “IP Addressing
Overview” on page 83.

- Subnet mask

- Ending IP address should be the last address of the engine in the system. Remember that
each engine has 17 IP addresses on each side, for a total of 34. Set the ending address
high enough to cover the last engine and any possible near term future needs.

If you are going to be using a Zone 3 environment you must set the default gateway
addresses for both sides of the engine. These addresses must come from the site’s IS
department.

% Make sure there are no DHCP servers connected to the network segments that assign addresses
in the Avid ISIS range.
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2 Connecting the ISIS Equipment

- Date, Time, and Time Zone or Enable network time protocol

If your network has a network time protocol (NTP) server, you can enter the IP
address of that server in the Chassis Configuration window. NTP Server 1 is for the
primary NTP server and if you have a secondary NTP server, enter the secondary IP
address in NTP Server 2.

% Once the NTP is configured on a switch, the information propagates to all the other switches
automatically. The time is also automatically synchronized onto the storage blades after the
NTP is configured on the switch.

.;*x' Avid 1515 Integrated rnet Switch Blade 2.0.0.24440

172.20.108.26 [ iss-single-user

Tools  Logging  Advanced Logout

System  cnassis Conriguration

Overview

1SS (left) 1SS (right)

Configuration

p Basic 1_ m I‘

Sel stack p d
AddiRemove chassis St 172.20.108.10 Siaf g Adiess 172.20.108.74
Reboot a chassis . x
End ip addre: End ip addre:
e S [172.20.108.30 by [172.20.108.98
Flush chassis Subnet Mask 265,255,265 0 Subnet Mask 265,255,265 0
manager logs
Set chassis manager ¥ Default gateway 172.20.108.1 ¥ Default gateway 172.20.108.65
log level
10 Gb Link Aggregation Network Date and Time Miscellaneous

View current setlings
Create new group

Enabla network time Current Time Wed Jul 16 13:00:54 2008

o pratocal Date YYTY MM.OD
Eraleit NTP ,— OO M. D) I~ Autamatically reset blades
Restart Serer 1 Time HH MM.SS after heartbeat timeout
Delete configuration NTP ,— (HH.MM.S3)
Configure failover Server 2 Time Zaone | GWT 'I
policy
Hi-Gig Link Aggregation Reset

8. Click Submit.

A Dialog box might appear with an informational warning and can be disregarded. The
first engine is now properly addressed.

9. Click Add/Remove Chassis to go to the Add a Chassis page.
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10. Click Add and wait for the progress bar to complete.

172.20.117.26 / iss2-single-user

Tools  Logging H=1 Logout

SYSem  pgd a chassis
Overview Submit a request to add a chassis into the system
Configuration Add
Basic

Set stack password .
) Remove a chassis

p AddRemove chassis
Reboot a chassis Serial Number Chassis ID  Action

Reset an ISB CRI51604900 1] Delete |

Flush chassis manager

logs CRIF48063 1 Delete |

Set chassis manager log

level CRIS16039 2 Delete |

10 Gb Link Aggregation

Add

11. Immediately attach an interconnect cable from port 1 of the left IXS to the left ISS
interconnect port of the second engine.

Left Subnet Twelve-Engine Connections

Third engine Fifth engine Seventh engine

Second engine Fourth engine Sixth engine

\ \
® R R RS RS ]
U (il }_@IL@I}_@IL@H}@I

Eighth engine Tenth engine / Twelfth engine

e g °°

)

Ninth engine  Eleventh engine

N
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%

It is not mandatory that you connect each engine to the exact ports shown in the illustration.
The order of the ports and engines shown was suggested just to keep the stack logically
organized.

12.

13.

14.

15.

Verify that the switch was added to the stack successfully.

The serial number of the new engine appears in the Add/Remove Chassis list after a few
moments when the switch is successfully added. If the new engine does not appear in
the list (times out), see “Engine Does Not Appear in Add Chassis List” on page 97. You
can also navigate to the Tools tab and verify that IXS can ping the added switch via the
expected client IP address.

Repeat steps 9 through 11 until eleven engines are connected. Connect the third engine
to port 2, fourth engine to port 3, and so on, until all engines are connected to ports 1
through 11 on left subnet (VLAN 10).

Attach the System Director to client port and assign an appropriate IP address for the
left subnet. Verify that you can ping all the switches in the left stack at the expected
IP addresses.

Continue with the following procedure to connect VLAN 20 (right side).

To connect the VLAN 20 subnet (right side)

1.

2.

Insert right IXS (right-side switch in the top engine) and tighten the thumb screws.

The IXS switch starts when inserted, allow the switch 2 minutes to power on and enter a
ready state.

Insert the right side ISSs that you intend on connecting to right IXS subnet and tighten
the thumb screws.

Allow the switches 2 minutes to power on and enter a ready state.
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3. Connect the second engine to port 1, third engine to port 2, and so on, until all engines are
connected to ports 1 through 11 on right subnet (VLAN 20).

Do not click “Add” from any IXS Agent Web page.

Right Subnet Twelve-Engine Connections

Third engine Fifth engine Seventh engine

Second engine \Fourth ingine\ Sixth {ngine\
® (o) e e )

Eighth engine / Tenth engine / Twelfth engine

Ninth engine  Eleventh engine

e 9 °°

)

Peor=e====:;
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4. Attach the System Director to client port and assign an appropriate IP address for the right
subnet. Verify that you can ping all the switches in the right stack at the expected
IP addresses.

All switches in the stack (left and right sides) should now be pingable from the System
Director.
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Hi-Gig Link Aggregation Group

82

Two interconnect cables and Link Aggregation are used to increase the bandwidth between
the IXS’s. However, both interconnect cables must not be connected until Hi-Gig Link
Aggregation is Enabled. Link Aggregation must be enabled for both sides of the network in
order for clients on both sides to perform I/O operations.

If Hi-Gig Link Aggregation is not enabled, and two interconnect cables are used to
connect the IXS’s, then traffic loops and stacking problems occur.

To enable link aggregation:

1.

wn kA~ W N

6.

Go to any left subnet Switch Agent Web page.

Notice on the left hand column of the System page there is an option Hi Gig Link
Aggregation with an Enable/Disable radio button.

. Click Enable/Disable.

. Click the radio button to Enable Hi Gig Link Aggregation.

. Click submit, the IXS’s restart.

. After the IXS has restarted, check that Hi Gig is “on” in the Hi Gig Link Aggregation

column of the System page > Switch Agent > Management Domain.

Connect a stacking cable from one IXS port to an IXS port on another Engine.

Currently only Port 6 and Port 7 on vl.x hardware can be used for Hi-Gig Link
Aggregation. Do not use any other stack ports to connect the IXS’s to each other.



ﬂ Installing Software and Configuring
10-Gb Link Aggregation

This chapter describes how to connect and configure the System Director and other Avid ISIS
hardware. Since the number of different configurations are endless, it uses a configuration with
four engines and one System Director as an example.

If you have questions, please call your Avid representative or your local ACSR.

& Before you start the procedures in this chapter, you should be familiar with the information
in previous chapters and the Avid Products and Network Site Preparation Guide.
This chapter contains the following sections:
* [P Addressing Overview
*  Configuration Overview
*  Software Installation
*  Product Recovery Needs to be Copied to the USB Flash Drive
* Java Runtime Environment
*  Avid Interplay Authentication
*  Configuring a 10-Gb Link Aggregation Group

IP Addressing Overview

Before you attempt to define a total IP addressing scheme for your system and configure the
static internal IP addresses of the engine, you should have a solid understanding of how the
addresses are assigned within the engine and how the IP addresses increment between engines.

192.168.10.10 and 192.168.20.10, subnet 10 and subnet 20, are used by Avid as examples
throughout this document, your site might require different addresses. Consult with your site’s
networking managers for site specific requirements. Unless specified, you can change the
addresses used in the following example to suit your needs. However, whichever static IP
addresses are assigned within the engine, they must not be assigned by a DHCP server to any
other device within the Network.
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The following figure shows the front and rear view of a engine. Use the following two
figures and bulleted list to understand how static IP addresses are assigned to each engine.

Front and Rear of a Engine

Upper left Front Rear

O]‘_&? I Ilqli <°>2 I qu\ii <°>2 I I\\@Ii <°>2 I Il(ﬂli o

e
| | |
of |22 "@[? —dlor_—_d|> 9o

.. (& === ] |
0 SIS S

Lower right Left side Right side

Management Port (default subnet 10) (default subnet 20)

Management Port The IXS shown is only

used when three or more
engines are connected.

The following list describes what needs to be accomplished to assign IP addresses to
engines. You should understand the assignment of IP addresses completely before you
perform the actual configuration.

Do not attempt to assign addresses to the engine using this list. This provides an overview,
not a step-by-step procedure.

*  Connect Port 1 of the System Director or a port on a laptop to the Management Port of
the ISS in the bottom engine of the rack using a CATS E, CAT6 cable or better. See the
previous figure.

*  You are now talking to the Management Port on an isolated network interface on the ISS
using the default IP address of 192.168.0.10. This IP address is used on every
Management Port on the ISS and expansion switch blade. The address is not on the local
10 or 20 subnets Ethernet bus and is never used to transfer actual data.

When you assign subnet addresses internally and have more than one engine, all ISSs and
1XSs on the left side of the rear of the engine are on one subnet, while all ISSs and IXSs on
the right side of the rear of the engine are on the other subnet.

See the following tables provide an example of the address assignments described in the
following bullets.

*  Then two static IP addresses are assigned to the upper left-most ISB slot in the engine
when looking at the engine from the front. The addresses are 192.168.10.10 on
subnet 10 and 192.168.20.10 on subnet 20. You are assigning the address to the slot, not
the blade. The ISB can be physically moved, but the IP address remains with the slot.
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*  As the slots go sequentially from top left to right, over a row and starting at the left again,
each slot is assigned a static IP address that is incremented by one until you reach the
right-most bottom slot that contains addresses of 192.168.10.25 and 192.168.20.25.

* At this point, each ISS or IXS is assigned a base address. One ISS is assigned a subnet 10
address 0of 192.168.10.26 and the other a subnet 20 address of 192.168.20.26 (unless the you
want to change the IP scheme or subnet mask). Each side of the engine is assigned 17
addresses on each network for a total of 34 addresses per engine.

*  You then increment the subnet 10 and subnet 20 addresses by one and assign them to the
switch blades in the next engine.

* The ISB slots and switches are again incremented.

First Engine Internal Static IP Address Assignments

First Engine

[SB 0

192.168.10.10 (left side)
192.168.20.10 (right side)

[SB 1

192.168.10.11 (left side)
192.168.20.11 (right side)

[SB 2

192.168.10.12 (left side)
192.168.20.12 (right side)

[SB 3

192.168.10.13 (left side)
192.168.20.13 (right side)

[SB 4

192.168.10.14 (left side)
192.168.20.14 (right side)

[SB 5

192.168.10.15 (left side)
192.168.20.15 (right side)

[SB 6

192.168.10.16 (left side)
192.168.20.16 (right side)

[SB 7

192.168.10.17 (left side)
192.168.20.17 (right side)

[SB 8

192.168.10.18 (left side)
192.168.20.18 (right side)

[SB 9

192.168.10.19 (left side)
192.168.20.19 (right side)

[SB 10

192.168.10.20 (left side)
192.168.20.20 (right side)

[SB 11

192.168.10.21 (left side)
192.168.20.21 (right side)

[SB 12

192.168.10.22 (left side)
192.168.20.22 (right side)

[SB 13

192.168.10.23 (left side)
192.168.20.23 (right side)

[SB 14

192.168.10.24 (left side)
192.168.20.24 (right side)

[SB 15

192.168.10.25 (left side)
192.168.20.25 (right side)

Switch (ISS or IXS)
192.168.10.26

Switch (ISS or IXS)
192.168.20.26
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Second Engine Internal Static IP Address Assignments

Second Engine

[SB 0

192.168.10.27 (left side)
192.168.20.27 (right side)

[SB 1

192.168.10.28 (left side)
192.168.20.28 (right side)

[SB 2

192.168.10.29 (left side)
192.168.20.29 (right side)

[SB 3

192.168.10.30 (left side)
192.168.20.30 (right side)

[SB 4

192.168.10.31 (left side)
192.168.20.31 (right side)

[SB 5

192.168.10.32 (left side)
192.168.20.32 (right side)

[SB 6

192.168.10.33 (left side)
192.168.20.33 (right side)

[SB 7

192.168.10.34 (left side)
192.168.20.34 (right side)

[SB 8

192.168.10.35 (left side)
192.168.20.35 (right side)

[SB 9

192.168.10.36 (left side)
192.168.20.36 (right side)

[SB 10

192.168.10.37 (left side)
192.168.20.37 (right side)

[SB 11

192.168.10.38 (left side)
192.168.20.38 (right side)

[SB 12

192.168.10.39 (left side)
192.168.20.39 (right side)

[SB 13

192.168.10.40 (left side)
192.168.20.40 (right side)

[SB 14

192.168.10.41 (left side)
192.168.20.41 (right side)

[SB 15

192.168.10.42 (left side)
192.168.20.42 (right side)

Switch (ISS or IXS)
192.168.10.43

Switch (ISS or IXS)
192.168.20.43

Configuration Overview
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Your System Director and engines should be rack mounted with the interconnect cables
connected to the left side of your stack as previously described before continuing.

You now need to do the following:

1. Configure the engine by assigning IP addresses to the engine. This provides each ISS,
IXS, and ISB with the needed IP addresses to connect to the clients and System
Director, see “Setting-Up Network Addresses In the Stack™ on page 71.

%

The ghost image on the System Directors does not set the IP addresses of the two onboard
NICs or the dual NICs card on the PCI bus, the system is set for DHCP.

2. Load the System Director software. This software is used to create a file system on the
System Director, bind the ISBs to the software on the System Director, create Storage
groups, and administer the Avid ISIS system. See “Loading Client Software” on

page 98.




Software Installation

3. Perform administrative functions: bind ISBs (storage elements), create storage groups, and
do other administrative functions. See Creating a Active Partition on the System Director.

4. Load the client software; see Loading Client Software.

Software Installation

Your System Director and engines should be cabled and attached to both internal subnets similar
to the “Setting-Up Network Addresses In the Stack™ on page 71.

Loading the Software

The Avid ISIS enclosure does not have a DVD reader. Software is loaded onto the system using a
USB flash drive. The system ships with two USB flash drives:

*  One USB flash drive is your Avid ISIS software installation kit and stores approximately 4
GB of data. Avid ISIS systems ship with the software kit loaded on the 4 GB USB.

Any USB flash drive is supported for loading the software kit as long as it has at least 1 GB of
storage.

*  The second USB flash drive stores approximately 16 GB of data and is intended to be used
as a bootable USB flash drive with Avid ISIS Product Recovery image. For instructions on
creating the bootable USB flash drive with Product Recovery image, see “Using the Product
Recovery USB for 64-bit System Directors” on page 195.

To load the Avid ISIS software:
1. Log in to the Avid ISIS 7000 as Administrator (default password: is-admin).
The Avid ISIS 7000 product documentation is in PDF format. You can access the documentation
in the AvidISISDocumentation folder on the Avid ISIS installer kit. You need to download and
install Acrobat Reader on your Avid ISIS 7000 before you can access the PDF documentation.
2. Make a folder for the software kit on your root directory (C:\) of your System Director.
3. Insert the 4 GB USB flash drive (with software kit) into any of USB ports on your System

Director.

You can run the software installer from the USB flash drive. The advantage of copying the
software kit to the Avid ISIS 7000 is that you have easy access to kit files if you should ever them
in the future.
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3 Installing Software and Configuring 10-Gb Link Aggregation

If the USB flash drive does not automatically display:
a. Double-click the computer icon on the desktop.

b. Double-click the USB flash drive icon in the window and copy the software kit into
the new folder you created on the Avid ISIS 7000 system.

4. (Option) The Avid ISIS 7000 software kit is also available on the Avid Download Center
(www.avid.com/support/downloadcenter). Uncompress (unzip) the downloaded
software kit in the new folder on the Avid ISIS 7000 system.

5. Double-click the Autorun.exe file in the software kit.

The installer splash screen appears.

7000

Package Selection Contact
RECMESTVEICR LWL SIS 7000 System Director ~

Software Installation

Software Package Action
System Director Software ot ins al
IS1S Client Installers

1515 Blade Installers

I1S1S SNMP Extension Agent

% Avid highly recommends that you click the ReadMe link. This displays the ReadMe file that
provides the latest information regarding the Avid ISIS 7000 system. You must have Adobe
Reader installed to view the PDF.

The following table describes the installer options and their functions.
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Installer Dialog Box

Software Installation

Selection Function

Package Selection  Select the ISIS 7000 software kit from the “Select Software Package” menu.

ISIS 7000 — Selects the ISIS 7000 software kit. Select this menu item to
install the Avid ISIS 7000 software on the System Director. This software
cannot be installed on the same server as the File Gateways software.

File Gateway — Selects the Avid ISIS File Gateway software kit. Select
this menu item to install the Avid ISIS File Gateway software. This
software cannot be installed on the same server as the System Director
software. If setting up the File Gateway, see the Avid ISIS File Gateway
Setup and User’s Guide.
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Installer Dialog Box (Continued)

Selection

Function

Software
Installation

System Director
Software

Resources
Contact

Avid’s Website

Click the “This Avid ISIS 7000 Engine is the System Director” checkbox if
you have one enclosure or have multiple enclosures but want this enclosure to
be the System Director which includes the software that runs the
Management Console and tracks the metadata stored in all the data drives.

System Director Software — Installs the System Director software used
to run the data drives and creates the file system for the data drives. It also
provides the ISIS Management Console and error logging. The installer
detects the operating system (Windows 32-bit and 64-bit) and installs the
appropriate software and creates the file system used by the engines; it
also provides the ISIS Management Console and error logging.

Also installed on the System Director are the client installers and the
Storage Blade (ISB) and switch (ISS and ISX) firmware. You need to load
the switch and ISB firmware on the engines before clients can use the
Avid ISIS System. See “Installing Software on the Engines” on page 94.

ISIS Client Installers — Installs the “client installers” on the System
Director. Clients can then install the latest software on the clients from the
System Director Management Console window. These installers are
accessed when you click the Installers icon in the Management Console.

ISIS Blade Installers — (System Director only) Installs software to
support Simple Network Management Protocol (SNMP). It is used with
network management to monitor network-attached devices for conditions
that warrant administrative attention. These SNMP monitoring agents are
used with an OpenNMS user interface to support the Avid System
Monitor.

Displays the Avid corporate address and contact information.

This link brings you to the Avid web site (www.avid.com). If you do not have
internet access on the computer running this software installation, Page not
found is displayed.


http://www.avid.com

Software Installation

Installer Dialog Box (Continued)

Selection

Function

ReadMe

Documentation

Browse Content

Create Recovery
USB Drive

Avid recommends that you read all the information in the ReadMe file
thoroughly before installing software or attempting to use the Avid ISIS
system. This ReadMe provides information that is not in the other Avid ISIS
documentation.

Search the Avid Knowledge Base for the most up-to-date ReadMe file,
which contains the latest information that might have become
available after the documentation was published. To view the online
version, visit the Knowledge Base at www.avid.com/readme.

The document provides hardware and software requirements, a limitations
and known issues, and other important information. You can access the
documentation in the top-level AvidISISDocumentation folder on the Avid
ISIS installer kit.

This is a link that brings you directly to the AvidISISDocumentation folder
on the Avid ISIS installer kit. This folder can be wherever the installer files
have been saved. This folder has all of the Guides that are included with the
release.

This is a link that brings you directly to the Avid ISIS installer kit. From here
you can access all the files included in the kit. The links accesses the software
kit wherever the installer folder has been saved.

You can use the Browse Content link to load the appropriate client
software from the software kit on the client. You can find the client
installer in the \AvidISISClientlnstallers folder.

This link opens a tool that helps you create a Product Recovery USB Flash
Drive. Avid highly recommends you copy the image to the USB flash drive
provided with your ISIS 7000 as part of your initial setup. For instructions on
using this tool, see “Using the Product Recovery USB for 64-bit System
Directors” on page 195.

. Select ISIS 7000 System Director from the “Select Software Package” menu.

The File Gateway selection is used when loading the Avid File Gateway server. The File
Gateway software cannot be installed on the same server as the System Director software.

. Click Apply.

. Follow the screen prompts accepting the defaults and License agreement.

. Once the installation is complete, click Finish.
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Product Recovery Needs to be Copied to the USB Flash Drive

The product recovery image is included on the D:\ or E:\ partition of the system drive. The
software installer splash screen provides a link to a tool that copies the image to the 16 GB
USB flash drive provided with your ISIS 7000. Avid highly recommends you copy this
image during the initial system setup. For instructions on how to create the product recovery
USB flash drive, see “Using the Product Recovery USB for 64-bit System Directors” on
page 195.

Installing the Application Key

You need to have the Application Key installed to make an Active partition.

To install the application key (dongle):
1. Locate the application key in the Avid ISIS kit.

2. Install the application key into one of the USB ports on the System Director. For an
exact locations, see Engine Front View or “Engine Rear View” on page 28.

Make sure the application key is seated completely in the port.
If you have multiple Avid ISIS Engines, the application key must be plugged into the Engine

that is running the System Director software. Clients cannot access the Avid ISIS software if
the application key is plugged into the Engine-only system.

Creating a Active Partition on the System Director

92

On new installations you must initialize your system by creating a Active partition on the
System Director.



To create a Active partition:

Software Installation

1. Click Start > Programs > Avid Unity System Director and select System Director Control
Panel. The Active Mode displays as blue in the Avid ISIS System Director Control Panel

window.

Blue Active

Mode

=101

Systern Directar Status | Configuration | Active Clients | Metadata Status | Advanced Settings |

Start System Direstor|

Requests per second

Stop System Director|

Swpstem Director Wersiar: 2.0.0

w

Requests per second 2

tegabytes per second 0o

n:|

Chanrels in use

Metadata synchronization

Reast Event Display MBits/Ses |

Help

2. Click the Configuration tab.

3. Click Stop Server

_(aix]
System Divector Status  Configuation | Active Clents | Metadata Status | Advanced Setiings |
~ Server Control Operations ~ Configuration
{ Ghart Garver General Configuration
Stop Server Falower Configuration.
~ Maior File System Operations ~Tools————————————————
Create New Active.. Launch Viewer

Create New Standby,

Create From Impart,
Stz

Recorfigure File Syster..
Server is not unning
Delste File System.

Close Helps

When you click Create New Active, this action results in the loss of all media assets on the
system. This is a non recoverable action and extreme caution should be exercised when this

command is invoked.

4. Click Create New Active. The server automatically restarts when complete.

5. If you are not placed in the Status Tab, click System Director Status.

The Standby Mode has changed to Active Mode and the light is Green.
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Installing Software on the Engines

After you have loaded new software on the System Director you need to upgrade the
software on the engines. You can use Web Administrator from anywhere to perform the

following functions, but you usually do it from the System Director:
*  Upgrade the ISS and IXS with the proper/latest software

*  Upgrade the ISBs with the proper/latest software

*  Create Workspaces

To upgrade the software:

1. Go to https://IP address of System Director (or virtual name):5015.
2. Log into the System Director.

The default Administrator password is blank.

The ISIS Management Console opens.
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Hardware  biades. upgrade snitch blades, blades. of all oiphaned elements. modify deseriptions for all Status, Resenations
and remee status for all devices
chasziz,
J J J J J
3| Monitoring Tool % ISIS Toolbox é& LDAP Sync Tool
Monitor the current state of the Connaction Analyzer, Log Synchronize uzer information
Tools Unity ISIS System. Launches a Agaregator, Disk Analyzer and with your LDAP server.
java taal. Switch Manager. Launches a Launches a java toal.
jaua tool
o 5 4 - o 4 5 - =k
1515 Setup %5 | Logging %5 | Diagnostics %f | Agent Configuration B L; . Installers
Preferences, Change administration Logs, System System Directar Status, System Agent Infarmation, Agent Download the client and flash
Advanced  Password, Extemal Logs, Profiler, 1S1S Snapshots Information, Ping, Nebwak Options, Agent Trace Setup installers.
Authentication, Interplay Health Statiztics
Monitor, Hotification Semvice

3. Click Chassis.




4. Select the chassis you want to upgrade in the Chassis list.

Software Installation

Upgrade Upgrade
Storage Blades Switch Blades
f AV D ity iz15 2.1/ 1518 avid-lab.corm SRR RIS ‘

Y/ S

@ Refresh % Upgrade Blades '@ Upgrade Switches P Remove Status 2, Details

Chassis
Serial Number

Status Time Storage Blade Status Switch Blade Status Available Spare Active

5. Click Upgrade Switches.

[«

% Upgrading switches takes approximately 25 minutes for the original ISIS switches and
10 minutes for the v2.x switch hardware (ISS2000 and 1XS2000). You should upgrade switches
on all your engines at the same time.

After all the Switch Blades are updated, upgrade the Storage Blades.
6. Click Upgrade Blades.
The Upgrade Storage Blades window opens.

Upgrade Storage Blades

Folders Files
JsisBladess ISISStDrageB\ad972.072444D.M\
T Upgrade .tgz file
Command ftnoifindexserverlsisBladesSISStorageBlade_2.0_24440 tgz
[ geBlade_2.0_24440g | Upgrade
Optiong I I
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3 Installing Software and Configuring 10-Gb Link Aggregation

7. Select the upgrade file, and click Upgrade.
Each Storage Blade takes approximately 10 minutes.

8. Select the engine and click Details.

Refresh

/

Select an engine System Overview Toolbar

Details

DOCISIS avid-lab.com - avstem

AV P/ unity 1515 2 1.1

Home D/Adminis‘traﬁon Toal » Chassiz

)

ffa glanoe -

Logout

/ — N N

@ Refresh % Upgrade Blades '@ Upgrade Gwitches  §F Remove Status 4, Details
Chassis
Serial Number

w Delails

| Status Time | Storage Blade Sta

Serial Mumber
Status Time

Storage Blade Status
Switch Blade Status
Availakle 0
Spare 2
Artive 4
Storage Blades 16
Switch Blades 2
Povver Blades 3

CRIE49051

w Switches
In band IP
1722010326
1722010390

Status

P
Select All Deselact All

w Siorage Elements
Mame

& SEODO
L& SEDDH

| Status Time
O7MG/2008 09:40:15
N7ARLANA N5 411 7

Version
2.0.0 24440
2.0.0 24440

O7MES2005 094033

Type Ten
Irtecrated

Irtecrated

1

\ Status | Type
Active

Artive

b4

4
Select All Deselect All

:

4 3

I Apply || Revert || Close |

|SeriaINumber V||:|n0t |comams YH

| [Fitter |[Clear |1 of 1

The Status for the upgrade is shown in the Details pain at the right of the window. Click
the Refresh button whenever you want the updated upgrade Status. When the Status is

empty, the upgrade is complete.

status graphically displayed.

9. Repeat the Software upgrade process for each Storage Blade.
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Other ways to view the installation status is to use the Monitor Tool, the color indicator in
the System Overview Toolbar, and the Storage Blade Status column. Select the Engine
Summary in the left pane for each engine and click the Upgrade button to see the install




Software Installation

Engine Does Not Appear in Add Chassis List

If the engine did not appear in the Add/Remove page, you must stop and troubleshoot the
problem. Once the engine appears in the list, continue adding any additional engines. Perform
the following steps one at a time and wait for the Add Chassis process to time-out before trying
the next step.

To troubleshoot why an engine did not appear in Add/Remove page:

1. Reseat the interconnect cables; both sides of the interconnect should have a green solid link
light when powered on. If not:

a. Remove the cable.
b. Click Add chassis.
c. Replace cable.
2. Reseat the ISS that is being added:
a. Remove the ISS.
b. Click Add chassis.
c. Reseat ISS.
3. Try a different IXS port:
a. Disconnect interconnect cable from IXS port.
b. Click Add chassis.
c. Attach interconnect to a new port on the IXS.
4. Try a different a new interconnect cable:
a. Disconnect interconnect cable.
b. Click Add chassis.

¢. Replace interconnect cable.

Check Switch IP Address

Telnet to the newly added switch at the expected IP address.

If the switch cannot be reached, try the following:
1. On the IXS Switch Agent, view “System Overview.”

2. Click on the link for the newly added chassis. If PethO-IP is not correct, Set switch back to
the default.

If the IP address is correct, proceed to the next step.

97



3 Installing Software and Configuring 10-Gb Link Aggregation

3. Check the State Machines in “System Overview” under “Stack Port Status.” The state
for the newly connect port should eventually become “SW_PORT_STACKED.” If it
does not, try the following:

a. Reseat the interconnect cable.
b. Restart the newly connected switch.

c. Restart the IXS.

Java Runtime Environment

The Avid ISIS Management Console and Avid ISIS Client Manager requires version 6 (build
1.6) or higher of the Java Runtime Environment (JRE). Avid provides a qualified version of
JRE for Windows systems on the Avid ISIS software kit in the [drive]:\Tools_3rdParty\Java
folder.

For clients using a Macintosh system, download the Java software from the Apple® Web site
(www.apple.com) or use the Apple Software Update.

Loading Client Software

You can load the Client software in several ways:
*  You can take the software kit to each client separately and load it from the DVD.

*  You can store the client software somewhere on the corporate network and allow
everyone who needs the software to gain access to it and load it.

*  You can use the a Browser to reach the ISIS Management Console and load it from the
System Director because it was loaded during the previous installation of the Client
Installers.

Keep in mind the following when connecting Avid ISIS clients.

*  When installing Avid ISIS client software on Windows systems, make sure you are
up-to-date with your Windows critical updates.

e Zone 1 clients must use 1 Gb connections to the ISS. The ISS does not negotiate at any
rate below 1 Gb. If 100 BASE-T connections are needed, connect the clients or server to
external switches configured for Zone 2, 3, or 4.

Connect TransferManagers and AirSpeed servers to Zone 1 or Zone 2.

To install the client software using a browser:
1. Start your browser application.
2. Run your Windows Update and accept all “High-priority Updates.”
3. Go to https://IP address of System Director (or virtual name):5015.
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Software Installation

The ISIS Management Console opens.
4. Type your Administrator’s password.
5. Click Administration.

An Installer Downloads screen opens.

‘v..’ ISIS Management Consale Sy Ftem 6t 8 glance 1 :55:50
Home * Installers a RE Logot
Avid ISIS Installer Downloads
. Category Installer File |
|S1EBladess |S158torageBlade_ taz download I
|ISISBladess SIS SwitchBlade_ tgz download
SIS Client! AidISISCHent_AirSpeead_iso download
ISISClient! AvidISISClient_MacOSx_ dmog download
SIS Client! AidISIECHent_Win32_.msi download
ISISClient! AvidISISClient_WinGd_ msi download
SIS Client! AidUnitylSISClient ILRE_ tgz.des download
flash/ install_flash_player_firefox exe download
flashi install_flash_player_internet_explorer.exe download
flash/ install_flash_player_osx_ub.dmag download
flashi uninstall_flash_player.exe download
flash/ uninstall_flash_player_osx.dmog download

6. Click the appropriate ISISClient installer.

The installer might ask if you want to save or run the installation software; either is
acceptable.

Win32 client ISISClient AvidISISClient_MacOSH_.dmg
installers  ——— | igi5ceny AvidISISClient_Win32__msi
ISI12Client! AvidISISClient _\Wing4_.msi
Flash ISISClients AvidUnityISISClient_ILRE_ tgz.des
executable flashi install_flash_player_firsfox exe
flashi install_flash_player_internet_explorer.exe
flashi install_flash_player_osx_ub.dmg

7. (Option) During a Windows installation a question appears asking who the software is for;
select “Everyone.”

8. Click the appropriate Flash executable.

9. Restart the client system when asked.
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3 Installing Software and Configuring 10-Gb Link Aggregation

The client software is installed.

Installing Macintosh Client Software Using Safari

When installing the Avid ISIS software on a Macintosh client using the Safari browser;
Safari completes the download, mounts the disk image, and starts the installer. Be aware that
other browser applications do not automatically mount the disk image. After the software is
successfully installed, dismount the installer volume:

To dismount the Avid ISIS installer volume on a Macintosh client:

1. Locate the mounted volumes listed in the left pane of the Finder window.

2. Select the volume that contains “AvidUnityISIS” in the name.

3. Click the eject button that appears to the right of the volume name.

Loading and Configuring Client software for Zone 3 Clients
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Loading clients software for Zone 3 clients is similar to Zone 1 or Zone 2 clients. After
loading the software for Zone 3 clients you need to perform some special configuration
functions.

To load and configure Zone 3 and Zone 4 clients do the following:

1. Load the client software as explained in Loading Client Software.

2. Do one of the following:

4

(Windows) If the Client Manager icon is not available in the Windows taskbar,
select Start > All Programs > AvidUnityISIS > ClientManager.

(Windows) Click the Client Manager icon in the Windows taskbar.

(Windows) Right-click the Client Manager icon and select Unity ISIS Client
Manager.

(Macintosh) Double-click the Client Manager alias icon on the desktop, or

double-click the Client Manager alias icon in the dock.

(Macintosh) If the Client Manager alias icon is not available, select Go >
Applications, and then double-click the AvidUnityISIS folder. In this folder,
double-click the UnityClientManager file.



Connections
list

Workspaces
list

The ISIS Client Manager opens.

& Unity ISIS Client Manager

Software Installation

DOCISIS sl@ 2
Auto Connect
Pt [ ]
4
Auto Online Workspace &+ System Retrieved Free Total Used Protection R/W
-~
b
Workspace Name | Filter 0cfO Retrieve details: Mounted A
Level Time Message
INFO FriNov 05 14:22:51 EST 2008 Disconnected from system 'DOCISIS® by user ‘administrator’. -
INFO FriMNov 05 14:22:80 EST 2003 Workspace "\D0CISIS'workspace1® was disconnected.
ERROR  FriNov 06 14:18:23 EST 2008 Problem retrieving user workspace list from System Director: *DOCISIS®. ERROR: Unable o completeo..
ERROR  FriNov 05 14:18:22 EST 20089 Failed to retrieve bandwidth limits from System Director 'D0CISIS'. ERROR: Unable to complete operati...
FriNov 05 14:18:19 EST 2009 Unable to validate workspace connection “‘workspace1' on drive " Ernor: Unable to complete operation. B...
ERROR  FriNov 05 14:18:19 EST 2009 Problem retrigving user workspace list from System Dirsctor: “DOCISIS®. ERROR: Unable o completea...
pat)

Preferences

3. Click the Preferences button and the Client Manager Preferences Window opens.

2 Preferences

General

Add button

Remove button Clear button

Advanced

Metwork

172.20,117.2

172.20,108.73

[

— Remote Hosts list

W

Apply

Resverk
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4. Click Remote Host.
5. Click Add.
A dialog box appears.

6. Type the name or IP address of the System Director (never type the Virtual addresses)
and click OK.

You must add the computer name for both System Directors if you have two.

7. Click Apply and close the Window.

Avid Interplay Authentication

Avid Interplay Authentication requires the Avid ISIS System Director to use a virtual name.
The System Director’s virtual name must not match the actual host name and must be
entered in the General Configuration Options dialog box even if your Avid ISIS system
configuration only has one System Director. For instructions on adding the virtual name,
search the Avid ISIS 7000 Administration Guide for General Configuration Options.

Configuring a 10-Gb Link Aggregation Group
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The 10-Gb link aggregation connection is done using the 10-Gb port on the ISS. You can
make a 10-Gb link aggregation connection on the left, right or both subnets. The number of
10-Gb links you can create, depends on the number of 10-Gb ports available on your zone
switch (Avid Production Network switch). The following procedure describes the process.
For an overview of 10-Gb link aggregation, see “10-Gb Link Aggregation Overview” on
page 44.

To create a 10-Gb link aggregation:

1. Configure your Avid Production Network switch for your 10-Gb link aggregation
connections.

This process is not described in Avid documentation, see the documentation that comes
with your switch. For additional information on configuring qualified switches, search
the Knowledge Base for the Avid ISIS Ethernet Switch Reference Guide.

Avid Production Network switches need to be configured for Source Destination IP
addresses in terms of link aggregation load balancing. This is the default both in Avid ISIS
switches and the Avid Production Network switches that have been qualified, no other load
balancing configurations are supported.



Configuring a 10-Gb Link Aggregation Group

If you connect the 10-Gb link cables before you have configure the link aggregation in the
ISIS Management Console, you will create network loops.
2. Open the Switch Blade Agent (see the Avid ISIS 7000 Administration Guide).

Click Switch Blade in the Management Console and double-click on the Switch Blade to
open he switch agent page. The default password is se-admin.

3. Click the System tab if it is not already selected.
The System window opens.
4. In the 10 Gb Link Aggregation area, click “Create new group.”

The agent displays information for the type of group and network. A maximum of eight
10-Gb links can be in a group.

Tools Logging  Advanced Logout

System Step 1. Select the type and network for the new link

Overview aggregation group
Link Aggregation Group Type
Configuration [(2 10 Gh |
Basic —Network
Set stack password @ | eft
Add/Remove chassis C Right

Reboot a chassis
Flush chassis Cantnua [

manager logs

Set chassis manager

log level

10 Gb Link Aggregation

View current settings
p Create new group
Enable/Disable
Restart

Delete configuration

Configure failover
policy

Hi-Gin | ink Anaranatinn

5. Select either the Left (VLAN 10) or Right (VLAN 20) in the Network area of the window
and click Continue.

The ISSs on either the left or right side of the stack are listed.
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3 Installing Software and Configuring 10-Gb Link Aggregation

6. Select the serial number of the ISS you want to use for your new link aggregation group
and click Continue.

A minimum of two ports must be selected.

select Left, Right, or Both to remove the link aggregation configuration.

Do not click Restart in the 10 Gb Link Aggregation area unless instructed to do so by

If you make a mistake on your link aggregation group, click “Delete configuration” and
& an Avid representative.

7. Click Enable/Disable.
The top of the window displays the current 10-Gb link aggregation status.

8. Select Left, Right, or Both, and Enable, and then click Submit to enable the link
aggregation that you just created.

9. (Option) Repeat step 3 through step 8 to create a link aggregation for the other side.

Link aggregation groups are created on the left and right sides individually. You can
have a link aggregation just on one side if you want.

10. Connect the interconnect cable between the 10-Gb ports on the ISS switch you have
configured.
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n Configuring Two Stacks of ISIS Engines

This chapter explains how to configure you ISIS engines into two Management Domains
(stacks); typically when setting up your ISIS environment with more than twelve engines. The
standard ISIS configuration supports up to twelve engines with one or two System Directors.

ISIS environments typically are configured with two System Directors for redundancy protection
against data loss. For information on connecting and configuring two System Directors, see
“Configuring the System for Failover” on page 116.

The following are the guidelines when planning two stacks of ISIS engines:

Maximum number of engines in a stack is twelve engines; therefore all configurations larger
than twelve engines must be configured for two Management Domains (two stacks)

Each stack, regardless of the number of engines, is configured into two subnets (VLAN 10
and VLAN 20)

When adding more than twelve engines you increase the amount of shared storage, the file
and client counts are the same regardless of the number of engines and whether you have
one or two stacks

An Avid ISIS configuration with two Management Domains can be managed by a single
Avid Interplay configuration

Maximum Storage Group size is capped at twelve engines; you cannot increase the size of a
Storage Group that already has twelve engines by adding an engine in a different
Management Domain

Storage Groups cannot expand across Management Domains.

Multiple Storage Groups are supported in each Management Domain, a minimum of two
Storage Groups are required with more than twelve engines (or at least one Storage Group
per stack)

When you have two Management Domains, the Storage Groups in both Management
Domains must be Mirrored (RAID Storage Groups are planned for a future release)



ISIS Two Stack Configuration

*  Configurations with more than twelve engines or two stacks require generation 2 hardware
(ISS/IXS2000)

*  Configurations with more than twelve engines or two stacks require the SR2500 or AS3000
System Directors. For information on updating your System Directors see “Replacing the
System Director” on page 192

*  Two stacks are linked by 10 Gb Ethernet connections using external switches (EXS)
For a list of supported external Ethernet switches, see the Avid ISIS 7000 ReadMe.

e Each VLAN must use the same number of 10 Gb connections on the external switches
between each stack

ISIS Two Stack Configuration

Each stack, regardless of the number of engines, is configured into two subnets (VLAN 10 and
VLAN 20). The following illustration shows the division, and the 10-Gb Link Aggregation used
to link the two Management Domains.
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4 Configuring Two Stacks of ISIS Engines

Two Stack Configuration

(Option 1) 10 Gb connection
to zone 2 switch

Left side
(default subnet 10)

Right side
(default subnet 20)

10 Gb connection
to house network

10 Gb connection
to house network

External 10 Gb
Ethernet switch

External 10 Gb
Ethernet switch

(Option 2) 10 Gb connection
to zone 2 switch

(Option 2) 10 Gb connection
to zone 2 switch

(Option 1) 10 Gb connection
to zone 2 switch

TN
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ISIS Two Stack Configuration

External Switch Link Aggregation Connection Guidelines

The following table provides the recommended number of 10-Gb link aggregation connections
between ISIS Management Domains when configuring more than twelve engines. Typically, you
would not use more than one stack if your site has twelve engines or less. If planning on more
than twelve engines, it is recommended that you set up your initial ISIS environment with two
stacks. Then when you expand to more than twelve engines, the additional engines can be added
without reconfiguring your single stack environment and IP Address scheme. For information on
10-Gb link aggregation connections, see “Configuring a 10-Gb Link Aggregation Group” on
page 102.

For best performance each Management Domain should be balanced with the same number of
engines in both stacks. A 10-Gb link aggregation connection goes from VLAN 10 of the first
stack to the external switch and then another 10-Gb link aggregation connection goes from that
external switch to VLAN 10 on the second stack. VLAN 20 has a 10-Gb link aggregation
connection from the first stack to a second external switch and then another 10-Gb link
aggregation connection that goes from the second external switch to VLAN 20 on the second
stack A diagram of these connections are shown in “Two Stack Configuration” on

page 108.These four connections are considered one 10-Gb link aggregation connection
described in the following table. You must have the same number of 10-Gb link aggregation
connections on both VLANs between the Management Domains. These connections are
bidirectional (full duplex) between the Management Domains.

Each 10-Gb link aggregation connection provides 600 MB/s bandwidth. To get the best full
bandwidth possible, you should make the 10-Gb link aggregation connections between the
Management Domains as listed in the following table. For more details on the bandwidth
between Management Domains, see the Avid ISIS Performance and Redistribution Guide.

Number of Engines Number of Engines Number of 10-Gb Link Aggregation

in First Stack in Second Stack Connections per Subnet
Up to 12 engines 1 engines One 10-Gb Link Aggregation
Up to 12 engines 2 engines Two 10-Gb Link Aggregation
Up to 12 engines 3 or 4 engines Three 10-Gb Link Aggregation
5 or more engines 5 or more engines Four 10-Gb Link Aggregations
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4 Configuring Two Stacks of ISIS Engines

IP Address Classes

You need a subnet with enough IP addresses to accommodate the number of engines, clients,
and devices you are connecting to your ISIS shared storage environment. A Class C network

typically provides 254 usable addresses. Your shared storage environment might need a
larger block of IP addresses than a Class C network provides. The pool of addresses in a
Class B network provides around 16,000 addresses, (which in most cases would be much
larger than required).

A 20 engine ISIS configuration uses a minimum of 340 IP addresses. If you plan on over 170

clients you need to use a Class B Network.

IP Addressing With Two Stacks

The IP addressing scheme engines are described in “IP Addressing Overview” on page 83.
This section expands the system and configuration to include up to 20 engines. The first

table provides a review of the engine numbering scheme. The second table is an example on

the engines configured into two stacks.

Example of a Single Engine IP Address Assignments

First Engine

[SB 0

192.168.10.10 (left side)
192.168.20.10 (right side)

[SB 1

192.168.10.11 (left side)
192.168.20.11 (right side)

[SB 2

192.168.10.12 (left side)
192.168.20.12 (right side)

[SB 3

192.168.10.13 (left side)
192.168.20.13 (right side)

[SB 4

192.168.10.14 (left side)
192.168.20.14 (right side)

[SB 5

192.168.10.15 (left side)
192.168.20.15 (right side)

[SB 6

192.168.10.16 (left side)
192.168.20.16 (right side)

[SB 7

192.168.10.17 (left side)
192.168.20.17 (right side)

[SB 8

192.168.10.18 (left side)
192.168.20.18 (right side)

[SB 9

192.168.10.19 (left side)
192.168.20.19 (right side)

[SB 10

192.168.10.20 (left side)
192.168.20.20 (right side)

ISB 11

192.168.10.21 (left side)
192.168.20.21 (right side)

[SB 12

192.168.10.22 (left side)
192.168.20.22 (right side)

[SB 13
192.168.10.23 (left side)

192.168.20.23 (right side)

[SB 14

192.168.10.24 (left side)
192.168.20.24 (right side)

ISB 15
192.168.10.25 (left side)

192.168.20.25 (right side)

Switch (ISS or IXS)
192.168.10.26

Switch (ISS or IXS)
192.168.20.26

Each engine uses 17 IP addresses on two subnets. The following table shows an example of

the starting and ending IP addresses for 20 engines on two VLANS.
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ISIS Two Stack Configuration

Starting and Ending Engine IP Addresses for Two Stacks

VLAN 10 Subnet VLAN 20 Subnet VLAN 10 Subnet VLAN 20 Subnet

Stack 1

Stack 1

Stack 2

Stack 2

Engine 1
192.168.10.10
192.168.10.26

Engine 2
192.168.10.27
192.168.10.43

Engine 3
192.168.10.44
192.168.10.60

Engine 4
192.168.10.61
192.168.10.77

Engine 5
192.168.10.78
192.168.10.94

Engine 6
192.168.10.95
192.168.10.111

Engine 7
192.168.10.112
192.168.10.128

Engine 8
192.168.10.129
192.168.10.145

Engine 9
192.168.10.146
192.168.10.162

Engine 10
192.168.10.163
192.168.10.179

Engine 11
192.168.10.180
192.168.10.196

Engine 1
192.168.20.10
192.168.20.26

Engine 2
192.168.20.27
192.168.20.43

Engine 3
192.168.20.44
192.168.20.60

Engine 4
192.168.20.61
192.168.20.77

Engine 5
192.168.20.78
192.168.20.94

Engine 6
192.168.20.95
192.168.20.111

Engine 7
192.168.20.112
192.168.20.128

Engine 8
192.168.20.129
192.168.20.145

Engine 9
192.168.20.146
192.168.20.162

Engine 10
192.168.20.163
192.168.20.179

Engine 11
192.168.20.180
192.168.20.196

Engine 1
192.168.11.10
192.168.11.26

Engine 2
192.168.11.27
192.168.11.43

Engine 3
192.168.11.44
192.168.11.60

Engine 4
192.168.11.61
192.168.11.77

Engine 5
192.168.11.78
192.168.11.94

Engine 6
192.168.11.95
192.168.11.111

Engine 7
192.168.11.112
192.168.11.128

Engine 8
192.168.11.129
192.168.11.145

Engine 1
192.168.21.10
192.168.21.26

Engine 2
192.168.21.27
192.168.21.43

Engine 3
192.168.21.44
192.168.21.60

Engine 4
192.168.21.61
192.168.21.77

Engine 5
192.168.21.78
192.168.21.94

Engine 6
192.168.21.95
192.168.21.111

Engine 7
192.168.21.112
192.168.21.128

Engine 8
192.168.21.129
192.168.21.145
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4 Configuring Two Stacks of ISIS Engines

VLAN 10 Subnet VLAN 20 Subnet VLAN 10 Subnet VLAN 20 Subnet

Stack 1 Stack 1 Stack 2 Stack 2
Engine 12 Engine 12

192.168.10.197 192.168.20.197

192.168.10.213 192.168.20.213

Static IP Addresses Available

There are some unused IP addresses between the two stacks that could be used for other
servers associated with the Avid ISIS environment. These IP addresses should be configured
as static IP addresses so not to interferer with the ISIS engines. The following table
demonstrates where the available IP address are located in the ISIS network. You IP address
depend on the address scheme you use to configure the ISIS network.

IP Addresses Used IP Addresses Used
VLAN 10 VLAN 20

First stack of twelve engines ~ Engine one 192.169.10.10 to Engine One 192.169.20.10 to
Engine twelve 192.168.10.213  Engine twelve 192.168.20.213

Available static IP Address 192.168.10.214 to 192.168.10.214 to
block 192.168.10.254 192.168.10.254

Second stack of eight engines Engine one 192.169.11.10 to Engine One 192.169.21.10 to
Engine eight 192.168.11.145 Engine twelve 192.168.21.145

Available static IP Address 192.168.11.146 to 192.168.21.146 to
block 192.168.11.200 192.168.21.200
Available DHCP IP Address  192.168.11.201 to 192.168.21.201 to
block 192.168.11.254 192.168.21.254

Connecting Two Stacks of Engines
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The process of connecting multiple stacks of Engines to the Avid ISIS network starts with
cabling and connecting single stacks as described in “Configuration Overview” on page 86.
First you logically configure the addresses for the engine, then you physically make the
connection to complete the process. If you need to install software, see “Installing Software
and Configuring 10-Gb Link Aggregation” on page §3.



Connecting Two Stacks of Engines

Setting-Up Two Stacks

%

Regardless of the number of engines you are planning in your Avid ISIS stack. The following
procedure summarizes the tasks you need to do after you have decided on your IP address
scheme with your Network administrator, see “IP Addressing With Two Stacks” on page 110.

To setup two stacks of engines:

1. Setup and configure each stack separately as you would in a single stack configuration (see
“Connecting ISIS Hardware” on page 70.

Each for the two stacks connect to the same System Directors.

2. Once the two Management Domains are configured, set the appropriate 10-Gb Link
Aggregation between the stacks with external switches (see “Configuring a 10-Gb Link
Aggregation Group” on page 102).

3. Upgrade your software if you are currently on an earlier ISIS 7000 software version before
setting up the Storage Groups in the separate Management Domains (see “Avid ISIS 7000
Upgrade Guidelines” on page 137).

4. See the Avid ISIS 7000 Administration Guide for setting up your Storage Groups and
Workspaces. The two stacks of engines are identified using a Domain ID in the Storage
Element page of the Management Console.

The two stacks cannot be part of the same Storage Group. Each stack must have at least one
Storage Group.

Reconfiguring One Stack into Two Stacks

In many cases you do not have to delete your data if you are splitting your stack of engines into
two Management Domains. If you have one large Storage Group and there is enough available
space in your existing stack, you can remove engines, triggering a redistribution of the data to
other engines, see “Engine Replacement” on page 189. This will make the chassis available to be
moved to the other Management Domain where they can be made into a new Storage Group, or
adding to an existing Storage Group in that Management Domain. If added that engine to an
existing Storage Group in the new Management Domain, a Redistribution will be incurred.

If you have several Storage Groups in your current stack, you can select the complete Storage
Group by removing the engines with that Storage Group to start the new stack.

The following procedure summarizes the tasks you need to do if you have one stack
configuration and want to break it into two Management Domains. First establish your

IP address scheme with your Network administrator, see “IP Addressing With Two Stacks” on
page 110, then complete these tasks.
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To disassemble the existing stack:

1.
2.
3.

9.

Upgrade to the latest ISIS software on the existing stack.
Remove all 10-Gb Link Aggregation cables (if needed).

Disable all 10-Gb Link Aggregation groups (“Enable/Disable”) in the stack, see
“Configuring a 10-Gb Link Aggregation Group” on page 102.

. Delete all 10-Gb Link Aggregation groups (“Delete configuration”) in the stack, see

“Configuring a 10-Gb Link Aggregation Group” on page 102.

. Remove the engines from stack by unplugging the engine interconnect cables.

. Use the “Reset Local Chassis ID” command in the ISIS Switch Blade Agent Page to

renumber the engines in the new Management Domain (see the Avid ISIS 7000
Administration Guide).

. Avid recommends running the Switch Diagnostics on stack 1 to make sure there are no

CITOT1S.

. Create the 10-Gb Link Aggregation groups in the stack that will be used to connect to

the external switches (EXS).
Connect to the EXS to each VLAN EXS after it is configured.

Make sure the ports on the EXS to which you are connecting these groups are
configured for link aggregation, otherwise you will end up with a loop.

To assemble the new stack:

1.

Access the switch management port on one of the new engines that will be added to the
new stack (see “Setting-Up Network Addresses In the Stack” on page 71).

. Go to System > Configuration > Basic page and update the IP configuration of the

engines that were removed from the old stack (see “Connecting ISIS Hardware” on
page 70).

. Reset the IP address scheme for each new or reconfigured engine (see “Setting-Up

Network Addresses In the Stack™ on page 71).

. Access the switch management port of one engines from the old stack.

. Go to System > Configuration > Add/Remove chassis and update the IP configuration of

the old stack

. Use the “Reset Local Chassis ID” command in the ISIS Switch Blade Agent Page to

renumber the engines that were removed from the old stack (see the Avid ISIS 7000
Administration Guide).

. Repeat step 4, 5, and 6 until all chassis have been reconfigured.

. Cable the engines for stack 2 using the engine interconnect cables that were removed

from stack 1.
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9. Avid recommends running the Switch Diagnostics on stack 2 to make sure there are no
erTors.

10. Create the 10-Gb Link Aggregation groups in the stack that will be used to connect to the
external switches (EXS).

11. Connect to the EXS to each VLAN EXS after it is configured.

Make sure the ports on the EXS to which you are connecting these groups are configured
for link aggregation, otherwise you will end up with a loop.
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This chapter explains how to enable the software for the two System Director failover systems
and how to connect and configure 10-Gb link Aggregation.

% For true redundancy it is recommended that you connect the second System Director to a
different engine than the first System Director. The Active and the Standby System Directors must
be the same model server, you cannot mix SR2400s, SR2500s, and AS3000 servers.

System Director Failover

When using two System Directors, one is referred to as Active System Director and the other one
is the Standby System Director. The File System on the Standby System Director is kept
up-to-date with the Active System Director. If the Active System Director fails, a failover
function switches to the Standby System Director to continue seamless operation. In an attempt
to keep the procedure easy to use, we use the following nomenclature:

*  When adding a new System Director to an existing Avid ISIS system or creating a failover
system configuration, the original System Director is called the existing System Director and
the new System Director is called new.

*  When installing two new System Directors to create a failover system configuration, one
System Director is called Active and the other Standby.
You can encounter two scenarios when enabling failover systems:

*  Creating failover by adding a System Director to an existing System. See “Adding a System
Director to an Existing File System” on page 118.

*  Creating failover on two new System Directors. See “Creating Failover with Two New
Systems” on page 126.



System Director Failover

Each System Director must connect to right and left sides of the engine to allow both of the
System Directors to reach the two internal subnets. Connect the two System Directions under the
following conditions:

»  After you have physically configured the system and loaded the Avid ISIS software on both
System Directors.

*  When the server software is Off on both systems.

*  The connect the Ethernet port of the Active System Director to connection 1 on the left side
of the engine (from the rear). The connect the Ethernet port of the Standby System Director
to connection 1 on the right side of the engine (from the rear).

Enabling a System Director

To enable a failover system for Avid ISIS:

1. Connect two System Directors (using straight or crossover cable) as shown in the following
figure.
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2. Enable the software on both systems, see “Configuring the System for Failover” on
page 116.
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% The configuration information for the notification service (SMTP information, contacts, and
filters) is stored in the registry on the System Director. This information is not currently
replicated to the failover System Director and must be entered manually on both System

Directors. For information on setting up the notification service, see Setting up Error
Notification in the Avid ISIS 7000 Administration Guide.

Adding a System Director to an Existing File
System

When you already have one System Director in use and you need to add a System Director
to create a failover system, you have five basic functions to perform. See the following
sections:

e “Setting IP Addresses for Crossover Link on page 118.

e “Stop the Active System Director and Set Up the Failover Connection” on page 119
*  “Configuring Failover Settings” on page 127

*  “Creating New Standby File System” on page 124

»  “Restarting Existing System Director” on page 124

Setting IP Addresses for Crossover Link

Avid recommends the System Director IP addresses for failover configurations that are listed
below. If you use different addresses, be sure to note them and have them available before
proceeding. You set the IP addresses in the Network Connections dialog box, which you
access from the Windows Control Panel. For information on setting Windows IP addresses,
see the documentation that came with your operating system.

To set IP addresses:

1. Go to Start > Control Panel > Network Connections for each System Director.

2. Set the Existing System Directors to the following TCP/IP addresses for ports 1 and 2:
- Onboard Ethernet port 1 (ETHI) - 192.168.1.1 netmask 255.255.255.0
- Onboard Ethernet port 2 (ETH2) - 192.168.2.1 netmask 255.255.255.0

3. Set the New System Directors to the following TCP/IP addresses for ports 1 and 2:
- Onboard Ethernet port 1 (ETHI1) - 192.168.1.2 netmask 255.255.255.0
- Onboard Ethernet port 2 (ETH2) - 192.168.2.2 netmask 255.255.255.0
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Stop the Active System Director and Set Up the Failover Connection

Mabke sure all Clients are notified that you are stopping the System Director.

To stop the existing System Director and set up the failover connection:

1. From the existing System Director, select Start > Avid Unity System Director > System
Director Control Panel.

2. Click the System Director Status Tab.

System Director Status 1 Configuration] Active Clienls] Metadata Status] Advanced Settings]

Requests per second System Director Version: 2.0.0

Megabytes per second

w

Fequests per second 2

D|

Megabytes per second 0.

D|

Channels in use

Metadata synchronization

Stop System Director] Feset Event Display MBits/Sec |

Help

3. Click Stop System Director.
4. Click the Configuration Tab.
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5 Configuring the System for Failover

5. Click Failover Configuration.

The System Director Failover Configuration dialog box opens.

(System Directo er Configuratio
Enable i Enable redund: perati Local Machine Name: :DOCISIS
Redundant Enter a name for the server that will be used by the clients:
Operation Virtual System Director Name:  *NOTE* This name should be the same on both System Directors

|SD2and3

Configure Virtual Addresses...

Failover routing paramelers:
- Local Machine: Remote Machine:

Manitar Port:
5000

First path IP address First path IP address

192 . 168 . 1 . 1 192 . 168 . 1 . 2

Second path IP address: Second path IP address:

192 . 168 . 2 . 1 192 . 168 . 2 . 2

Validate Send... Validate Receive... |

o]

Cancel

6. Select “Enable redundant operation.”

7. Type a name in the Virtual System Director Name text box.

The same virtual name must be assigned to both System Directors.

8. In the Local Machine area leave the Monitor port set to 5000. If you have another
application that uses port 5000, change the Monitor port to an available port number.
This port number must be the same on both the existing and the new System Directors.

9. Do one of the following:

»  When you have completed step 8 on the Existing System Director, go to step 10.

»  When you have completed step 8 on the New System Director, go to step 15.

If you have a MediaManager attached to the system and you are adding a second system to
create a failover system, it is important that you maintain the same server name and virtual
name as used previously to maintain database integrity. For example, prior to installation of
a New server, the actual and virtual server name was set to “SD.” Avid recommends that the
virtual server name for both servers be set to “SD2” and that the actual machine name be

changed from “SD2” to something like “SD2SERVER.”

10. Set the Local Machine First Path IP address to local IP 1: 192.168.1.1.

11. Set the Local Machine Second Path IP address to local IP 2: 192.168.2.1.
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12.
13.

14.
15.
16.
17.
18.
19.

20.

Adding a System Director to an Existing File System

Set the Remote Machine First Path IP address to: 192.168.1.2.
Set the Remote Machine Second Path IP address to: 192.168.2.2.

The Existing System Director has now been configured. The next step must be performed on
the New System Director.

Repeat steps 10 through 13 on the New System Director.

Set the Local Machine First Path IP address to local IP 1: 192.168.1.2.
Set the Local Machine Second Path IP address to local IP 2: 192.168.2.2.
Set the Remote Machine First Path IP address to: 192.168.1.1.

Set the Remote Machine Second Path IP address to: 192.168.2.1.

Validate the crossover connections by clicking Validate Send on one system and Validate
Receive on the other.

On the Sending System Director, you see the Red Box turn Green for each connection.

=]

Sending packets on port [2000

~Packets sent over first network path:

To IP Address: Current
I 192 . 168 . 1 . 2 Valid response...
Successful round =
0 Reset
- Packets sentto over second networkpath.
To IP Address: Current Green
| 192 .168 . 2 . 2 Valid response...
Successful round l_
0 Reset
IPress "Esc' or Exit to leave this dialog
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The numbers in the Packets Received boxes indicate the number of packets received

from the first System Director On the Receiving System Director you see the packets
received number incrementing for each connection.

validate failover connection(s)

Listening for packets from all interfaces on port [2000

 Packets r d from first k path:
From IP Packets received:

192 . 168 . 1 . 2 |13

Reset

- Packets received from second network path:

From IP

PackW
192 . 168 . 2 . 2 |14 Reset

Press 'Esc' or Exit to leave this dialog

—
| Packets received

21. On each system, click Exit.

22. Configure the Virtual Addresses on both systems by doing the following:

a. Go to System Director Control Panel, select Configuration Tab, select Failover
Configuration, and click Configure Virtual Addresses.

Choose an unused static IP address that is on both system subnets that are used as

the Virtual IP addresses for both System Directors. The following example uses

192.168.10.253.

¥irtual Server Address Configuration

Wirtual Address

—Yirtual Address 1

Local interface to which the
address is assigned

|192.168. 10 . 253 |192.168.

. 100

—Wirtual Address 2

|192.168.2D . 253 |192.168.

. 100]

Cancel |




Adding a System Director to an Existing File System

c. Map the Virtual IP address to the corresponding real IP address on each subnet for each
of the System Directors. This example uses 192.168.10.100 and 192.168.20.100.

d. Register both of the Virtual IPs in DNS with the Virtual System Director Name.

Binding Order for Health Monitoring

When you have your System Directors in a Failover configuration and use the Interplay Health
Monitor with the Interplay Framework, the VLAN 10 and VLAN 20 network interface cards
must be the first and second entries in the Network Interface Binding order to communicate

properly.

If a network crossover connection is the first entry, the System Director Health Monitor will not
display information regarding the System Director.
To set the network connection bindings order:

1. On the System Director, click Start > Settings > and double-click Network Connections.

2. Click the Advanced menu in the Network Connections window and select Advanced
Settings.

3. Click the Adapters and Bindings tab.

4. If the connections for the VLAN 10 and VLAN 20 network interface cards are not in the first
and second position, select them and press the Green Up arrow to move them to the top of
the list.

5. Make sure the two Crossover connects are be at the bottom of the list.
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Creating New Standby File System

To create a new standby file system:

1. On the non-Active System Director, select Start > Avid Unity System Director > System
Director Control Panel, and click the Configuration Tab.

2. Click Create New Standby.

System Director Status Configuiation | Active Clients | Metadata Status | Advanced Settings |

- Server Control Operations i~ Configuration

b St Berver General Configuration...
Stop Server Failover Configuration

i~ Majar File Spstem Operations ~ Tools

Create New Active.. Launch Yiewer

Create MNew Standby.
Create From Import.
r~ Status

Recaonfigure File System.
Server is nat running
Delete File System...

Close Help

Restarting Existing System Director

To restart the Existing System Director:

1. On the Existing System Director, select Start > Avid Unity System Director > System
Director Control Panel, and click the System Director Status Tab.

2. Click the Start System Director button.

L =100

System Director Status | Configuration | Active Clients | Metadats Status | Advanced Setiings |

Requests per second System Director Version:

tegabytes per second

=

Requests per second 0.

':|

Megabytes per second 0.

|:.|

Channels in use

Metadata synchionization

Start Spstem Direcloil Stop System Direclo;l Feset Event I Display MBits/Sec I
Close Help

d
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Stopping and Restarting System Directors During
Failover

You might need to stop and start the System Directors during failover at various times. Avid
recommends you stop the Standby System Director prior to stopping the Active System Director.

To determine which system is Active or Standby:
1. Select Start > Avid Unity System Director > System Director Control Panel.
2. Click the System Director Status Tab.

The second light from the top says Active or Standby.

System Direstor Statvs | Configuration | Active Cients | Metadata Status | Advanced Setiings |

Reguests per second System Directar Version: 2.0.0

Megabytes per secand

w

FRequests per second 2

D|

Active or Megabytes pst ssoond i

Standby

Channels in use

||:

Metadata synchionization

Starl System Direcior| Stop System Director Reset Event Display MBits/Sec |

Help

Stop
3. Stop or start the System directors, do one of the following:

» To stop both systems, select Start > Avid Unity System Director > System Director
Control Panel, click System Director Status, and then click Stop System Director.
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» To start both systems, select Start > Avid Unity System Director > System Director
Control Panel, click System Director Status, and then click Start System Director.

o =1of]
System Direstor Status | Configuration | Active Clients | Metadata Status | Advanced Setings |

Requests per second Spstem Director Version:

Megabytes per second

Requests per second 0o

Megabytes per secand 00

Start

Channels in use [t}

Metadata synchronization

Stop Systen D\reclo] Reset Event | Digplap ABits/Sec |
Close Help

Creating Failover with Two New Systems

When you have two new systems, you need to create a failover system between the two
systems. To do this you have to perform three basic functions as described in the following
sections:

+  “Setting IP Addresses for Crossover Links” on page 126.
*  “Configuring Failover Settings” on page 127.
*  “Creating New File Systems on the Active and Standby System Directors” on page 130.

Setting IP Addresses for Crossover Links

To set IP addresses:

1. Go to the System Control Panel of each System Director.

2. Set the Active System Director to the following IP addresses:
- Onboard Ethernet port 1 (ETHI1) - 192.168.1.1 netmask 255.255.255.0
- Onboard Ethernet port 2 (ETH2) - 192.168.2.1 netmask 255.255.255.0

3. Set the Standby System Director to the following IP addresses:
- Onboard Ethernet port 1 (ETHI1) - 192.168.1.2 netmask 255.255.255.0
- Onboard Ethernet port 2 (ETH2) - 192.168.2.2 netmask 255.255.255.0
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Configuring Failover Settings

To configure failover settings:

1. From the Active System Director, select Start > Avid Unity System Director > System
Director Control Panel.

2. Click the Configuration Tab.

3. Click Failover Configuration.

F Enable redundant operation

DOCISIS

Local Machine Name:

Enter a name for the server that will be used by the clients:

Virtual System Director Name:

*NOTE* This name should be the same on both System Direclors

[sD2and3

Failover routing paramelers:

Local Machine:

Monitor Port:

T —

First path IP address
[ 192 .

168 . 01 .1

‘Second path IP address:

[192 . 168 . 2 . 1

Validate Send...

Configure Vifual Addresses...

Remate Machine:

First path IP address

| 192

168 .1 . 2

Second path IP address:

[ 192 .68 . 2 . 2

Validate Receive... |

o]

Cancel

4. Select “Enable redundant operation.”

5. Type a name in the Virtual System Director Name text box.
The same virtual name must be assigned to both System Directors.

6. In the Local Machine area leave the Monitor port set to 5000. If you have another
application that uses port 5000, change the Monitor port to an available port number. This
port number must be the same on both the existing and the new System Directors.

7. Do one of the following:
»  When you have completed step 6 on the Existing System Director go to step 8.
»  When you have completed step 6 on the New System Director, go to step 13.

If this is the second time through the procedure for the New System Director go to step 13.
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8. Set the Local Machine First Path IP address to local IP 1: 192.168.1.1.

9. Set the Local Machine Second Path IP address to local IP 2: 192.168.2.1.
10. Set the Remote Machine First Path IP address to: 192.168.1.2.
11. Set the Remote Machine Second Path IP address to: 192.168.2.2.
12. Repeat steps 1 through 5 on the Standby System Director.
13. Set the Local Machine First Path IP address to local IP 1: 192.168.1.2.
14. Set the Local Machine Second Path IP address to local IP 2: 192.168.2.2.
15. Set the Remote Machine First Path IP address to: 192.168.1.1.
16. Set the Remote Machine Second Path IP address to: 192.168.2.1.

17. Validate the crossover connections by selecting Validate Send on one system and

Validate Receive on the other.

You should see the red box turn green for each connection on the Sending System.

Sending packets on port [5000

- Packets sent over first network path:

To IP Address: Current
I 192 . 168 . 1 . 2 Valid response...
Successful round =
0 Reset |

~Packets sent to over second network path:
To IP Address: Current
I 192 . 168 . 2 . 2 Valid response...
Successful round l_
0 Reset |

IF‘rBss 'Esc’ or Exit to leave this dialog

Green

The numbers in the Packets Received boxes indicate the number of packets received
from the first System Director. You should see the packets received number
incrementing for each connection on the receiving system.



Listening for packets from all interfaces on port |5|:”:":l

- Packets received from first network path:

From IP Packets received:

192 . 168 . 1 . 2 |13

Reset

~Packets received from second network path:

From IP

192 . 168 . 2 . 2

PackW
|14 Reset

Press 'Esc' or Exit to leave this dialog

Creating Failover with Two New Systems

| — Packets received

18. On each system, click Exit.

19. Configure the Virtual Addresses on both systems.

This allows the Client to have access to the Active System Director by using the same virtual
IP address no matter which System Director is active at the time.

The virtual addresses used in this procedure are examples and can be different for your system.

To configure the virtual address on both System Directors:

1. Go to System Director Control Panel of one of the System Directors, select Configuration
Tab, select Failover Configuration and click Configure Virtual Addresses button.

2. Select two unused static [P address, one on each system subnets, that are used as the Virtual

IP addresses by both System Directors.

The following example uses is 192.168.10.253 and 192.168.20.253.

3. Map the Virtual IP address to the corresponding real IP address on each subnet for each of
the System Directors. The following example uses 192.168.10.100 and 192.168.20.100.

virtual Address Local interface ko which the
address is assigned

—Wirtual Address 1

<

|192.153. 10 . 253 |192.168‘ 10 . 100

—Wirtual Address 2

| 192 . 168 . 20 . 253 | 192 . 168 . 20 . 100|
concer_|
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4. Repeat steps 1 through step 3 using two physical addresses of the remaining System
Director but the same virtual addresses of 192.168.10.253 and 192.168.20.253 as used
in the example.

5. If using a DNS server, you should enter the virtual name and virtual IP of the System
Director. Register both of the Virtual IPs in DNS with the “Virtual System Director
Name.”

If you not using DNS, the virtual name and virtual IP entry should be made to the
C:\windows\system32\drivers\etc\hosts file on both System Directors and all clients.

Creating New File Systems on the Active and
Standby System Directors

To create a new file system:

1. From the Active System Director, select Start > Avid Unity System Director > System
Director Control Panel.

2. Click the Configuration Tab.
3. Click Create New Active.

4. From the Standby System Director, select Start > Avid Unity System Director > System
Director Control Panel.

5. Click the Configuration Tab.
6. Click Create New Standby.

1% Avid Unity ISIS System Director Control Panel _ (o] %]

System Director Status  Configuration |Actwe Ellenlsl Metadata Slalusl Advanced Setl\ngsl

 Server Control Operations ~ Configuration

LT I General Corfiguration
Stop Server Failover Configuration...
i~ Major File System Operations rTools——————————————
Create New Active Launch Yiewer
Create Mew Standby...
Create From Import...
[Status————
Reconfigure File System _
Server is not running
Delete File Spstem. .
Clase Help

7. Click Close.
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IJ Status LEDs and Stacking Problems

This chapter provides an explanation of the light-emitting diodes (LEDs) located on the different
sections of the Avid ISIS engines. It also provides a information on how to recover from a
stacking problem. The following sections are included:

* LED Locations and Colors

e LED Summaries

*  Recovering from Stacking Problems

The ISS and IXS have activity and link LEDs for each port. The location of these LEDs are

shown in “Integrated Ethernet Switches” on page 29. These LEDs provide the following
functions:

*  Activity — The activity LED indicates that the port is in use.

* Link — The link LED indicates that there is an active connection on the port.

LED Locations and Colors

The status LEDs are used to indicate errors and provide status on the different phases of the
software installation. The LED colors and blinking indicate the following functions:

*  Qreen-blinking — System or section is getting ready or is OK
* Green-steady — System or section is OK and operational
*  Amber-blinking — Minor failures occurring, but not fatal

*  Amber-steady — Fatal or almost fatal error has occurred, system or section is not
operational.
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LED Summaries

When determining errors, the status LED blinks at one of the following three rates or stays
On (steady).

¢ Slow: 0.5 Hz
¢ Medium: 2.0 Hz
e Fast: 5.0 Hz

The following table provides a description of the ISS status LEDs.

ISS LED Summary

Color and Blink Speed Status

Green — slow Starting the Operating System
Green — steady with 50 ms of black each second Master OK
Green — steady with 50 ms of amber each second Backup OK

Amber — fast High temperature (> 60C)
Temperature critical (> 70C)
Waiting for temperature to drop

Amber — steady Temperature OK/Not booting yet
Error?® (followed by restart, but restart might not work)

a. Possible errors include: missing critical application, low level code problem, or temperature is critical.
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The following table provides a description of the ISB status LEDs.

ISB LED Summary

Color and Blink Speed

Status

Green — slow

Green — fast

Green — steady

Amber — slow, all ISBs asynchronously

Amber — fast

Amber — steady

Amber and Green — alternating fast flashing
(irregular)

Starting the operating system
Degraded state

OK

No engine configuration

High temperature (> 60C)
Temperature critical (> 70C)
waiting for temperature to drop

ISB has been taken off line in the user interface or
Temperature OK/Not booting yet Error (followed by restart,
if restart not working)

Possible errors include: missing critical application, low
level code boot problem, or temperature is critical.
ISB has been taken off line because of a serious memory

€rror

The ISB needs to be replaced.

The following table provides a description of the Engine LEDs.

Engine LED Summary (Master ISS and All ISBs Synchronously)

Color and Blink Speed

Status

Green — slow
Green — medium

Green — medium

External request via ISS agent
Stacking failure (error or collision)

Engine error (anywhere)
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The following table provides a summary of the Engine LEDs during software installations.

Software Installation LED Reporting

Color and Blink Speed

Status

Green — steady

Amber — 2 second interval
Amber — 1 second interval
Amber — 2 second interval
Amber — 3 second interval

Amber — fast

No installation in progress

Installation starting, installing in phase 0
Installation in phase 1

Installation in phase 2

Installation in phase 3

Installation failed

Recovering from Stacking Problems

If your Avid ISIS shared storage network has a serious problems as a result of the setup, it
might necessary to recover the stack. Here are a few possible problems:

»  Traffic loops were introduced

»  Switch does not have the right IP address

» [P addresses seem to flipping; sometimes belonging to one switch, and then belonging

to another switch

Set One Switch Back to Default
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The problem might only be with one particular switch or engine. If you think this is the case
(for example, a switch that was added does not have the right IP address), then perform the

following.

To set a switch back to the default:

1. Disconnect the interconnect cables to both switches in the chassis of the problem
switch. (If the problem switch is an IXS, disconnect all stacking cables from each switch

in the chassis.)

2. In the Add/Remove Chassis page of the IXS, click Delete for the problem chassis.

3. Connect through the management port to the problem switch.

4. Use the management IP to go to the Switch Agent of the problem switch. For example

https://192.168.0.10:5015/.



10.

Recovering from Stacking Problems

Navigate to the “Advanced” page.
Under Switch Blade, click “Reset to factory defaults.”
Enter the password when prompted to reset the switch to defaults.

The switch and storage blade password is se-admin and the System Director password is
is-admin.

The switch restarts.

When the switch starts up, it has IP address “192.168.10.26” and the password is reset to
default.

If the problem switch is an:

- IXS — Click Add from another IXS. If there is not another IXS, click Add from another
ISS.

- ISS — Click Add from the IXS to which this switch will connect.
Connect the interconnect cable from the problem switch to the IXS.
- Ifthe problem switch is an IXS, connect an interconnect cable to another ISS.

- Ifthe problem has been resolved, connect the interconnect cable from the switch on the
other VLAN subnet to the IXS on fixed subnet. If the problem switch was an IXS,
re-connect all other interconnect cables in the engine.

Rebuilding the Stack

%

The following procedure summarizes how to rebuild the entire stack of engines.

To rebuild the stack:

1.
2.

Disconnect all interconnect cables between all switches.
Pull each switch by removing them from the engine.

This clears any traffic loop problems.

3. Reseat the first XS in the engine and connect through the management port of the first IXS.

5.
6.

Use the management IP address to access the switch’s Agent Page (for example
https://192.168.0.10:5015/).

Navigate to the Advanced Web page.
Under Switch Blade, click “Reset to factory defaults.”

The switch and storage blade password is se-admin and the System Director password is
is-admin.The System Director Web Page Administrator default password is blank.

7.

Enter the password when prompted to reset the switch to defaults.
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8. The switch restarts.

When the switch starts, it has IP address “192.168.10.26” and the password is reset to
the default. Through the Switch Agent, configure the switch with the proper IP address
range, netmasks, time zone, passwords, see “Setting-Up Network Addresses In the
Stack” on page 71.

9. Perform the appropriate procedure for connecting your engines, see “Connecting ISIS
Hardware” on page 70.
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This appendix provides a summarized list of what tasks need to be performed when upgrading
Avid ISIS 7000. All Avid ISIS upgrades are to be performed by Avid ISIS Avid Certified
Support Representatives (ACSR).

The following list provides the order in which tasks need to be performed.

* Ifyou have not already noted the host names, passwords, IP address, and other important
network details, see “Preupgrade Information” on page 159. Although this information
needs to be gathered before you start, the pages that include the blank tables are at the end of
this document.

* Do not perform an Avid ISIS system upgrade if your network is not in optimum working
order, see “Health Check” on page 137.

* Ifyou have documented the preupgrade information and your Avid ISIS is healthy, you can
start the Avid ISIS system upgrade, see “Software Upgrade” on page 139.

»  After you finish the upgrade, confirm everything is functioning properly, see “Post Upgrade
System Verification” on page 156.

Health Check

Before any changes are made to the system, perform the following quick checks to verify that the
system is in good working order. Do nrot perform an upgrade if there are any issues with the
system. Correct all problems before performing the upgrade.

Things to check before upgrading:

1. Log into the ISIS Management Console and click Storage Elements. All Storage Elements
should be green, investigate any error statuses. For details on troubleshooting Storage
Elements error statuses, search the Knowledge Base at www.avid.com/onlinesupport for
“ISB Error Status Glossary.”

2. Open a command window and ping all switches in both stacks. All switches should be
pingable and able to access the web pages for all switches. If running Avid ISIS v1.1B or
later, you could alternatively run switch diagnostics and only select the connectivity tests.
Access the switch diagnostics by clicking Advanced on the switch web page.


http://www.avid.com/onlinesupport
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. Ping each System Director on both subnets (left and right, not the crossover paths). Each

System Director should be accessible via both paths from any client or switch on the
Avid ISIS system.

. Ping the default gateway on the left and right network from System Director and ISSs.

This should be accessible from any point in the network. You can ping directly from and
ISS/IXS from the Tools tab on the switch web page.

. Log into each System Director and open the System Director’s Control Panel. Both

paths should be up, and standby should be receiving and replicating metadata. Check the
Metadata Status tab in the System Director’s Control Panel on the standby. The date
stamp in the saved and replicated fields should be current and updating frequently.
Standby instructions only apply if there is a failover machine present.

. Check the system event logs on the System Directors for recent error events.

. Perform a thorough physical inspection of the interconnection cables looking for:

- Missing retainers, strains, sharp bends, signs of physical abuse.
- Ensure that labels are visible, physically firmly in place, and legible.

- Confirm that all fans and ventilation areas are free of obstructions, dirt, lint, and
debris.

- Ensure that there is clearance front and rear to allow components to be replaced
without obstructions for their full chassis travel length.

- Make sure cables are not zip tied to the power supplies or the switches.

. Perform System Director Primary to Secondary Failover — Turn off one of the System

Directors and verify in the System Director Control Panel that the Active Mode
indicator has turned red. Turn the System Director back on and see that Active Mode
displays Standby.

. Check the system drive status on the System Director.

- On the AS3000, click Start > Programs > Intel -> Intel Rapid Storage Technology
right-click the Intel Rapid Storage Technology icon in the task bar. The icon should
be a green check mark when the drives are healthy.

- On the SR 2500, click Start > Programs > RAID Web Console 2 > Start UI and see
that the Server Heath is green. If not, search www.Intel.com and search for Intel”
RAID Software User’s Guide for corrective actions.

- On the SR 2400 use the CIM Browser utility icon on the right-side of the taskbar.
The CIM Browser icon must be green (looks like a square). You can hover your
mouse pointer over the icon to see the utility name, double-click the icon to start the
utility.


http://www.Intel.com
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Verifying the System Director RAID controllers are in sync by checking LSI CIM
Browser. Do this before and after the upgrade. The System Director internal drives are
RAID and can become out of sync. LSI is an application running on the System Director
that indicates their health.

Software Upgrade

After noting the necessary network and system component information listed in “Preupgrade
Information” on page 159 you are ready to upgrade the Avid ISIS. The following is a generalized
procedure for upgrading an ISIS. Read the upgrade section in the ISIS ReadMe for specific
upgrade details in that release.

To upgrade Avid ISIS 7000 v2.1.1 and later, you need to upgrade the clients before you upgrade
the infrastructure. This is necessary because ISIS client software before v2.1.1 is not supported
in the ISIS v2.1.1 and later infrastructure. Although, v2.1.x client software is supported in v1.4
and later infrastructures. Once the clients have been upgraded, you can upgrade Avid ISIS
infrastructure.

The clients are defined as follows:

*  Avid editing applications

* Interplay Assist and Instinct

+ Interplay Access

*  Avid Approved Applications Initiative such as Pro Tools and Final Cut Pro

The infrastructure is defined as follows:

*  System Director — System Director software and upgrade Storage Blades (ISBs) and
Switch Blades (ISS/ISXs) in the Avid ISIS engines to the v2.1.1 firmware

* Interplay servers — Interplay Engine, Interplay Media Indexer, Interplay Transfer, and
CaptureManager

*  Capture devices — AirSpeed, AirSpeed Multi Stream, and Avid Interplay Low-Res Encoder

If updating from an ISIS v1.x infrastructure you must do a full redistribution on your workspace
after you have updated the infrastructure to v2.x. A full redistribution is needed to take
advantage of the performance improvements. The redistribution is required even if the system
has zero (0) configuration changes listed.

Avid ISIS v2.1.1 SR2500 64-bit System Directors ship with an
SD_X64_PIS21_MBS5000XALR_V05_DVD or later image on the internal RAID drives. The
image version number can be found in the c : \IMAGE . TXT file on the System Director root
directory. If upgrading your 64-bit System Director from Avid ISIS v2.0.1 or earlier Avid
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recommends you reimage the System Directors to reduce the number if updates required in
this release. For instructions on how to reimage the System Director, see the “Reinstalling
the Windows Storage Server 2008 Operating System” on page 198.

If you are upgrading from Avid ISIS v2.0.1 or earlier, Avid suggests you consider reimaging
the 64-bit System Director (see “Reinstalling the Windows Storage Server 2008 Operating
System” on page 198). Several configuration changes and driver versions have been updated
in the 64-bit System Director and you might find it easier than following the referenced
procedures listed in the following procedure. If you do decide to reimage, perform a failover,
then reimage the Standby System Director first.

To update your Avid ISIS v1.4 and later software to v2.1.1 or later:
1. Update your Avid ISIS clients to the v2.1.1 or later software.

Do not continue to the next step until all your clients are updated. For information on
saving your client preferences, see “Client Preferences” in the Avid ISIS ReadMe.
Update the network interface driver if required for the release you are installing (see the
ReadMe). If the System Director does not have the correct version, update the network
board drivers on the System Directors and clients.

% To get started with the client upgrades, you can manually copy the client installers to one of
your network servers using a USB flash drive. The installers on the System Director are
located on: D:\Program Files\Avid Technology\AvidUnityISISInstallers.

- For Windows clients, you need to uninstall the ISIS client using Windows® Control
Panel, reboot, install ISIS client, and reboot.

- For Mac clients, you can just install the new client software over the old version and
no reboots are required.

- AirSpeed clients, require the placement of the software installation package on an
HTTP server.

The AirSpeed user interface provides a window where you type the URL path in the
Server text box where the AirSpeed upgrade is located. Select the AirSpeed ISO
image from the Available Versions list. Click Update Version. For more information
on upgrading AirSpeeds, see the Avid AirSpeed Setup and Installation Guide.

% The Avid Interplay Media Indexer and AirSpeed Multi Stream patch is no longer needed with
Avid ISIS v2.0.2 and later. You must uninstall the patch and ISIS v2.x client software before
installing the ISIS v2.1.1 and later client software. For more information, see “Avid
Interplay Media Indexer and AirSpeed Multi Stream Patch” in the Avid ISIS ReadMe.

2. Shutdown or exit the Client Manager application on all Avid ISIS clients connected to
the engines.
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This includes AirSpeeds®, AirSpeed Multi Streams, and ancillary servers; for example
Interplay® servers.

You do not need to shutdown the client if they can continue to work off line. AirSpeeds can
continue to capture to their internal drives and editing systems can edit as long as they are not
using workspaces.

3. Stop the Avid ISIS service on Standby System Director via System Director Control Panel
or shutdown the Standby System Director.

4. Move to the Active System Director and uninstall Avid ISIS 7000 System Director software
(includes ISIS Client Installers, ISIS Blade Installer, and System Director software) using
the Add/Remove programs in Windows®™ Control Panel.

Avid ISIS v2.x includes an Avid ISIS Blade Installers program that was not included in previous
releases. If reinstalling Avid ISIS v2.0 or later you must uninstall the ISIS Blade Installer, ISIS
Client Installer, and System Director software.

5. Check the ReadMe for the version of the network interface driver that is required for the
release you are installing. If the System Director does not have the correct version, update
the network board drivers on the System Directors and clients.

6. Start the System Director and Log into Administrator account.

7. (For new installs or re-imaged System Directors) Start Internet Explorer 7 and change the
following settings.

a. Click Tools > Internet Options and change the Security to the following:
- Internet - Medium
- Trusted - Low
b. Click the Advanced tab and change the following:
- Phishing Filter - Disabled
- Use SSL 2.0 - Enabled (checked)
- Use TLS 1.0 - Disabled (unchecked)

8. Install the new versions of Avid ISIS System Director software (includes ISIS Client
Installers, ISIS Blade Installer, System Director software) onto Active System Director. Note
that the Avid ISIS System Director defaults to D: and Avid ISIS Installer defaults to C:. For
ease of troubleshooting, both installers should point to D:.

9. Once the software is installed, the System Director service starts up again as Active. Verify
this in System Director Control Panel.

10. (Skip this step if updating from ISIS v2.0.2 and later) Update the System Director
application key (dongle), see “Application Key Driver Update on the System Director” on
page 150.
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11. (Skip this step if updating from ISIS v2.0.4 and later) Change the Intel Pro driver
configuration on the System Director, see “System Director Intel Pro Driver
Configuration Update” on page 151.

12. (Skip this step if updating from ISIS v2.0.4 and later) Update the System Director to
allow Windows Updates, see “Enabling Windows Updates on 64-Bit System Directors”
on page 155.

13. Upgrade switch firmware and ISB firmware. The switch firmware upgrade will take
about 20 minutes. The ISB upgrade will complete in about 10 minutes (four engines or
more).

You can do both the switch firmware upgrade and the ISB firmware upgrade at the same

time.

/e o o P

)

Log into the ISIS Management Console.
Click Chassis from the list.

Shift click all chassis.

Click Upgrade Switch Blades.

Click Upgrade Storage Blades.

Monitor upgrade progress in the Monitor tool via the upgrade view. Check front and
back view and verify that all components are upgrading.

If you are upgrading switches from v1.x to v2.x the upgrade adds an interim step. The
switches go to “Install Waiting” status between Phase 2 and 3. Once all switches in the
stack are in “Install Waiting” (verify this with Monitor Tool), then either cycle power
on each chassis, or issue a software restart to each switch (Advanced tab on switch
agent web page). It is important that all switches in the stack get rebooted at the same
time. Check the ReadMe for the compatibility between firmware versions on new
releases.

14. While the upgrade is in process, begin the upgrade on the Standby System Director.

a.

Uninstall the Avid ISIS System Director software (includes ISIS Client Installers,
ISIS Blade Installer, System Director software) using the Add/Remove programs in
Windows Control Panel.

Update the network interface driver if required for the release you are installing (see
the ReadMe). If the System Director does not have the correct version, update the
network board drivers on the System Directors and clients.

Install the new version of the Avid ISIS System Director software (includes ISIS
Client Installers, ISIS Blade Installer, System Director software) on the Standby
System Director.
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% Avid ISIS System Director defaults to D: and AvidUnityISISInstaller defaults to C:. Either will
function properly in any location but for ease of troubleshooting, both installers should be
pointed to D:.

Once the software is installed, the System Director will run in standby mode.

d. Start the System Director Control Panel and verify System Director is running in
standby mode and all lights are green.

15. Once all firmware upgrades are complete, verify that all ISBs and switches are showing the
correct build number in the Monitor tool. This number should match the build numbers
shown in ISIS Management Console Installers page. If any ISBs are not at the correct
revision or have failed the upgrade, upgrade the failed ISB again.

If upgrading from Avid ISIS v1.x to v2.x, do not continue to the next step until all your clients are
updated.

16. If you upgraded from Avid ISIS v1.x to v2.x, a full redistribution must be performed on all
existing workspaces. The redistribution is required even if the system has 0 configuration
changes listed.

& Once you have done a full redistribution on all your workspaces with v2.x software, any
v1.x clients that have not updated the Avid ISISI client to v2.x software will not be able to
mount workspaces.

Component Requirements From Previous Releases

The following is list of items outside the ISIS software that you might need to update depending
on the current version of your ISIS software. If you are setting up a new ISIS system or updating
an ISIS environment that is already at v2.2.2, continue with “Upgrade Process” on page 144.

* Ifupdating from ISIS v2.0 — v2.0.6 to v2.4 — update the System Director Intel system BIOS
on the 64-bit System Director (SR2500), see Avid ISIS v2.2.2 ReadMe.

e Ifupdating from ISIS v2.0 — v2.0.6 to v2.4 — update the Intel RAID controller driver and
registry key on the 64-bit System Director, see Avid ISIS v2.2.2 ReadMe.

e Ifupdating from ISIS v2.0 — v2.0.3 to v2.4 — update the System Director to allow Windows
Updates, see Avid ISIS v2.2.2 ReadMe.

e Ifupdating from ISIS v2.0 — v2.0.1 to v2.4 — update the System Director application key
(dongle), see Avid ISIS v2.2.2 ReadMe.

* Ifupdating from ISIS v1.4 — v2.0.1 to v2.4 — you must first upgrade to Avid Unity ISIS
v2.1.1 before upgrading to v2.3, For instructions, see Avid ISIS v2.1.1 ReadMe.

143



A Avid ISIS 7000 Upgrade Guidelines

Upgrade Process

144

The following process summarizes the upgrade process.

If you are upgrading from a version earlier than Avid ISIS v2.2.2, you must first perform the
updates documented in “Component Requirements From Previous Releases” on page 143
before upgrading to v2.4.

To upgrade:

1.

Download the ISIS software kit from the Avid Download Center
(www.avid.com/US/support/downloads) to your System Director.

. Log into Administrator account on the Standby System Director and Stop the Standby

System Director using the ISIS Control Panel.

3. Load the ISIS software kit on the Active System Director.

O 0 9

10.

11.

. Double-click the Autorun.exe file in the software kit.

The installer detects the existing version of the installed software (if any) and displays
the components that need to be upgraded in the splash screen.

. Select ISIS 7000 System Director from the “Select Software Package” menu.

The File Gateway selection is used when loading the Avid File Gateway server. The File
Gateway software cannot be installed on the same server as the System Director
software.

. Click Apply.
. Follow the screen prompts accepting the defaults and License agreement.
. Once the installation is complete, click Finish.

. Upgrade your ISBs and ISS/IXSs. Using the ISIS Management Console, select all the

ISBs and click Upgrade Storage Blades and then select all your ISS/IXSs and click
Upgrade Switch Blades. You do not need to wait for the ISBs to be finished, you can
upgrade ISBs and ISS/IXSs at the same time.

You can watch the upgrade progress in your Monitoring tool.
Update your Standby System Director using repeating steps 3 to 8.

After upgrading the ISB and ISS/ISX during the Active System Director upgrade, you
do not need to upgrade the ISB and ISS/ISX again when upgrading the Standby.

Update your Avid ISIS clients software.

For information on saving your client preferences, see the Avid ISIS 7000 ReadMe.


http://www.avid.com/US/support/downloads
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Avid ISIS Software Installation From the USB Flash Drive

New systems include the Avid ISIS 7000 software on the 4 GB USB flash drive. If upgrading
your software from an earlier release, download the software from the Avid Download Center
(www.avid.com/US/support/downloads) to your System Director.

The Avid ISIS 7000 Setup Guide contains complete instructions for loading the software onto the
system. You can access the documentation in the top-level AvidISISDocumentation folder on the
Avid ISIS software installer kit. The following is a summarized version of the procedure.

In the past Avid has instructed you stop the Standby System director, upgrade the Standby, and
restart the Standby. Once the Standby was running you were instructed to update the Active
System Director.

Avid has revised the upgrade process to stop the Standby System Director and upgrade the Active
System Director first, then upgrade the Standby System Director. This process avoids replicating
metadata between ISIS software versions.
To install your Avid ISIS software on new installs:

1. Log in to the Avid ISIS 7000 as Administrator (default password: is-admin).

2. Make a folder for the software kit on your root directory (C:\) of your Active System
Director.

3. Insert the 4 GB USB flash drive (with software kit) into any of USB ports on your Active

System Director.

You can run the software installer from the USB flash drive. The advantage of copying the
software kit to the Avid ISIS 7000 is that you have easy access to kit files if you should ever them
in the future.

If the USB flash drive does not automatically display:

a. Double-click the computer icon on the desktop.

b. Double-click the USB flash drive icon in the window and copy the software kit into the
new folder you created on the Avid ISIS 7000 system.

4. Double-click the Autorun.exe file in the software kit.

The installer detects the existing version of the installed software (if any) and displays the
components that need to be upgraded in the splash screen.

5. Select ISIS 7000 System Director from the “Select Software Package” menu.

The File Gateway selection is used when loading the Avid File Gateway server. The File
Gateway software cannot be installed on the same server as the System Director software.

6. Click Apply.
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11.

. Follow the screen prompts accepting the defaults and License agreement.
. Once the installation is complete, click Finish.

. Install the Application Key.

10.

Load the ISBs and ISS/IXSs firmware. Using the ISIS Management Console, select all
the ISBs and click Upgrade Storage Blades and then select all your ISS/IXSs and click
Upgrade Switch Blades. You do not need to wait for the ISBs to be finished, you can
upgrade ISBs and ISS/IXSs at the same time. For more information, see the Avid ISIS
7000 Setup Guide.

You can watch the upgrade progress in your Monitoring tool.

Run the Product Recovery tool to create a Product Recovery USB flash drive.

For information on creating the Product Recovery USB flash drive, see the Avid ISIS 7000
Setup Guide. 70 open and use the ISIS Control Panel and Management Console see the Avid
ISIS 7000 Administration Guide.

12.
13.
14.
15.

16.
17.
18.
19.
20.
21.

Open the ISIS Control Panel.

Click Stop System Director.

Click Configure File System.

Open the Management Console.

Log in using the Administrator user name and the default password is blank.
Select Create Active File System and click OK.

Click the Storage Managers icon.

Select your ISIS ISBs in the list and click Bind.

Create a Storage Group, Workspaces, and add Users in the Management Console.
Repeat these steps if you are setting up a Standby System Director.

Install your Avid ISIS clients to the v2.4 software. For more information, see the Avid
ISIS 7000 Client Guide.

Intel Network Driver and BIOS Update
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Avid has qualified an Intel system BIOS upgrade on the 64-bit System Director (SR2500).
This BIOS and Intel Pro driver upgrade combination corrects a condition where the network
connection fails during a restart. The following sections describe the updates.

If you find it necessary to reimage the System Director, you need to updated the network
driver again. The BIOS is not affected when you reimage your server.
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64-bit System Director BIOS Upgrade

Avid is recommending you update the BIOS on the 64-bit System Director and File Gateway. To
do that, you can visit the Intel web site and follow their instructions, or use the files and
instructions posted on the Avid Download Center (http://www.avid.com/US/support/downloads).

The procedure on the Avid Download Center requires you to create an Intel Deployment
Assistant DVD and use a USB flash drive to load the BIOS update package on the System
Director and File Gateway. Instructions for running the Intel BIOS Upgrade Utility and installing
the BIOS are included with the image for the utility and the BIOS package.

Check your current BIOS version before upgrading the BIOS. If your BIOS is at version 98, you
have the recommended BIOS version for this release. Enter BIOS Setup by pressing the F2 Key
during POST and the version is displayed as S5000.86B.12.00.0098 in the Main tab.

Intel RAID Controller Driver Update

This section describes the process for updating the Intel driver and registry key for the internal
RAID controller on the Intel SR2500 server using the SROMBSAS18E Intel hardware RAID
controller. This RAID controller is used in the Avid ISIS SR2500 System Director and the Avid
Interplay 64-bit Media Indexer. This driver does not apply to the other SR2500 configurations
using the embedded SATA RAID ESRTIL.

The majority of the Intel SR2500 Avid ISIS System Directors use a 64-bit operating system. Avid
did ship some Intel SR2500 System Directors with a 32-bit operating system before the 64-bit
operating systems were released. All Avid ISIS System Directors using the Intel SR2500 server
require this RAID controller driver update.

The RAID controller update requires a driver update and a registry change. Access the update
package from one of the following locations. Create a new folder on the server that you are
updating and place the update files in it.

This RAID controller driver is available from two locations:

*  Download the Intel hardware RAID controller SROMBSASI18E update package from
(http://www.avid.com/US/support/downloads).

e This version of the Intel driver has been added in the Avid ISIS software installer DVD and
can be found on the Avid ISIS software installer DVD in the
Tools 3rdParty\Drivers_ and
_Firmware\IntelSROMBSAS18E Raid Controller\Intel Raid v3.11.0.xx folder.
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To upgrade the SROMBSAS18E Intel driver:

1. Access the Standby System Director and stop the System Director service using the ISIS
Control Panel.

2. Right-click on My Computer and select Manage. The Computer Management Window
opens.

3. Select Device Manager. The Device Manager opens
4. Click the plus sign (+) next to SCSI and RAID Controllers.
5. Right-click on the Intel RAID Controller SROMBSASI18E and select Properties.

E Computer Management !EI

Q Bile  Action  Wew  Window  Help | 18| =]
- | AW TS 20 Al

=) Computer Management: (Lacal) =& As1-ISIS-QFALLZ

Eﬁ& System Tools [+ v_w} Computer

[]--@ Event Yiewer [+-#g# Disk drives
[#--g-] Shared Folders [+ § Display adapters
[]---% Local Users and Groups []---,,,'é. DVDJCD-ROM drives
[+--d4%] Performance Logs and &lert: []--@ IDE ATASATAPI controllers
2, Device Manager -7y Mice and ather pointing devices
-4 Starage B g Manitors
[+ Removable Storage [+-EE Mebwork, adapters
&' Disk Defragmenter I:I---“y‘ Ports {COM & LPT)
g8 Disk Management I:—:I--ﬂ Processors
[]—-@ Services and Applications ﬂ. InteliR) XeoniR) CPU ES335 @ 2.00GHz
-8 TnkellR) Xeon(R) CRUI ES335 @ 2.00GHz
%% Intel(R) Xeon(R) CPU ES335 @ 2.00GHz
.8 Intel(R) Xeon(R) CPU ES335 @ 2.00GHz

=€z 551 and RAID controllers
8 CJIntel(R) RAID Cartroller SROMES
[]---@,/ Sound, video and game controllers

- ¢ System devices
[+ Universal Serial Bus controllers

4] | >

6. Click the Driver tab in the Properties window.
7. Click Update Driver in Driver tab.
8. In Hardware Update Wizard, do not let Windows select the driver:
a. Select “No, not at this time” and click Next.
b. Select “Install from a list of specific location (Advanced)” and click Next.
c. Select “Don’t search. I will choose the driver to install” and click Next.
Click “Have Disk.”

&~
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10.
11.

12.
13.

f.

g.
h.

Software Upgrade

Click Browse and locate the oemsetup. inf file in the package you copied to the server.

- 64-bit System Director and Media Indexer —
IntelSROMBSAS18E_Raid_Controller\Intel Raid v3.11.0.xx\
W2K3x64 folder

- 32-bit System Director — IntelSROMBSAS18E_Raid_Controller
\Intel Raid v3.11.0.xx\XP folder

Click Open, in the Locate File dialog box.
Click OK, in the Install From Disk dialog box.
Click Next in the Hardware Update Wizard.

Once you complete the driver install, click No when prompted to restart the server.

Close the Properties window.

Apply the registry key by browsing to the RegKey Updates folder in the package you
copied to the server.

»

64-bit System Director — double-click the w2k3 . reg file to apply the registry key
change.

The following two entries are added to the 64-bit System Director registry location:
KEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\msas2k3\
Parameters\Device

DriverParameters = flushrequest= 3
DriverParameter = flushrequest= 3

32-bit System Director — double-click the winXP. reg file to apply the registry key
change.

The following two entries are added to the 32-bit System Director registry location:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\megasas\
Parameters\Device\

DriverParameters = flushrequest= 3
DriverParameter = flushrequest= 3

Restart the Standby System Director.

After the StandBy System Director has restarted, turn off the Active System Director to
failover to the updated Standby System director. Repeat this procedure on the second System
Director.
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After upgrading to Avid ISIS v2.0.2 and later, you must upgrade your Avid ISIS application
key (dongle) driver on the System Director (see “Software Upgrade” on page 139). The
driver name for the application key is the Sentinel Protection Installer. If you do not update
your application key, the Active Clients tab in the System Director Control Panel displays “0
licenses allowed by dongle” and the Client Manager displays the following error:

Failed to authenticate user: “Administrator” on System Director:
“SQADATA” ERROR: Not enough user

This Sentinel v7.4.2 driver upgrade pertains to System Directors with Windows XP
Embedded 32-bit operating systems. System Directors running Windows Server 64-bit
operating systems already have this driver version installed.

To upgrade the Sentinel driver:

1. Open the Standby System Director Control Panel and click Stop System Director to stop
the service.

2. Remove the application key from the USB port on the Standby System Director.
3. Uninstall the old version of the Sentinel driver using the Windows Control Panel.
a. Click Start > Settings > Control Panel > and select Add or Remove Programs.
b. Locate the Sentinel Protection Installer and click Remove.
c. Restart the System Director.

4. When the System Director restarts, log-in, open the System Director Control Panel, and
click Stop System Director to stop the service.

5. Run the SafeNet® SSD Cleanup utility.
a. Download the SSD Cleanup utility (32-bit) from:
http://www.safenet-inc.com/support/tech/sentinel.asp
b. Save the utility on your System Director.
c. Extract the .zip file.
d. Double-click the SSDCleanup.exe file and follow the prompts.
e. Restart the System Director.

6. When the System Director restarts, log-in, open the System Director Control Panel, and
click Stop System Director to stop the service.

7. Double-click the SentinelProtectionlnstaller7.4.2.exe file located in the following folder
on the System Director.


http://www.safenet-inc.com/support/tech/sentinel.asp
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D:\Program Files\Avid Technology\AvidUnityISISSystemDirector\
Sentinel Driver Installer

8. Install the Sentinel driver as follows (Complete installation).
a. Click Next.
b. Accept the license agreement and click Next.
c. Continue with accepting the defaults to finish the installation.
9. Reinsert the application key in the USB port on the System Director.
10. When prompted for the SNTNLUSB.SYS file, navigate to:
C:\Program Files\Common Files\SafeNet Sentinel\Sentinel System Driver
11. Open the System Director Control Panel and click Start System Director to start the service.
When started, the Active Clients tab in the System Director Control Panel displays the

correct number of licenses and the clients.

If the Active Clients tab does not display the correct number of licenses and clients, contact
your Avid Representative before trying to upgrade your Active System Director.

12. Repeat this procedure on the Active System Director.

Stopping the Active System Director induces a failover to the Standby System Director.

Record IP Addresses on the System Director

Before you update your Intel Pro network driver, Avid recommends you record the current IP
address used on the System Directors. This precaution allows you to restore the IP addresses to
the current settings if your network configuration is accidently lost.

To record the current IP addresses used by the System Director:

1. Open a command window on the System Director. Click Start > Programs > Accessories >
and select Command Prompt.

2. Type ipconfig /all > c:\ip.txt in the Command Prompt window.

This command saves a text file (named ip.txt) to the root directory on the System Director.
Open this text file if need to reconfigure the IP addresses to the addresses used before
performing this network configuration update.

System Director Intel Pro Driver Configuration Update
Use the following instructions to upgrade the Intel Pro network driver v12.4 on your 64-bit

System Director, and configure the dual network ports. System Directors always have an Intel
driver installed by default. You do not need to removed the older version.
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Depending on the operating system and original driver version shipped with your System
Director, the Intel Pro driver version varies.
To identify your current Intel Pro driver version on the System Director:

1. Open the Windows Add or Remove Programs control panel. Click Start > Settings >
Control Panel > and select Add or Remove Programs.

2. Verify the version number beside the Intel Network Connections in the “Currently
installed programs” list.

The Intel Network Connections driver version number shipped with Windows 64-bit
operating systems is v12.4.38.0. System Directors with Windows 32-bit operating systems
have vi12.3 or earlier. Do not upgrade System Directors with Windows 32-bit operating
systems to vi2.4.

- Ifyou have the Intel Pro driver v12.4 or v12.3, perform the changes described in
“To reconfigure the current the Intel Pro driver setting on the System Director:” on
page 152.

- Ifthe Intel Pro driver on your System Directors is earlier than on v12.3, no action is
required. It is not necessary to upgrade the Intel Pro driver on the System Director
tov12.3.

To reconfigure the current the Intel Pro driver setting on the System Director:

1. Stop the Standby System Director.

2. Insert the Avid ISIS software installer DVD into the client DVD drive. The software
installation window opens after several seconds.

3. Click the Exit button to close the installation window.

4. Browse to the appropriate Intel network driver folder on the Avid ISIS software installer
DVD depending on the Windows operating system on your System Director.

[DVD drive] \Tools_3rdParty\Drivers and Firmware\Intel Prol000 14.7
. Double-click the executable file (Autorun.exe).
Click Install Drivers and Software.
Accept the default settings to install the driver.
Click Finish.

© 0 N

Right-click My Network Places and select Properties.

10. Right-click the right side network connection and select Properties.
The Properties dialog window opens.

11. Click Configure.
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12. If prompted, click Yes to proceed.
The Intel Pro Server Adapter Properties dialog box displays.
13. Click the Advanced tab.

Change the configuration as described in one of the following two steps. The dialog boxes in
these steps are based on the version and driver installation.

14. (Option) If your Server Adapter Properties dialog box display looks like the following,
change the configuration as described after the screen capture.

If you are using a Remote Desktop Connection the Advanced tab does not appear.

21x

General Advanced | Diriveer I Resources | Power Management I

The following properties are available for thiz network, adapter. Click

the property vou want to change on the left, and then select its value

on the right.

Property: Walle:

Adaptive Inter-Frame Spacing - aFf ﬂ

Enable PME —

Interrupt Moderation B ate
Jurnbio Frames

Link Speed & Duplex

Locally Administered Address
Log Link, State Event

Offload Receive P Checksum
Offload Receive TCP Checksum
Offload Tranzmit [P Checksum
Offload Trangmit TCF Checksum
(a5 Packet Tagging

Receive Descriptors ﬂ

ak I Cancel |

a. Click Flow Control and set the Value to Off.

b. Click Interrupt Moderation Rate and set the Value to Off

c. Check that the Receive Descriptors and set the Value to 1024.
d. Check that the Transmit Descriptors and set the Value to 1024.

e. Click OK Server Adapter Properties dialog box.
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15. (Option) If your Server Adapter Properties dialog box display looks like the following,
change the configuration as described after the screen capture.

Intel{R} PRO;1000 MT Dual Port Server Adapter Properties 7| x|

Teaming I WLANz | Boot Options I Diriveer
Gerneral I Link Speed Advanced | Fower Management

( intel) Advanced Adapter Settings

Settings:

Jumbo Frames Properties
Locally Administered Address
Log Link Skake Event

Performance Options

7305 Packet Tagging
TCRJIP Offloading Options
wiait For Link

Performance Options

Caonfigures the adapter to use settings that can improve adapter ;I
performance.

[ ]
QK. I Cancel |

Click the Performance Options in the Setting list.

ISHE

Click Properties.

Click Flow Control and set the Value to off.

Click Interrupt Moderation Rate and set the Value to off
Check that the Receive Descriptors and set the Value to 1024.
Check that the Transmit Descriptors and set the Value to 1024.

/e 0

Click OK to close the Performance Options.

= @ oo

Click OK to close the Server Adapter Properties dialog box.
16. Repeat steps 3 through 8 for the left side network connection.
17. Restart the Standby System Director.

18. Stop the Active System Director and repeat steps 1 through 10 to update the Intel Pro
driver and configure the dual network ports on the Active System Director.
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Enabling Windows Updates on 64-Bit System Directors

Currently, Windows updates are disabled on 64-bit System Directors running Windows Storage
Server. Avid ISIS v2.0.4 includes a hotfix to enable the Windows Update service and allow you
to update your System Director.

Automatic Updates remain disabled for security reasons. To update your System Director in the
future, you need to use the Windows Update web site.

After enabling Windows Updates on your 64-bit System Director, access the Knowledge Base at
www.avid.com/securityupdate and review the Microsoft Security Bulletin Addendum document.
This link also includes antivirus software support on Avid products which can be found in the
Avid Security Guidelines and Best Practices document.

This procedure will result in workflow interruptions, and should be performed during a
scheduled maintenance interval.
To enable Windows Updates on the System Director:

1. Extract the Avid ISIS v2.0.4 update zip archive to the standby System Director.

2. Open the System Director Control Panel and click Stop System Director to stop the service.

3. In the extracted update zip archive, navigate to Tools 3rdParty\ISISUtilities\ and
double-click the file enableAutoUpdateServiceWithUpdatesOff.cmd to execute it.

Open Internet Explorer and click Tools > Windows Update.
Follow the prompts to install the Windows Update ActiveX control.

Once the Windows Update software is installed, click the Custom button.

N o » ok

Click to deselect the check box for Internet Explorer 8 (this version has not been qualified).
Leave the rest of the updates selected.

*

Click “Review and install updates.”
9. Click the “Install Updates” button.

10. Follow any prompts that appear, and restart the System Director when the updates have been
installed.

11. When the System Director has restarted, check the Windows event logs for any unusual
events.

12. Open the System Director control panel, and verify that the metadata date stamp in the
Metadata Status tab in the saved and replicated. Fields should be current and updating
frequently.

13. Repeat this procedure on the active System Director.
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Stopping the active System Director will invoke a failover event, and cause a brief
interruption in workflow.

Post Upgrade System Verification
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After upgrading a system it is important to do a series of checks to verify that all upgraded
components are functioning optimally.

To verify the upgrade:

1. Verify network connectivity for all components:

C.

Ping all ISSs and IXSs on left and right stack.

From any client, ping Active System Director and Standby System Director on left
and right sides.

Ping the virtual System Director on left and right side.

2. Verify both System Directors are functioning properly by checking the following:

Check if any new errors are getting generated in the event logs.

Both paths should be up and all green lights in System Director’s Control Panel on
both System Directors. If no failover, some lights will be blue.

Metadata should be replicating between the two System Directors. The Standby
should be toggling between receiving and replicated. Check the Metadata Status tab
on the standby. The date stamp in the saved and replicated fields should be current
and updating frequently.

Check the RAID status on the System Directory.

- On the SR 2500, click Start > Programs > RAID Web Console 2 > Start UI and
see that the Server Heath is green. If not, search www.Intel.com and search for
Intel® RAID Software User’s Guide for corrective actions.

- On the SR 2400 use the CIM Browser utility icon on the right-side of the
taskbar. The CIM Browser icon must be green (looks like a square). You can
hover your mouse pointer over the icon to see the utility name, double-click the
icon to start the utility.

Verifying the System Director RAID controllers are in sync by checking LSI.
LSI is an application running on the System Director that indicates their health.

3. Perform System Director Primary to Secondary Failover — Turn off one of the System
Directors and verify in the System Director Control Panel that the Active Mode
indicator has turned red. Turn the System Director back on and see that Active Mode
displays Standby.


http://www.Intel.com
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4. Run PathDiag on one client on the left and one client on the right subnets at the same time.
To set PathDiag Tool:

a. Do one of the following:
- (Windows) Select Start > All Programs > AvidUnityISIS > PathDiag.

- (Macintosh) Select Go > Applications, and then double-click the AvidUnityISIS
folder.

b. Click Start > Avid Unity ISIS Program group> Path Diag.

PathDiag

Optional Lag Files... <<< Standard Tests

Awg Read MBFS
B RocentRead MBFS
@ PeakRead MSM00
& pog it MBPS

Recentwirte MBPS
B Foakirite MSHM00

Click Setup.

d. Set “Path to Test” to a mounted ISIS workspace letter. (Check in my computer if not
sure) Make sure its an ISIS workspace and not the internal C: drive.

e. Set the duration 10 minutes.

f.  Click Custom Test and set the following parameters:
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Custom Test 1 Gb client 10 Gb Client
Settings (not bandwidth limited) (not bandwidth limited)
File Access Method Automatically select Automatically select
Reads vs Writes Writes, then Reads (Sequential) Writes, then Reads (Sequential)
Transfer Size 4096 16384
Transfer Rate Unlimited Unlimited
Max File Size 1000 1000
g. Click Ok and Start.

- 1-Gb clients that are not bandwidth limited should expect at least 65 MB/sec in
the Path Diag tool (v1.x and v2.x hardware).

- 10-Gb clients that are not bandwidth limited should expect at least 500 MB/sec
for reads and at least 200 MB/sec for writes in the Path Diag tool (v2.x
hardware.

5. While Path Diag is running check the system to make sure that there are no Network
Degraded status indications. Check the following:

a.

In the ISIS Management Console, click Storage Elements. All ISBs should be green
and not displaying any Network Degraded states.

Spot check a couple ISBs by browsing to the ISB web page and click Statistics.
Select the bottom network tab. None of the error columns should be incrementing.
Press F5 to update the page a few times.

For details on troubleshooting Storage Elements error statuses, search the
Knowledge Base at www.avid.com/onlinesupport for “Troubleshooting the
Network Degraded Status on ISIS 1.0-1.1” Tech Alert.

6. Run Switch Infrastructure Diagnostics:

a.

o o

&~

—

Navigate to any switch agent web page (in the ISIS Management Console, click
Chassis from the list on the left, click Details tab and then double-click on a switch
IP address).

In switch web page, click Advanced tab.

Click Switch Infrastructure Diagnostics from the list on the left.
Click Select All under System Tests.

Select Both in Select Network section.

Select All chassis in Select Chassis menu.


http://www.avid.com/onlinesupport
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g. Click Run Diagnostics.

Let the diagnostics run, when the Switch Diagnostics - Reported Result/System
Overview displays, the results from all switches in both stacks should be available in the
summary page.

h. Click Switch Diagnostics Results Summary Page.

i.  Any errors report as red and warning conditions are amber. Click headings to investigate
any error or warning statuses. There should be no red statuses present.

7. Check all other zones in use for proper operation. If there are Zone 2 and 3 clients, each of
these zones should be checked with clients running Path Diag:

a. Run a Path Diag client for left and right side for each Zone 2 switch in place.

b. Run a couple of Zone 3 path diag clients and verify consistent performance.

A Zone 3 client might not have the bandwidth of a Zone 1 or 2 client.

Preupgrade Information

Gather the following information before the upgrade. This information is critical to
troubleshooting an Avid ISIS.

*  Current Avid ISIS software version

*  Avid ISIS Administrator password

*  Switch agent password

e Number of Avid ISIS engines

» ISB Size: 500 GB 1TB 2TB
*  Number of Storage Groups

*  Number and type of editing clients: (Windows or Macintosh, and using what zones)
*  Number of AirSpeeds

*  Other workgroup server details (for example TransferManager, MediaManager, and
Interplay; host names, passwords, and versions)

Zone 2 Switch Information

Note the following switch information:
*  Type of switch (Cisco/Foundry)
*  Number of switches

*  Location of configuration files
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Note the following System Director information:

Virtual Network Name and IP Addresses

Virtual IP Left

Virtual IP Right

Virtual ISIS Name

System Director 1

Host name

Administrator Password

IP address

Left ISIS IP Address

Left Default Gateway

Right ISIS IP Address

Right Default Gateway

First failover IP address

Second failover IP address

System Director 2

Host name

Administrator Password

IP Address

Left ISIS IP Address

Left Default Gateway

Right ISIS IP Address

Right Default Gateway
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First failover IP address

Second failover IP address

ISIS Engine/Switch Information
Fill out the following engine and switch information for the on site equipment.

Are any engines using Link Aggregation on the 10-Gb links?

Note what engines that are using 10-Gb links and the configuration (a maximum of eight 10-Gb
links are supported):

Engine #1, Serial Number

Left IXS/ISS IP: Right IXS/ISS IP:
First Left ISB IP: First Right ISB IP:
Left IXS IP: Right IXS IP:

Engine #2, Serial Number

Left IXS/ISS IP: Right IXS/ISS 1P:
External Zone 2 switch External Zone 2 switch
IP address (if attached): IP address (if attached):

Engine #3, Serial Number

Left ISS IP: Right ISS IP:
External Zone 2 switch External Zone 2 switch
IP address (if attached): IP address (if attached):

Engine #4, Serial Number

Left ISS IP: Right ISS IP:
External Zone 2 switch External Zone 2 switch
IP address (if attached): IP address (if attached):
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Engine #5, Serial Number

Left ISS IP:

External Zone 2 switch
1P address (if attached):

Right ISS IP:

External Zone 2 switch
1P address (if attached):

Engine #6, Serial Number

Left ISS IP:

External Zone 2 switch
1P address (if attached):

Right ISS IP:

External Zone 2 switch
1P address (if attached):

Engine #7, Serial Number

Left ISS IP:

External Zone 2 switch
IP address (if attached):

Right ISS IP:

External Zone 2 switch
IP address (if attached):

Engine #8, Serial Number

Left ISS IP:

External Zone 2 switch
IP address (if attached):

Right ISS IP:

External Zone 2 switch
IP address (if attached):

Engine #9, Serial Number

Left ISS IP:

External Zone 2 switch
IP address (if attached):

Right ISS IP:

External Zone 2 switch
IP address (if attached):




Preupgrade Information

Engine #10, Serial Number

Left ISS IP: Right ISS IP:
External Zone 2 switch External Zone 2 switch
IP address (if attached): IP address (if attached):

Engine #11, Serial Number

Left ISS IP: Right ISS IP:
External Zone 2 switch External Zone 2 switch
IP address (if attached): IP address (if attached):

Engine #12, Serial Number

Left ISS IP: Right ISS IP:
External Zone 2 switch External Zone 2 switch
IP address (if attached): IP address (if attached):

On Site Spares

List all Avid ISIS spare parts that are onsite:

Spare Components and Cables

Part Quantity Firmware Version (if known)
ISBs

ISSs v1l.x or v2.x (ISS2000) hardware
IXSs vl.x or v2.x (IXS2000) hardware
XFP, X2, and SFP+ N/A

(used with external switches)

Intel® network boards

10-GB fiber cable N/A

CAT5e/6 cable N/A
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Spare Components and Cables (Continued)

Part Quantity Firmware Version (if known)

Xenpack® (if Cisco)

3rd party switches

Additional Parts Available

Spares Checklist

Use the following list to assure that you have the correct parts onsite when performing any
Avid ISIS upgrade. This can be a mix of customer spares and parts brought onsite by
upgrade technicians.

* 1 —1IXS and IXS2000

¢ 1 —1ISS and ISS2000

« 2—ISBs

* 1 — XFP and SFP+ (used with external switches)

* Asmany ISS/IXSs as required to replace ALL pre-Rev. E switches onsite.

Additional spares for a comprehensive spares parts list:

» If Cisco switches are in use: 1 Xenpack, 1 SC-LC cable
* If Foundry switches are in use: 1 additional XFP, 1 LC-LC cable

Switch Hardware Revision Check
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ISIS switches that are Pre-Rev. E hardware should be replaced. Avid has identified a
condition where after a power cycle (not reboot) an ISS/IXS might not boot up.
Consequently, any pre-Rev. E switches installed at the site should be replaced during an
upgrade. Use the “Checking ISS HW Rev.pdf” document to check what hardware revision
the switches onsite are.

*  Number of switches onsite (and in use) that are pre-Rev. E:

*  Number of spares onsite that are pre-Rev. E:




I] Avid ISIS Upgrade Utility

This appendix describes the user interface of the Avid ISIS Upgrade Utility. The Avid ISIS
Upgrade Utility (AvidUnityISISTools.msi) can be found on the Avid ISIS 7000 software kit in
the \Tools 3rdParty\ISISUtilities folder. This utility is an application for upgrading the
ISS and ISB firmware. It offers an alternative to the normal online upgrade utilities when the
switching infrastructure cannot be maintained during the upgrade.

The original documented procedure for upgrading the ISS and ISB firmware is located on the
Avid Web site under the name: Loading Firmware on Avid ISIS 7000 Switches. The original
procedure is now replace by this Avid ISIS Upgrade Utility.

Overview and Requirements

This stand-alone application allows field engineers to start and monitor the installation of switch
and ISB upgrades from a laptop connected to Avid ISIS through the management port. This
utility does not replace the current software upgrade process. Its primary function is for
upgrading a switch or a pair of switches that is incompatible with an existing stacked network.
Insertion of these switches into the network before the upgrade could disrupt or compromise the
network’s operation.

Functional Description

The Avid ISIS Upgrade Utility is a Windows based application that provides the following
functions:

*  Provides a self-configuring FTP service.
*  Picks up the install packages via a browse window.

»  Discovers all the existing devices (switches and blades) on the network via broadcasting and
displays the information in a table.

» Displays the existing version, status, and package version already installed on each device.

*  Provides the capability of issuing the firmware install command to one or more of the
displayed devices at the same time.


http://www.avid.com/onlineSupport/supportcontent.asp?browse=go&productID=172&contentID=9666

B Avid ISIS Upgrade Utility

*  Provides the capability of monitoring the install status of every device currently in
install process.

»  Provides the capability of viewing the install log information of each device
individually.

Software Component Design

The Avid ISIS Upgrade Utility is composed of the following components:
*  The GUI Component — provides the Graphical User Interface of the application

» The Avid ISIS Upgrade Utility application programming interface (API) handles the
low level functions such as:

- Configure and start the FTP server thread.
- Discover available Avid ISIS systems connected to the network.
- Manage and monitor the various Avid ISIS install threads.

- Manage the command requests and responses between the Avid ISIS Upgrade
Utility and the Avid ISIS agent.

*  FTP Server — provides the file transfer service necessary for the devices to retrieve the
install package.

Avid ISIS Upgrade Utility Components

ISIS Upgrade Tool GUI "] I1SISAgent M 'SS,
< > Device
A
Y
ISIS Upgrade Tool APl » FIP
Server
Laptop
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Software Interface

The software interfaces with the storage devices through the switch agents with HTTP requests.
The application is provided with a graphical user interface which is described in the following
sections. The Avid ISIS Upgrade Utility main window displays when the application is started
and is divided into three sections:

*  FTP Server section provides the function of managing the install packages and displaying
FTP related activities.

» Install Control section displays the storage device information table, performs a variety of
operations on the element table and of instantiating the install process.

*  Monitoring section is the section where the Device Upgrade status is asynchronously
displayed every 2 seconds for monitoring the status for the installation.
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Avid ISIS Upgrade Utility Window

3I¢ Avid Unity ISIS Upgrade Utility [_ [ x]
~FTP Server

Install StorageBlade 1.5 4134040z

Packages  |SwitchBlade_1.5_44490 g2 Add | Remove |

Log Time Starnp | Message ﬂ

Wiew 11AB2006 1:35:54 PM - [452] Connection clazed

11/16/2006 1:35:54 PM [452] Download completed
NAB/Z005 1:35:28 PM [452] User "anonymous” began downloading "/SwitchBlade_1.5_44490 tgz
11/16/2005 1;35:28 PM  [452] User "anonymous” logged in.

11|I1BJQUUB 1:35:28 PM [452] Incoming connection frorm 192,168.20.26: 47777, | _Iﬂ .
4 » eat |

- Install Cortral

IP Address | |p address | Davice Typa | Install Status | ‘ersion | Favi... | Package
01592 1682024 ISB in progress 150 2 StorageBlade_1.5... ]
019216882025 ISB none 150 2 StorageBlade_1.5... Y
[#192 163.20.26 155 none 180 2 SwitchBlade_1.5_.. Discover |

Reboat |

q o Rermave Entry |

URL Iﬂp:ﬁindexsenrer:1026f8t0rageB\ade_1 5 41340 tyz

Options |--no_wait Start Install |

r~ Monitoring
Install IP Address Device Type | Install Status Time Starnp |
Status

j

Rermave Entry

FTP Server Section

The FTP Server Section contains the following functions:
e Add installer package to the FTP root directory

*  Remove installer from the FTP root directory

*  Select installer to be sent to the storage device

* Display FTP Log information.
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Install Control Section

The Install Control Section contains the following functions:

¢ The device information table:

IP Address
Device type
Install Status
Version
Revision

Current version of the firmware package running on the device

*  Table operation buttons:

Add button adds new entries to Device Information table.

Update Status button reloads status, version, and packages information of the selected
device entries in the table.

Discover button retrieves and displays information on all the devices that respond to the
application broadcast.

Reboot button sends a restart command to the selected device entries in the table.
Remove Entry button removes all the devices entries that are selected in the table.

Start Install button issues the command that starts installing the selected package to the
selected devices.

This button is enabled when an install package is selected from the Install Packages list
and at least one device entry is selected from the device information table.

* Install Operation Command is composed of the following items:

URL field displays the command text that is passed to the device.

Option field displays the options associated with the command.

Monitoring Section

The Monitoring section contains the following functions:

» Install Status Monitoring table displays the upgrade status of the devices currently
upgrading.

« Remove Entry button removes the selected entries from the Install Status table.
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Running the Avid ISIS Upgrade Utility

The Avid ISIS installer DVD includes the Avid ISIS Upgrade Utility application and runs on
the Avid ISIS System Director.
To install an upgrade package:

1. Insert the Avid ISIS installer DVD into a laptop’s DVD drive and double-click
AvidUtilityISISTool.msi located in the following location.

DVD drive:\ISISUtilities
The installer file, installs the application on your laptop.

2. After the installation has completed, removed the DVD and click Start > Programs >
AvidUnityISIS > Unity ISIS Upgrade Utility from your laptop.

The Avid ISIS Upgrade Utility Window opens.
3. Click Add in the FTP Server section of the window.
A browser dialog box opens.
4. Browse to the location where the new (or old) install package is located.
5. Select the package you want added and click Open.
The dialog box closes and the selected package is added to the Install Package list.
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4. Avid Unity ISIS Upgrade Utility

—FTP Server
Install StorageBlade 1.5 41340.tgz
Packages [SwitchBlade_1.5_44490.1gz Add | Rernaove
Log Time Stamp I Message |
iew 1111342006 4:36:32 PM Waiting for incoming connections..
11715 e 1
11134
11132 Look in: [ 3 fip R e =
111342

‘

StorageBlade_1.5_41340.kqz Clear
SwitchBlade.tgz
SwitchBlade_1.5_41340.kgz

~Install Control———

IP Address | |p add add
192
On1e2 Update Status |
Egg Digcover |
Loz Reboot
0192 |
Hi Fermove Entry |
URL Iﬂp:ffind
Options I--nD_WE (5 e I j | Teem I Start [mstall |
~ Manitaring Files of type: IInstaII Files [“.tgz] j Cancel
Install 1P Addi ™ Open as read-only
Status .
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Fermove Entry

6. Click Discover to retrieve information on all the available devices.

7. Select the devices you want to update. (Click the check-box beside the IP Address device
entries in the table.)

8. Click Start Install to begin installing the selected package to the selected devices.

% The Start Install button is only enabled when an install package and at least one device entry are
selected.

The Install Status is displayed in the Monitoring section of the window. After the Install
Status shows complete, you can close the Avid ISIS Upgrade Utility.

To remove a package from the Install Package list:

1. Select the package you want to remove from the Install Package list.

2. Click Remove.
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Configuring Switch Redundancy for
Workgroup Servers

This appendix describes how to configure your ControlAir™, CountDown™, and Media Browse
/ Capture Manager servers in the Avid ISIS environment for Avid production network switch
redundancy Hot Standby Routing Protocol (HSRP) protection. Your server needs to have a dual
port network card. The basic theory is to connect one network port on the server to one switch
and the second network port to a second switch on the network. There is no configuration
required to Avid ISIS hardware or software. The switch redundancy is configured on the switch
(Cisco / Foundry) and server operating system.

Media Browse and CountDown Failover Process

Network Teaming is supported on the ControlAir, Media Browse, and CountDown servers
within the Avid ISIS shared storage network.
The following steps outlines the qualification process:
1. Configured dual network board for Teaming (See “Network Teaming Setup” on page 174).
2. Restarted the Media Browse or CountDown server.
3. Start your Media Browse clients on the server.

There are also switch configurations on the Avid ISIS installer DVD for HSRP/VRRP, see

the documentation that comes with your switch. For additional information on configuring
qualified switches, search the Knowledge Base for the Avid ISIS Ethernet Switch Reference
Guide.



Media Browse and CountDown Failover Process

Configuration Diagram

The following is an example switch redundancy configuration using AirSpeeds.
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C Configuring Switch Redundancy for Workgroup Servers

Network Teaming Setup

The following procedure describes how to configure a server on the Avid ISIS shared
storage network for failover protection using Teaming. The server requires a dual network
board. Each network port is connected to separate switches.
To setup Teaming:
1. Right-click My Network Places and select Properties.
The following Network Connections window opens.

" Metwork Connections =10l x|

File Edt Wiew Favorites Tools Advapced Help | :,'

* Folders | & (3 )(KJ|E|v

(3 Back - €3 - (T | - search

EDE
E—

Address |t}, Metwork Connections

Marne | Type | Stakus | Device Mamne

LAN or High-Speed Internet

ELocal Area Connection LAM or High-Speed Internet Connected InkeliR) PROJ 1000 MT Dual Port Metwork Connection
A Local Area Connection 3 LAN or High-Speed Internet Connected Intel{iR) PROJ 1000 MT Dual Port Metwark Connection #2
L Local Area Connection 4 LAN or High-Speed Internet Disabled InkeliR) PROJ 1000 XF Server Adapter
Wizard
|5 Mew Connection Wizard Wizard
q | 1o

2. Select one of the network connections to be involved.

Ensure both network connections to be involved in the Team are enabled.
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Network Teaming Setup

3. Right-click the network connection and select Properties.

-4 Local Area Connection Properties e

General | Authertication I Advanced I

Connect uzing:

I@ IntellR] PRO/1000 MT Dual Port Met

Thiz connection uges the following items:

O ,@ MNetwaork Load Balancing
,@ Filz and Printer Sharing for Microzaft Metwaorks

I:I| T IntelR] Advanced Metwork, Services Protocal it
4 3

Install... | Urinstall | Froperties |
— Description

Allaws pour computer to access resources on a Microzoft
netwwork.

¥ Show icon in notification area when connected
[V Matify me when this connection has limited or no connectivity

QK Cancel

4. Click Configure.
5. Click the Teaming tab.

175



C Configuring Switch Redundancy for Workgroup Servers

6. Select the “Team with other adapters” radial button and click New Team.

Fower Management |
Advanced

WLANS I Drivver I
General I Link I

in‘tele Adapter Teaming

Teaming options:

Teaming

¢ Do not team this adapter

" Express: Team all ports on this adapter

Mew Team... |
Tiear:
I Mo teams available ﬂ Broperties. . |

Team with ather adapters

'@ To help pratect vour security, Internet Explorer has restricked X
this filz fram shawing active content that could access vour ...

Teaming allovws you to group multiple adapters into & single team ﬂ
that:
& Supports YLARNS

=l
& Tisnnrts mailinle taom burnas far mact Intal adartars

oK I Cancel I

7. Specify a name for the Team and click Next.

New Team Wizard

‘wielcome ta the Intel(R] PRO Adapter Mew Team ‘wizard

Specify a name for the team:
IMADISISMB2

'{;J To help protect vour security, Internet Explorer has

x
restricted this file fram showing active content that could...

Advanced Metworking Services (ANS) team names are limited d
to 45 characters.

After you create the ANS team, you can vievy and modify ts
=ettings on the Settings tab in Team properties.

For more information skout AMS teaming, click here.

[
< Back I Mext > I Cancel |
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Network Teaming Setup

8. Select which network adapters to be included in the Team and click Next.

MNew Team Wizard

x|

Select the adapters to include in this tean:

on
IntellR)] PROA000 MT Dual Port Metwork, Conrection #2

':g) Ta help protect your security, Internet Explorer has x
restrictad this file Fram showing active content that could. ..

The list showes the adapters that are available for Advanced ﬂ
Metworking Services (ANS) teaming.

Adapters that do not support ANS teaming or that are already
membiers nf annthee ANS or Froress tram are anavailable ;I

% Back I Mext » I Cancel |

9. Select “Switch Fault Tolerance” from the Team mode list and click Next.

MNew Team Wizard

x|
Select a team mode:
Adapter Fault Tolerance
Adaptive Load Balancing

Static Link Aggregation
|EEE 802.3ad D) ic Link &

Switch Fault Tolerance A

Switch Fault Tolerance (SFT) pravides a failover relationship
between two adapters when each adapter is connected to a
separate switch.

In SFT teams, one adapter is active and one adapter iz in

standby mode. In standiy mode, the adapter is inactive and

weaiting for failover to occur. t does not transmit or receive

netweark traffic. If the active adapter loses connectivity, the -
standby adapter automatically takes over. *

< Back I Mext » I Cancel I
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C Configuring Switch Redundancy for Workgroup Servers

10. Click Finish.

New Team Wizard

The wizard hag the zettings needed to create the team.

*t'ou can view and modify the settings for these adapters from the team
properties dialag.

x|

Cancel |

< Back

Windows processes the configuration. When complete, the Network Connections looks

similar to the following:

‘p_\ Network Connections

File Edit Wiew Favorites

Tools  Advanced  Help

=lolx|
| .'l':

o Back = £ - ¥ | ) Search

“ Folders | & [ x!’|-

Address |€}, Metwark Cannections

Hae

Mame

|T|:e

| Skakus

Device Name

. Local Area Connection

L Local Area Connection 3
L Local Area Connection 4
L Local Area Connection &

Wizard

LAN or High-Speed Internet

Lar or High-3peed Internet
Lar or High-3peed Internet
Lar or High-3peed Internet
Lar or High-3peed Internet

Wizard

Connected
Connected
Disabled

Connected

TEAM : MADISISMBZ - Intel(R) PRO{ 1000 MT Dual Port Metwork Connection
TEAM : MADISISMBZ - Intel{R) PRO{ 1000 MT Dual Port Metwork Connection #2
Intel{R) PRO{1000 XF Server Adapter

TEAM : MADISISMEZ

| *

11. By default the newly created Team uses DHCP. The network connection representing
the Team needs to be configured with a static IP address, possibly the same static
IP address used by one of the network adapters in the new Team.
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A

The following maintenance recommendations are not meant to be a troubleshooting guide but
more of a care and monitoring checklist for Avid ISIS. Typically the Avid ISIS does not need to
be power cycled. All components of the ISIS stack can individually be replaced or restarted
without interfering with the operation of ISIS stack.

Power cycling the entire stack (all the components at the same time) could risk the stability
of the ISIS stack.

For information on using the tools described in this section, see the Avid ISIS 7000
Administration Guide.

Minimum Storage Space Requirement

The recommended amount space you must maintain for background functionality and failures is
7% of free space in each Storage Group. In other words, you should not fill Storage Group more
than 93% full. Exceeding 93% used space can produce severe performance issues in some
situations.

To calculate the right amount of free space, log into the ISIS management Console and navigate
to the Storage Group window. For each Storage Group, take the Effective number and multiply
by 0.07. This will be your recommended free space in GBs. To assure that you Storage Group
never exceeds the recommended space, create a new workspace in this Storage Group with the
same size and label it “Headroom” and do not give anyone access to this workspace.

Daily Maintenance

The following contains a list of items you should do on a daily basis. It is estimated to take 15
minutes to perform these functions.

*  Check the Storage Elements status: Open the ISIS Management Console and click Storage
Elements.

- You should see a green circle beside the storage blade in the Name column

- Check the Status column for errors or Network Degraded
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The Status column in the Storage Elements report the status of the storage element
logged by the System Director. (The Status line in the Details area reports the same
information.) When the storage element maintains a working status, the
Administrator tool displays no entries in the Status field. If a problem arises, or
when the status of the storage element changes, the Administrator tool updates the
Storage Elements dialog box.

Check the Storage Blade Status and Switch Blade Status: Open the ISIS Management
Console and click Chassis.

You should see a green circle beside each chassis in the Serial Number column
Check the both Status columns for errors

When the chassis, switches and storage elements maintain a working status, the
ISIS Management Console displays no entries in the status field. If a problem
arises, or when the status changes, the ISIS Management Console updates the status
column and the Details area.

Start the Monitor Tool and check the front (ISBs) and back (ISSs, ISXs, and power
supplies) for errors.

You can hover your mouse pointer over a component and status details are displayed.
Errors display as red or yellow components, or as a warning icon on the component.

Check System Director Control Panel on the Active System Director for errors. On the
System Director Status tab, make sure there are no red indicators in the status box.

Check for green indicators beside the “System Director is running” and “Both paths
are up”

Check that a blue or green indicator is displayed beside “Replicated” on the Active
System Directory

If the event log indicator is not green, check the Windows Event logs on the Active
System Director

Check System Director Control Panel on the Standby System Director for errors.

Verify the Standby System Director is “Started” and in “Standby”” Mode. Check for
green indicators beside the “System Director is running” and “Both paths are up”

Check that a blue or green indicator is displayed beside “Receiving”



Weekly Maintenance

- Ifthe event log indicator is not green, check the Windows Event logs on the Standby
System Director

Check that the Avid ISIS Workspaces have “Free Space” available: Open the ISIS
Management Console and click Workspaces, see “Minimum Storage Space Requirement”
on page 179.

Weekly Maintenance

The following contains a list of items you should do on a weekly basis. It is estimated to take 30
minutes to perform these functions.

Review Windows Event logs on the Active and Standby System Directors

Check the ISB network connections between the ISBs using the ISB Connection Analyzer.
All Storage Elements should be green.

In the Avid ISIS Switch Blade Agent, run the Switch Infrastructure Diagnostics located in
the Advanced tab. Select all tests, both the left and right networks, and all chassis.

Do not run the switch diagnostics during heavy usage or critical network production times. Some
tests burden the system’s bandwidth and resources.

In the results page, save the diagnostic results by clicking the Download link and save the file
using the date as part of the file name.

Check the RAID status on the System Director.

- On the AS3000, click Start > Programs > Intel -> Intel Rapid Storage Technology
right-click the Intel Rapid Storage Technology icon in the task bar. The icon should be a
green check mark when the drives are healthy.

- On the SR 2500, click Start > Programs > RAID Web Console 2 > Start UI and see that
the Server Heath is green. If not, search www.Intel.com and search for Intel® RAID
Software User’s Guide for corrective actions.

- On the SR 2400 use the CIM Browser utility icon on the right-side of the taskbar. The
CIM Browser icon must be green (looks like a square). You can hover your mouse
pointer over the icon to see the utility name, double-click the icon to start the utility.

Make sure you have at least one storage element worth of free space (depending on the size
of your storage blades) for each storage group, see “Minimum Storage Space Requirement”
on page 179. If a storage blade should fail, you need enough space to remove the failed
storage blade.
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Monthly Maintenance

You should test a failover on a monthly basis. It is estimated to take 1 hour to perform this
function.

Take a snapshot — The ISIS Snapshot tool collects information currently displayed by
the ISIS Management Console and the Avid ISIS System Director Control Panel. Open
the ISIS Management Console and click Logging > ISIS Snapshot in the Advanced
section. Select Create new snapshot.

Perform System Director Primary to Secondary Failover — Turn off one of the System
Directors and verify in the System Director Control Panel that the Active Mode
indicator has turned red. Turn the System Director back on and see that Active Mode
displays Standby.

Before you turn off either System Director, verify that the metadata date stamp in the
Metadata Status tab in the saved and replicated. Fields should be current and updating
frequently.

Check the Redistribution status: Open the ISIS Management Console and click
Workspaces.

- The Redistribution column for each workspace should be blank, and have less than
10 configuration changes (see Config Changes column)

- Ifyou have 10 or more configuration changes, the status is highlighted in yellow
and displays “Requires Full Redistribution” in the Redistribution column

You should do a full redistribution at the next maintenance interval. Schedule a time
when the system is not heavily used, as this will allow the full redistribution to
complete in the shortest amount of time.

Redistribution Guidelines
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Do not perform an ISB firmware upgrade while a Redistribution is in process. Make sure all
firmware upgrades are completed before any redistribution is started. The following events
trigger redistribution:

Moving a Workspace

Clicking “Full Redistribution” on a Workspace
Adding a Storage Element to a Storage Group
Removing a Storage Element from a Storage Group

Changing the state of a Workspace to mirrored or unmirrored



Saving ISIS Metadata

If a firmware upgrade must be done and a redistribution in progress, do the following:
1. Suspend the active redistribution using the Advanced Commands in Workspace window.

2. Verify that the Workspace displays “redistribution suspended” in the Status column and all
other workspaces do not have “redistribution in progress” displayed.

3. Perform the firmware upgrade on the ISB(s) that must be upgraded.
4. Wait until the firmware upgrade is completed successfully.

5. Resume the redistribution using the Workspace window.

Saving ISIS Metadata

%

This procedure describes how to save the metadata stored on the system drives for the data
drives. You would typically only need to do this in a hardware replacement scenario, where both
System Director system drives are not going to stay with the data drives.

Regardless of how many Engines you have, all the metadata for all the data drives, in all of the
Engines, are saved on the System Director. The Engines do not store any metadata.

To save the System Director metadata:
1. Stop the System Director service using the ISIS Control Panel.
The System Director is constantly writing metadata. Metadata files are always open and locked,
so the best way to copy the metadata files is to stop the System Director service so the file are
closed.
2. Copy the Partition0 and Partition] files from the following location on the System Director:
D:\Program Files\Avid Technology\AvidUnityISISSystemDirector

There is also a PartitionDump.bin file. This file is also helpful when identifying the data on
the data drives. If possible, include this files with the two Partition metadata files.

The following are a couple suggested ways of saving the Partition0 and Partition1
PartitionDump.bin files.
- Use a USB flash drive that has the capacity for the Partitionx files (4 GB recommended).

- Create a network share on a client system on the network and copy the Partitionx files to
that shared folder.

3. Verify that you have the current copy of the Metadata by comparing the date in the Metadata
tab of the ISIS control Panel.

4. Start the System Director service using the ISIS Control Panel.
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Available Utilities

The following is a list of headings in the Avid ISIS 7000 Administration Guide that describe
other utilities and tools for monitoring and troubleshooting.

*  Avid ISIS System Director Control Panel
* ISIS Management Console
- Changing the Administration Password
- Setting up Error Notification
- Avid ISIS Snapshot Tool
- Using the Profile Tool
*  System Statistics
* System Logging
- Accessing the Logging Window
- Viewing Event Logs
* Avid ISIS Log Aggregator Tool
* Avid ISIS Disk Tester Tool
e Avid ISIS ISB Connection Analyzer Tool
* Avid ISIS Switch Manager Tool
e Avid ISIS Agents
- Agent Tools
- Log Viewer Tool
- Switch Infrastructure Diagnostics
*  Avid ISIS System Monitor Tool

*  System Director event message meanings

Client Manager Maintenance
If you suspect a poor connection between your client system and a mounted workspace, you

can test the Avid ISIS shared storage network connection between each client system and the
shared storage network using the Avid PathDiag tool. This tool informs you if there is
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sufficient read/write throughput for read and write operations needed by the client system. For
more information on using the Avid PathDiag tool see, Avid ISIS 7000 Client Manger Guide.
This guide also describes the following Administrative tasks:

Clearing Cached Data
Using Logs and Messages

Status Indicators and Troubleshooting

If the LEDs on the ISSs or ISBs are indicating a problem, identify the problem using the
information under, “Status LEDs and Stacking Problems” on page 131.

Complete Server Room Shutdown

%

There is no requirement to power cycle the entire Avid infrastructure but, if the need arises to
turn off all the equipment (such as a relocating the server room), turn off the components in the
following order. When turning on the component, use the reverse order.

To shut down the entire Avid network (server room):

1.

2 N 0 bk v

P et et
w N = o

Shutdown all Avid editing system and attached media I/O equipment, for example Avid
Mojo and Avid Adrenalines.

Shutdown all capture and playout servers such as AirSpeeds.

Shutdown CaptureManager Server.

Shutdown Interplay Transfer Server.

Shutdown Avid Interplay Media Services and Providers.

Shutdown Interplay Engine and Avid Interplay Archive Engine.

Shutdown Media Indexers — Do not stop the Media Indexer while it is indexing storage.
Shutdown Systems running Interplay Framework Multicast Repeaters.

Shutdown Systems running the Interplay Framework Lookup Service.

Invoke Failover on Avid ISIS System Directors.

. Shutdown Standby Avid ISIS System Director.
. Shutdown Primary Avid ISIS System Director.
. Shutdown Avid ISIS Engines.

14.

Shutdown the network switches.

Power up the entire rack of equipment in reverse order and verify all clients have mounted the
necessary ISIS Workspaces.
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I3 Adding and Replacing Hardware

This appendix provides procedures for adding and replacing components in your Avid ISIS. Avid
ISIS hardware additions and replacements are to be performed by Avid ISIS Avid Certified
Support Representatives (ACSR).

Do not add any hardware if there are any issues with the system. Correct all problems before
adding new hardware and making changes to the system, perform a quick checks to be verify that
the system is in good working order, see “Health Check” on page 137.

Adding Hardware

Use the following guidelines if a switch replacement is required. Typically hardware
replacement be performed after the software upgrade to avoid unnecessary downgrade and
upgrades of the firmware.

Be aware that all switch firmware is not compatible. Incompatible firmware does not stack
together and therefore cannot be upgraded in the normal manner. As a general rule, v1.0x
firmware switches do not stack with v1.1, v1.2, v1.3 and later switches and vice versa. Older
v1.1x switches will usually stack with newer rev 1.1x switches.

Avid ISIS v1.3 and later now ships with a standalone firmware Avid ISIS Upgrade Utility which
replaced the older “Laptop upgrade procedure.” This utility is suitable for upgrading (or
downgrading) any firmware version of switch. This utility should be on hand for any upgrade if
the normal upgrade procedure fails for any reason. This utility can be found at the root level of
the Avid ISIS v1.3 and later installer DVD in a folder called ISISUtilities. For details on the use
of this utility, see “Running the Avid ISIS Upgrade Utility” on page 170.

For more details on compatibility between firmware versions, search the online Knowledge Base
at www.avid.com/US/support for “ISIS firmware matrix.”

If you are replacing an existing switch in the stack, you do not need to add/remove chassis or do
anything to the stack. Use the following procedure to swap a switch.
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Switch Replacement

Switch Replacement

To replace an ISS or IXS switch:

1. Disconnect all network interconnect cables and remove old switch. (Power remains on at all
times.)

2. Insert new switch but do not attach the stacking cable yet.

3. Update switch to correct firmware (if necessary) using the Avid ISIS Upgrade Utility, see
“Avid ISIS Upgrade Utility” on page 165.

Install Avid ISIS Upgrade Utility on a spare computer or laptop.

b. Load the firmware package on your spare computer or laptop that matches the firmware
on your Avid ISIS.

Assign IP address on Laptop to 192.168.0.100.
d. Connect the Ethernet cable to the Management Port of the new switch.

e. Start the Avid ISIS Upgrade Utility. In the Install packages section select add and
browse to correct firmware package that you loaded on your spare computer or laptop.

f.  The utility should detect the switch on 192.168.0.10 automatically. If not, you can put in
the IP address manually.

g. Check the switch and select Start Install.

h. Monitor the upgrade via the Avid ISIS Upgrade Utility until complete. This takes about
20 minutes.

4. Once the switch is at the correct firmware and restarted, the stacking cable can be attached.

5. Verify that the switch is pingable via the correct stack IP address from another switch on the
same side of the stack (subnet).

Adding an Engine

This section covers the simplest configuration on adding an engine to a system (1 engine, 2
switches and 16 ISBs). If you are expanding a system with with v1.x hardware, see the v2.1.1 (or
earlier) Avid ISIS Setup Guide for detailed procedures.

To add an engine:
1. Rack engine in proper position.
2. Install power supplies, switches, and ISBs.
3. Apply power to the engine.

4. Allow chassis to boot fully, about 2 minutes.
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5. Update the firmware on each switch if necessary (see “Switch Replacement” on
page 187).

6. Add the left switch to the stack:
Open the switch web page on any switch on the left stack.

b. Click add/remove chassis. You should see the existing stack with the same number
of chassis as are currently in the system.

c. Click add chassis and then click OK. Wait for the request to get to all switches (all
bars turn green). Then immediately attach the stacking cable from the left IXS to
the switch. This should be at the ready state before clicking OK.

d.  Wait up to 5 minutes.

- If'the stacking procedure is successful, the new chassis (verify by serial
number) is now listed in the chassis list.

- Ifyou do not see it listed there after waiting and pressing F5 a few times,
disconnect the stacking cable and repeat steps ¢ and d until chassis is
successfully added to the stack.

7. Once the left switch is added to the stack, verify that the new switch is at the expected
IP address by pinging the new switch from another switch (not management IP). You
can get the IP address from the ISIS Management Console and click Chassis from the
list on the left and then click the Details tab on the new chassis serial number.

8. Attach the stacking cable to right switch and verify that the new switch is at the
expected IP address by pinging the new switch from another switch (not management
1P).

9. Once the switches are added and confirmed okay, update the ISB firmware and add the
ISBs to the filesystem.

a. Highlight new chassis in ISIS Management Console Chassis window and click
Upgrade Storage Blades,

b. Once upgraded, add the new ISBs to the filesystem. When added they become
Storage Elements listed as a Spare in the Type column.

c. Select all the new Storage Elements and add them to the Storage Group. Once in a
Storage Group they become Active in the Type column and a redistribution is
initiated. This can take several hours. The upgrade and client activity can continue
during this process.

% Do not go through the add chassis procedure a second time. The chassis has already been
added to the stack.

188



Engine Replacement

Engine Replacement

Use the following procedure when replacing an ISIS engine. For purposes of this procedure, the
engine to be replaced is referred to as “old chassis” and the replacement engine as “new chassis.”

To replace an ISIS engine:
1. Note the engine serial number on the front of the old chassis. Serial numbers are adhered on
the rack-mount ears of the Avid ISIS Engine (under the plastic screw covers, if installed).

If you have not already noted the host names, passwords, IP address, and other important
network details, see “Preupgrade Information” on page 159.

2. Log into the ISIS Management Console and get details on the old chassis (use the serial
number that you record on the front) and note the left and right IP addresses.

3. Disconnect the CX-4 interconnect cables from the old chassis.

4. Disconnect the 1-Gb connections and any 10-Gb (optical) connections from old chassis.

5. Open a Switch Agent Web page of any Zone 1 client on the left side.

Open the Switch Agent page via the Info button on the engines details page. For more details, see
the Avid ISIS 7000 Administration Guide.

6. Click the System tab > Add/Remove Chassis.
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7.

10.
11.

12.

13.
14.
15.
16.

Find the serial number of the old chassis in the Serial Number list and click the “Delete”
button for that chassis.

';*i' Avid ISIS Integrated Ethernet Switch Blade ||

172.20.120.213 [ iss2-single-user

Tools  Logging B0 Logout

3y Add a chassis
Overview Subimmit a request to add a chassis inta the system
Configuration T
Basic

Set stack password
p AddRemove chassis
Reboot a chassis

Flush chassis manager Serial Number ChassisID Action
logs

Set chassis manager log CRIG44048 0 Delete |

level
CRIS50026 1 Delete |
10 Gb Link Aggregation

View current settings CRIZ50014 2 Delete |
Create new group

YRIT25031 E Delete
Enable Disable _I
Restart CRIG25100 4 Delete |

Delete configuration
Configure failover policy YRIT 35027 5 Delete |

Remove a chassis

. Wait for the operation to be completed (all chassis in the list displays green and “The

configuration request completed successfully” is displayed).

The old chassis serial number should no longer be listed in the Serial Number list.

. Power-off the old chassis by pulling a single power cord and then pulling the remaining

two power cords simultaneously.
Carefully remove all ISBs from the old chassis and put them in a safe place.

Carefully remove both switches from the old chassis, noting from which side of the
chassis each switch was removed. Put them in a safe place.

Carefully remove all three power supplies from the old chassis and put them in a safe
place.

Remove the old chassis from the rack.
Install the new chassis into the rack (without the ISBs, switches, and power supplies).
Carefully reinsert all ISBs.

Carefully reinsert the three power supplies.



Replacing an Internal System Director Drive

17. Carefully reinsert both switches into the original position in which they were in on the old
chassis. Do not reconnect any cables at this time.

All thumb screws should be secured and snug.

18. Power-on the new chassis by simultaneously inserting two of the power cords and then the
third.

Give the new chassis at least 3 minutes to initialize and when all ISBs have solid green
LEDs.

After 3 minutes if the ISBs are all blinking green in unison, call Avid Customer Support.

19. Reattach the CX-4 interconnect cables to the left and right switches

20. Go back to the Switch Agent Web page (use any left switch other than the one being added).
Select Configuration > Add/Remove chassis. The new chassis serial number should now be
listed in the Serial Number list.

21. Go to tools and select ping. Enter the left I[P address noted in step 1. Both switches in the
new chassis should now be pingable.

22. Reconnect any 1-Gb and 10-Gb cables that were disconnected earlier.

23. Verify the proper operation of both stacks by running the Path Diag from a client in each of
the following locations: Zone 1 left, Zone 1 right, Zone 2 left, Zone 2 right, and Zone 3.

Replacing an Internal System Director Drive

There are two system drives installed in the Avid ISIS Engines. The two drives are mirrored and
accessible from the rear of the Engine. If you have a failure on either one of the two system
drives you can pull the failed drive out of the Engine and install a replacement without turning
off the Avid ISIS Engines. The Avid ISIS continues to run properly if one of the two system
drives are removed.

As soon as you install a replacement system drive into the vacant system drive slot, the .the
system begins the process of creating a mirror of the original drive on the new drive. All Avid
ISIS operations continue to run uninterrupted.

The drive carriers for the system drives are locked to avoid them from opening during shipment.
The plastic drive carrier key is mounted on the rear of the Engine beside the system drives.
To replace the System Director drive:

1. Remove the failed drive from the front of the System Director by releasing the drive latch on
the front of the drive and pulling the drive from the chassis.

2. Insert the new drive completely into the open drive slot and close the drive latch.

The new drive initiates and completes the repair with no other intervention.
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Replacing the System Director
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Use the following procedure if you are replacing your System Director to a newer model
server. This includes updating from a 32-bit System Director to a 64-bit System Director, or
updating the Intel® SR2400 or SR2500 to the AS3000. Before you start the System Director
replacement procedure:

* Install the new System Director into the rack. If planning a Standby System Director,
also install the second System Director into the rack.

The new Standby System Director is configured after this new Active System Director is
running, see “Adding a System Director to an Existing File System” on page 118.

« Install the Avid ISIS v2.0 or later software on the new System Director, see “Software
Upgrade” on page 139.

*  Make sure your existing Active and Standby System Directors are healthy, verify that
the system is in good working order. Do not upgrade to the new System Director if there
are issues with the old System Director, see “Health Check™ on page 137.

*  Update the software on existing Active and Standby System Directors to the same Avid
ISIS version as the new System Director, see “Software Upgrade” on page 139.

Avid has shipped the Intel SR2500 System Director with a 32-bit operating system and

9 MB of memory. If you have this model System Director and want to upgrade to a 64-bit
operating system, you must purchase a Windows 64-bit operating system license and
re-image the 32-bit Intel SR2500 System Director.

*  Save your current version of the metadata, see “On the old servers that are being
removed:” on page 192.

* Load the Windows operating system, see “Reinstalling the Windows Storage Server
2008 Operating System” on page 198. This is not necessary if you have purchased a new
System Director.

*  Import the current version of the metadata, see “On the new server that is to become the
active System Director:” on page 193.

On the old servers that are being removed:

1. Identify the existing Standby System Director and stop the System Director service via
the ISIS Control Panel.

2. Identify the existing Active System Director and stop the System Director service via
the ISIS Control Panel.

3. On the Active System Director, locate and preserve the “D:\Program Files\Avid
Technology\AvidUnityISISSystemDirector\PartitionDump.bin” file.

This file is an exported version of the metadata.
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4. Copy the PartitionDump.bin file into a temporary directory on the new System Director that
is to become the new Active System Director.

The Avid System Director software prevents you from creating a shared folder on the
System Directors. The following are a couple suggested ways of moving the
PartitionDump.bin file.

- Use a USB flash drive that has the capacity to move the PartitionDump.bin file.

- Create a network share on a client system on the network and copy the
PartitionDump.bin file to that shared folder. From the new System Director copy the
PartitionDump.bin file into the temporary folder.

On the new server that is to become the active System Director:

1. Verify that you have the current copy of the PartitionDump.bin file from the old Active
System Director.

2. Start the Avid ISIS System Director Control Panel application.

3. Configure the virtual name and IP address on the new Active System Director to match the
old Active System Director.

Configure the virtual name and IP address using the functions in the Configuration tab of the
ISIS System Director Control Panel.

4. If using the same IP addresses as the old System Director, make sure to shut down the old
System Director first to prevent an IP conflict.

% 1t is acceptable to change the IP address scheme of the new System Director. It is not
recommended that you change the virtual ISIS name.

5. Click the “Create from Import” button in the Configuration tab. The System Director must
be stopped to enable this button.

L 8 s 3
System Director Status Configuration | Active Clients | Metadats Status | Advanced Settings |
~Server Control Operations ~ Configuration
Ghart Garver General Configuration
Stop Server Falower Configuration.
- Maiot File System Operations ~Tools————————————————
Create New Active.. Launch Viewer
Cieete New Standby.. |
Create From Impart,
Stz
Recorfigure File Syster..
Server is not unning
Delste File System.
Close Help
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6. You are prompted to navigate to the PartitionDump.bin file you saved on the Active new
System Director.

The file is copied to a location used by the Active System Director and its extension is
changed from bin to import.

D:\Program Files\Avid Technology\AvidUnityISISSystemDirector64\
PartitionDump.import

The Active new System Director creates a new file system and imports the metadata
from the file.

7. Move the Application Key (dongle) from the old System Director to the new System
Director.

8. Verify that the System Director is now running and Active. Start the Management
Console and verify that all workspaces are listed. If not, call customer support before
continuing.

9. Configure the new Standby System Director, see “Adding a System Director to an
Existing File System” on page 118.
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64-bit System Directors

This section describes the procedures to recover your Avid ISIS system drive by reinstalling
Windows Storage Server 2008 and Avid specific additions and changes.

This procedure restores only the Windows operating system and the hardware drivers. It does not
restore the Avid ISIS software. The Avid ISIS software must be reinstalled separately, after the
operating system recovery is complete. The version number of the image can be found in the
C:\IMAGE.TXT file on the root directory of the system drive.

& The Avid ISIS ships with a backup product recovery image on the D: or E: partitions of the
system drive. Avid highly recommends you copy the image to the 16 GB USB flash drive

provided with your Avid ISIS. When you perform a full product recovery of the Avid ISIS
system drive, you lose the product recovery image and the metadata on the system drive.

After reimaging the server the Administrator password is set to is-admin.

You might need to reinstall the Windows Storage Server 2008 operating system on your Avid
ISIS System Director if you are directed to do so by Avid Customer Support. The reinstallation
offers you two options:

*  Perform a Windows Storage Server 2008 installation to the entire system. This replaces all
the data from all the available partitions on your system drive. You can perform this
operation if you are initializing your system drive.

& You lose metadata if you restore all the partitions of the drive.

»  Perform this operation to replace only the operating system on your system drive. Typically
this removes the first partition (C:); the other partitions are not changed.

Creating a Product Recovery USB Flash Drive

Avid highly recommends you copy the image to the 16 GB USB flash drive provided with your
Avid ISIS as part of your initial setup. The following procedure describes how to create the
product recovery USB flash drive. The product recovery image is included on the E:\ partition of
the system drive.



F Using the Product Recovery USB for 64-bit System Directors

Once you have created the bootable USB flash drive using the Product Recovery tool, the
USB flash drive you will be able to re-install the operating system and drivers as it was
shipped from Avid.

& When you perform a full product recovery of the Avid ISIS system drive using the

196

product recovery USB flash drive, you lose the product recovery image on the D: or E:
partition of the system drive.

To create a product recovery USB flash drive:

1. Locate the 16 GB USB flash drive Avid provided with the Avid ISIS and insert it into
the front USB port.

2. Click “Create Recovery USB Drive” from the installer splash screen or double-click the
AvidRecoverylmageTool.exe file included in the software installer kit from the
following location:

\Tools 3rdParty\ISISUtilities\

% A direct link to this file is included in the software install splash screen (Create Recovery
USB Drive).

The Avid USB recovery image creator window opens.

£ Avid USB recovery image creator o ] oA |

Welcome to the Avid USE recovery image creator,

If wou haven't inserted wour USE Flash drive, do that now,

This program is used to transfer an 03 recovery image to a USE flash drive
which is then used to restore wour system to its original setup. Ta skart,
click. "3elect image' which will go to the direckory with the recovery image
that came with wour system, then continue on to skeps 2 and 3. Eject the
IJ3B Flash drive properly before removing.,

—3tep 1 - Select image file:
sh_recovery_data_Filesfisis_engine_ss2008_v s, ari Seleck image |

—Skep 2 - Select USE flash drive:

IKingstDn DataTraveler 2.0 j

—5kep 3 - Write image to USE flash drive:

| 0%, Wirite image |

Found a compatible drive, press "Write image' ko continue. .




7.

Creating a Product Recovery USB Flash Drive

Click Select Image to locate the product recovery image from D: or E: partition of the Avid
ISIS system drive (the tool’s browser opens to the E: partition by default, you might need to
browse to the D: partition to locate the .ari file).

Select the .ari file.

The Scan button becomes active when you select the image file. The “Select USB flash
drive” menu lists USB devices that are installed and capable of accepting the image file. If
the inserted USB flash drive does not appear in the drop down menu, verify the capacity of
the USB flash drive.

Click Scan.
Select the USB flash drive from the “Select USB flash drive” menu.
The Write image button becomes active when you select the USB flash drive.

Click Write image.

% Creating the product recovery image on the USB flash drive can take 18 to 45 minutes depending
on the capabilities of the USB flash drive.

8.

Click OK to acknowledge the warning about losing all previous data on the USB flash drive.

The Write image button becomes a Cancel button when the image is being created. If you
cancel the write image process, the process starts over from the beginning on the next
undertaking.

. Click Ok when process is completed.
10.

The USB flash drive appears in the taskbar as an icon. Remove the USB flash drive as
follows:

a. Double-click the USB icon in the taskbar. A pop-up menu appears with a list of attached
USB devices.

a. Select the USB flash drive with the product recovery image.
b. Click Stop.

c. Click OK to remove the selected USB device.

d. Remove the USB flash drive from the Avid ISIS.
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Reinstalling the Windows Storage Server 2008
Operating System
To reinstall the Windows Storage Server 2008 operating system from the Avid Product
Recovery flash drive:
1. Make sure all clients stop any activity and unmount their workspaces.
2. All clients need to exit Client Manager.
3. Locate the 16 GB USB flash drive with the Avid ISIS image.
4. Use the System Director Control Panel to stop the System Director.
5. Insert USB flash drive into the USB port in the system.

You must enter the BIOS with USB flash drive plugged-in to set correct drive boot order.

6. Select Start > Shut Down.
The Shut Down Windows dialog box opens.
7. Select Restart, and click OK.
The Windows Storage Server 2008 operating system restarts.
8. Press the Delete key several times during startup until you see “Entering Setup.”

9. Set the USB Drive to boot first. Navigate to the Boot tab > Hard Disk Drives > 1st Drive
and select “USB Kingston DataT.” The 2nd Drive setting changes to the “RAID: Intel
Volume.”

% Depending on the manufacturer of the USB flash drive, this USB selection in the BIOS might
change. The initial release of Avid ISIS includes a Kingston USB flash drive. This might not
be the manufacturer of the USB flash drive in future releases.

10. Select the Advanced tab > CPU Configuration, make sure the hyper thread option “Intel
HT Technology” is [Disabled].

11. Select the Advanced tab > IPMI Configuration, make sure ‘“Restore on Power Loss” is
set to [Last State].

12. Press F10 to Exit and Save your changes.
The system continues to start from the USB flash drive.

Wait until two windows appear, click on the blue window and select one of the available
options:

- Recover only the OS partition.

- Recover the entire system disk.
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When you recover the entire system disk, the recovery image on the D: or E: partition is
removed.

- Exit without doing a recovery.
13. At the prompt, type the number of the operation you want to perform:

» Ifyoutype 1 or 2, a warning screen opens, informing you that you are about to recover
the operating system. Continue with step 14.

p Ifyou type 3, the recovery quits to the Main menu. You need to type 3 again to get to
command window. Press Ctrl+Alt+Delete to quit in any of these windows.

14. A yellow screen appears type Y.
15. A red screen appears type Y.
The reimaging takes 20 to 30 minutes.
Q Do not remove the USB flash drive while performing the product recovery. If you remove
the USB flash drive an error is displayed stating it cannot write the Ghosterr.txt file. If the

USB flash drive was removed, you cannot continue the process by re-installing the USB
flash drive. You would have to start the recovery process from the beginning.

16. A gray screen prompts you to reboot. Type R, and quickly remove the USB flash drive from
the system.

Configure the operating system as described in the following section. The Apply Computer
Setup message is displayed for 3 to 5 minutes.

Configuring the System Drive Using Windows 2008
Storage Server Setup

After you recover the Windows Storage Server 2008 operating system, several system
parameters are set including a system Disk Check. The system restarts, and you are prompted to
enter the Windows activation key. This number is on the Windows Certificate located on the
right-side of the Engine top cover. You need this Windows number in the following procedure.

To set up the Windows operating system:

1. (If removed) Reconnect all the network Ethernet cables.

2. When the Product Key screen opens, type the Product Key from the Certificate of
Authenticity in the Product Key text box. The certificate is on the top of the Avid ISIS
Engine.
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& The Product Key Authenticity is verified with Microsoft through an Internet
connection. If you do not have the Avid ISIS connected to an in-house network, you
need to phone in your Product Key and get an Authenticity number back from
Microsoft.

The Windows Storage Server 2008 Setup utility starts, and the a dialog box opens
showing the License Agreement screen.

3. Select “I accept the agreement.”

4. Click Next.
The Avid ISIS Engine restarts (potentially more than once).

5. Log on as Administrator and is-admin as the password.

6. After your system restarts for the last time, customize the system and local settings. See
the Windows documentation for more information.

» Ifyou are outside the United States, customize the system and local settings.
»  You might want to create a new system administrator name and password.

» Company Name and Organization.

» Date and Time Settings.

» Network Workgroup and Computer Domain settings.

When the operating system is restored in the Avid ISIS Engine, a unique computer host
name is created based on the MAC ID of the system board. Each time you re-image
your Avid ISIS Engine, the same name will be generated. Although if you have changed

the computer host name of your Avid ISIS Engine, you need to reapply your computer
host name again.

7. Start the system and install Avid ISIS software, see “Loading the Software” on page 87.

Configuration Settings Not In The Image

After you recover the Windows Storage Server 2008 operating system, The following
settings need to be changed.
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Administrative User Password

The Administrator password needs to be set to never expire.

To change the administrator password expiration setting:

1.

S

Click Start > Settings > Control Panel and select Administrative Tools.

2. Double-click Local Security Policy.

3. Expand Account Policy in the left pane and select Password Policy.
4.
5

Double-click Maximum password age in the right pane.

. In the Local Security Setting tab, set the password to expire in 0 days (password will not

expire).
Click Apply.

Click OK and close all open windows.

Network Port Configuration Settings

The following changes need to be made in the Intel Pro Properties settings.

ISIS Engine Intel Pro/1000 Network Port Settings

Option Setting
Flow Control Disabled
Interrupt Moderation Off
Receive Buffers 1024
Transmit Buffers 1024
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202

To set up network port properties:

1. Right-click the Network icon on the desktop and select Properties.

The Properties dialog window opens.

2. Click Manage Network Connections.

_E‘ Control Panel’,Network Connections
P = N = =
I | & = Metwork Connections - l‘i’] ISearch O]
File Edit ‘iew Tools Advanced Help
Organize ¥ = Views ¥ (7]
Marmne |v| Status |-| Device Marne |-| Connectiviky +
& (top-left) port 1 Metworl Inkel(R) 52567LM-4 Gigabit M.,  Access to Local only
W (top-right) prol000-port 2 Metwinrk, Inkel(R) PROJ1000 PT Dual Po...  Access ko Local only
W (bottam-right) prol000-port 3 Tetwork, Inkel{R) PRC{1000 PT Dual Po...  Access ko Local only
& (bottom-left) port 4 Metwinrk, Inkel(R) G2574L Gigabit Metw...  Access ko Local and
<] | 2
|? items &

3. Right-click the first Pro 1000 network port and select Properties.

4. In the Properties dialog box select Internet Protocol Version 4 (TCP/IPv4) and click

Configure.

5. If ask to confirm any changes, click Yes.



6. Click the Advanced tab.

Configuration Settings Not In The Image

Intel{R) PRO/1000 PT Dual Port Server Adapter Properties
Teaming I WLAMz I Diriwer I Details
General I Link Speed Advanced | Power Management
( |nte|*J Advanced Adapter Settings
Setkings:

Interrupk Moderation ;I Properties
Jurmnba Packet

Large Send Offload w2 {IPwd)

Large Send Offload w2 (IPwE)

Locally Administered Address

Log Link State Event

=
Performance Options
Configures the adapter to use settings that can improve adapter :I

performance.

-]

[ o ]

Cancel |

7. Click the Performance Options in the Setting list.
8. Click Properties.

9. Click Flow Control and set the Value to Rx&Tx Enabled.

10.
11.
12.
13.
14.
15.
16.
17.
18.

Click OK to close the Performance Options.
Click the Power Management tab.

Restart the Avid ISIS Engine.

Click Interrupt Moderation Rate and set the Value to Off
Check that the Receive Buffers and set the Value to 1024.
Check that the Transmit Buffers and set the Value to 1024.

Deselect the reduce link speed during standby power saving option.
Click OK to close the Server Adapter Properties dialog box.
Repeat steps 3 through 15 to configure the second Intel Pro 1000 port.
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This section provides information on the dimensions and weight, the environmental, the
electrical, and the power cord specifications for the Avid AS3000 when used as the ISIS 7000
System Director. It also recommends the use of an Uninterruptible Power Supply and supported
network cabling.

Dimensions and Weight

The following table lists the dimensions and weight.

Component Dimensions and Weight

Component Height Width Depth Weight

AS3000 System Director 1.75in (444 mm) 19in(482.6 mm) 27 in (685.8 mm) 40.01b (18.1 kg)
with drives installed

Environment

The following table lists the environmental specifications.

Environmental Specifications

Operating Operating Storage
Component Temperature Humidity Temperature
AS3000 System Director 32°F to 104°F 5% to 95% (at 38°C) —4°F to 140°F

(0°C to 40°C) non-condensing (—20°C to 60°C)




Electrical

Electrical

The following table lists the electrical specifications.

Electrical Specifications

Component Voltage Frequency Watts (Max. U.S.)

AS3000 System Director 100 to 240 Vac 50 to 60 Hz 650 W

Two hot-swap
redundant AC power
supplies

Uninterruptible Power Supply (UPS)

Avid highly recommends you create a separate derived power system for your ISIS 7000 System
Director. This provides protection against sudden power surges or losses that could cause you to
lose files or experience data corruption.The power outlets need to be from the same distribution
panel. This helps prevent ground loops that can be caused by plugging equipment into power
sources with different ground potentials. Make sure there is adequate, dedicated power for the
UPSs.

& You should have all the electrical work at your site done by a licensed electrician. The
electrical changes must meet country, state, and local electrical codes.

The ISIS 7000 System Director supports UPS devices that are connected using network
connections, USB connections, and serial connections. Install the software from the UPS
manufacturer for advanced shutdown behavior, calibrate the UPS device. These software
packages also allow for a connected Windows server to send alerts to other Windows servers to
perform actions.

If your ISIS 7000 System Director is connected to a network, network policy settings might also
prevent you from completing this procedure. Make sure there is adequate power and the correct
receptacle type for each hardware component, the rack power strips, and the UPSes. Do not use
extension cords to plug in any of the hardware components.
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Supported Cabling

Avid supports the following cable types for connecting an ISIS 7000 System Director

system.

If you need run your cable greater distances, call Avid Customer Support for supported
cable and accessory information.

Supported Cables

Cable Connection
Type

Function

Connector Style and Maximum Cable
Length

Avid engine interconnect
CX-4 cable. Only
available from Avid.

Ethernet network cable,
CAT5e, CAT6, or CAT6a
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Connect engines. See
“Removing the Avid Engine
Interconnect Cable” on page 43
for proper removal.

Connects:

Ethernet Avid ISIS clients

System Directors and clients to
1 Gb ports on an ISS

Avid Interplay servers to shared
storage networks

Avid AirSpeed capture and
playback servers to shared
storage networks

Avid ISIS 7000 management
port to laptop

CX-4 connector
There are three supported lengths at this time:

1, 3, and 5 meters

RJ45 connector

100 Meters; If using CAT5e the cable must be
rated for 350 MHz for maximum length.

The minimum GigE cable length for Avid network
products is 6 feet or 2 meter.



Supported Cables

Supported Cabling

Cable Connection
Type Function

Connector Style and Maximum Cable
Length

Optical cables Connects:

10-Gb port of switch to optical
10-Gb port on the Avid ISIS
engine.

ISS 10-Gb optical port to switch
port

ISS 10-Gb optical port to 10-Gb
Ethernet Client

10-Gb Client to 10 Gb Switch
port

10-Gb Ethernet switch to 10-Gb
Ethernet Switch

The maximum length for 10 Gb Ethernet cable is
defined by the core diameter (measured in
microns) and modal bandwidth (in units of
MHz*km).

Avid supports multi-mode fiber cable using 850
nm transceivers (short distances). Specifications
for these cables can be found in the ISO 11801
structured cabling document.

MMF 62.5 micron cable Modal Bandwidth of:
(Overfilled Launch (OFL) Bandwidth, typical of
OM1 cable)

e 160 MHz*km at 26 meters
e 200 MHz*km at 33 meters
MMF 50 micron cable Modal Bandwidth of:

* 500 MHz*km at 82 meters (Overfilled Launch
Bandwidth, typical of OM2 cable)

* 2000 MHz*km at 300 meters (Effective Modal
Bandwidth, typical of OM3 cable)

Avid supports single-mode fiber cable using
1310 nm transceivers (long distances):

*  SMF ITU G.652.A/B 9 micron cable up to
10 km

When connecting to the 10 Gb port of the ISS module, it is important to follow two rules:

* Ensure that the cable has the required modal bandwidth for the distance of the run.

* Make sure that all multimode cables between an ISS port and the other end of the cable run are of the same

diameter (for example, 50/125 um or 62.5/125 um).

Single mode transceivers are Class 1 laser product per IEC 60825-1 Amendment 2(2001) and IEC
60825-2 1997. Operating this product in a manner inconsistent with intended usage and
specification may result in hazardous radiation exposure.
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Supported Cables

Cable Connection
Type

Function

Connector Style and Maximum Cable

Length

Avid ISIS
X2 optical transceivers

Avid ISIS
XFP optical transceivers

Avid ISIS
SFP+ optical transceivers

Transceiver used in:

Cisco® 4948 and 4900M

Transceiver used in:

Foundry FESX424 and
ISIS ISS1000

Transceiver used in:

ISIS ISS2000

SC connector
X2 = Cisco X2-10GB-SR for MMF
X2 = Cisco X2-10GB-LR for SMF
LC connector

XFP = 10G-XFP-SR for MMF
XFP = 10G-XFP-LR for SMF

XFP = Foundry 10G-XFP-SR
or Picolight XXL-SC-S45-21 for MMF

XFP = Foundry 10G-XFP-LR

or Bookham 10G-BASE-LR for SMF
LC connector

* SFP+ short range (SR)

Picolight PLRXPL-SC-S43-21-N
or Finisar FTLX8571D3BCL
or Avago AFBR-700SDZ for MMF

* SFP+ long range (LR)

Finisar FTLX1471D3BCL for SMF
Avago AFCT-701SDZL for SMF
JDSU JSH-01LWAA1 for SMF
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This document contains safety and regulatory information for Avid hardware.11

Warnings and Cautions

FCC Notice

Canadian Notice (Avis Canadien)

LED Safety Notices

European Union Declaration of Conformity
Disposal of Waste Equipment by Users in the European Union
Argentina Conformity

Australia and New Zealand EMC Regulations
Japan EMC Regulations

Korean EMC Regulations

Taiwan EMC Regulations

Warnings and Cautions

> BbB bbb

Never install equipment if it appears damaged.

Disconnect the power cord before servicing unit.

Only perform the services explicitly described in this document. For services or procedures

not outlined in this document, speak with authorized Avid service personnel.

Follow all warnings and cautions in the procedures.

Operate the device within its marked electrical ratings and product usage instructions.

If you need to replace a battery in an Avid hardware unit, be sure to use the correct battery
type. There might be a risk of explosion if a battery is replaced by an incorrect type.

Dispose of used batteries according to the manufacturer's instructions.

For products with a power switch the main power switch should remain accessible after

installation.
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(Hebrew Warnings and Cautions)
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FCC Notice

Part 15 of the Federal Communication Commission Rules and Regulations has established
Radio Frequency (RF) emission limits to provide an interference free radio frequency
spectrum. Many electronic devices produce RF energy incidental to their intended purpose.

Class A Equipment

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio frequency energy and, if
not installed and used in accordance with the instructions, may cause harmful interference to
radio communications. Operation of this equipment in a residential area is likely to cause
harmful interference, in which case the user will be required to correct the interference at
personal expense.
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Canadian Notice (Avis Canadien)

Modifications
The FCC requires the user to be notified that any changes or modifications made to Avid

hardware that are not expressly approved by Avid Technology may void the user’s authority to
operate the equipment.

Cables

Connections to Avid hardware must be made with shielded cables with metallic RFI/EMI
connector hoods in order to maintain compliance with FCC Rules and Regulations.

Canadian Notice (Avis Canadien)

Class A Equipment

This Class A digital apparatus meets all requirements of the Canadian Interference-Causing
Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Réglement sur le matériel
brouilleur du Canada.

LED Safety Notices

|
Class 1 LED Product ‘

Avid hardware might contain LED or Laser devices for communication use. These devices are
compliant with the requirements for Class 1 LED and Laser Products and are safe in the intended
use. In normal operation the output of these laser devices does not exceed the exposure limit of
the eye and cannot cause harm.

Standard to which conformity is declared: (Class 1 Eye safe per requirements of IEC 60825-1 /
CDRH)
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(Hebrew LED Safety Notices)

LED 599 DY /,HN202 HIRMN

‘ Class 1 LED Product ‘

MY MYNTS 0MKIN AOX 0IPNN .NMWRN TMYS S pnn R LED mm 5535 mwy Avid namn
amb 1pnn Sw vban ,nban 1HYsna AxN winwb o'mva 01,1 Class 100 S M¥im LED mam
P15 0125 5127 1K ,pwn Sw novwnn nbaann N K

mw™T 5 1 Class 10N 1Y MMLA) NN TIXRNAT PN
(CDRH / 1-60825 IEC

European Union Declaration of Conformity
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C€

Declaration of conformity
Konformitétserklarung
Déclaration de conformité
Declaracion de Confomidad
Verklaring de overeenstemming
Dichiarazione di conformita

We/Wir/Nous/W1J/Noi:

Avid Technology
75 Network Drive
Burlington, MA, 01803 USA

European Contact: Nearest Avid Sales and Service Office or
Avid Technology International B.V.

Sandyford Industrial Estate

Unit 38, Carmanhall Road

Dublin 18, Ireland



European Union Declaration of Conformity

declare under our sole responsibility that the product,

erkldren, in alleniniger Verantwortung,dal dieses Produkt,
déclarons sous notre seule responsabilité que le produit,
declaramos, bajo nuestra sola responsabilidad, que el producto,
verklaren onder onze verantwoordelijkheid, dat het product,
dichiariamo sotto nostra unica responsabilita, che il prodotto,

Product Name(s): ISIS 7000
Model Number(s): 7020-30088-XX
Product Option(s): This declaration covers all options for the above product(s).

to which this declaration relates is in conformity with the following standard(s) or other
normative documents.

auf das sich diese Erkldrung bezieht, mit der/den folgenden Norm(en) oder Richtlinie(n)
iibereinstimmt.

auquel se référe cette déclaration est conforme a la (aux) norme(s) ou au(x) document(s)
normatif(s).

al que se refiere esta declaracion es conforme a la(s) norma(s) u otro(s) documento(s)
normativo(s).

waarnaar deze verklaring verwijst, aan de volende norm(en) of richtlijn(en) beantwoordt.
a cui si riferisce questa dichiarazione ¢ conforme alla/e seguente/i norma/o documento/i
normativo/i.

The requirements of the European Council:
Safety: Directive 2006/95/EC

UL 60950-1, 2nd edition
CAN/CSA-C22.2 No. 60950-1-07; 2007
IEC 60950-1, 2nd edition

EN 60950-1:2006

EMC: Directive 2004/108/EC

ENS55022:2006 /A1:2007
ENS55024:1998 /A1:2001 /A2:2003
EN61000-3-2:2006

EN60000-3-3:1995 /A1:2001 /A2:2005

Gerrett Durling, VP of Engineering, Shared Services

Issued In Burlington MA, USA 2010
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Disposal of Waste Equipment by Users in the
European Union

of with other waste. Instead, it is your responsibility to dispose of your waste equipment by
handing it over to a designated collection point for the recycling of waste electrical and
electronic equipment. The separate collection and recycling of your waste equipment at the
time of disposal will help conserve natural resources and ensure that it is recycled in a
manner that protects human health and the environment. For more information about where
you can drop off your waste equipment for recycling, please contact your local city recycling
office or the dealer from whom you purchased the product.

ﬁ This symbol on the product or its packaging indicates that this product must not be disposed

Argentina Conformity

TOV
Rheinland
L Argentina S.A.

Made in USA
Australia and New Zealand EMC Regulations

¢ N1709

Ken Hopkins

Avid Technology (Aust) Pty Ltd
c/o — Elliot House

Suite 810, Level 8

140 Arther St

North Sydney

NSW - 2060
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Japan EMC Regulations

Japan EMC Regulations

Class A Equipment

This is a Class A product. In a domestic environment this product may cause radio interference
in which case the user may be required to take corrective actions. VCCI-A

L_O)%% 3, IS AAIRHRFRINBEE T, COREERERETHEAT
BEBEESIZEITENHNET, CDFEICIIFERED 'ﬁtJJt;
i#%%a%?‘éi?gj(éné‘_c‘:b‘%b)iTo

VCCI—
Korean EMC Regulations

Class A Equipment

Please note that this equipment has obtained EMC registration for commercial use. In the event
that it has been mistakenly sold or purchased, please exchange it for equipment certified for
home use.

0l 7|7|E YFE(AZ) HAL

tE{st 77|12 B
OiA = S Ae 0| ME Fol5tAl7| diat
H, 7HE2e RFuMd AL Este 712 SEe=2
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Taiwan EMC Regulations
Taiwan EMC Regulations BSMI Class A EMC Warning

BEmgmE:
BAETHROWHAS  £EAHEEPRE
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Warning Statement
1. UV ray radiation

- Following statement or equivalent:
2% . FERGETELEEAUY &

- Following marking or other equivalent marking:

&h

2. Operator touchable area protection

Operation manual should have following statement and statement should be shown on
device, or put on similar sentence:

e
=K

fe b Al E) ER v
am = it 315 & B R HAt 504

3. Heat-related hazards
Injury may result from high temperatures under normal operating conditions, causing:
- Burns due to contact with hot accessible parts
- Degradation of insulation and of safety-critical components
- Ignition of flammable liquids
Examples of measures to reduce risks include:
- Taking steps to avoid high temperature of accessible parts
- Avoiding temperatures above the ignition point of liquids
- Provision of marking to warn USERS where access to hot parts is unavoidable

High temperature warning marking — you may use the following high temperature
warning marking:



Taiwan EMC Regulations

£\

4. Mechanical hazards
Injury may result from:
- Sharp edges and corners
- Moving parts which have the potential to cause injury
- Equipment instability
- Flying particles from imploding cathode ray tubes and exploding high pressure lamps
Examples of measures to reduce risks include:
- Rounding of sharp edges and corners
- Guarding
- Provision of SAFETY INTERLOCKS
- Providing sufficient stability to free-standing equipment

- Selecting cathode ray tubes and high pressure lamps that are resistant to implosion and
explosion respectively

- Provision of markings to warn USERS where access is unavoidable
5. Radiation

Injury to USERS and to SERVICE PERSONS may result from some forms of radiation
emitted by equipment.

Examples are sonic (acoustic), radio frequency, infra-red, ultraviolet and ionizing radiation,
and high intensity visible and coherent light (lasers).

Examples of measures to reduce risks include:

- Limiting the energy level of potential radiation sources
- Screening radiation sources

- Provision of SAFETY INTERLOCKS

- Provision of markings to warn USERS where exposure to the radiation hazard is
unavoidable

6. Chemical hazards

Injury may result from contact with some chemicals or from inhalation of their vapors and
fumes.
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Examples of measures to reduce risks include:

- Avoiding the use of constructional and consumable materials likely to cause injury
by contact or inhalation during intended and normal conditions of use

- Avoiding conditions likely to cause leakage or vaporization

- Provision of markings to warn USERS about the hazards

. Safety warning statement for equipment that is under hazardous voltages

. Equipment with touch current exceeding 3.5 mA

One of the following labels, or a label with similar wording, shall be affixed adjacent to
the equipment AC MAINS SUPPLY connection:

s

=3
=) JIL

BRI ARSI

9. An EUT that provides TELECOMMUNICATIONS NETWORK connection ports

for connection of multiple items of other telecommunications equipment shall not
create a hazard for USERS and TELECOMMUNICATIONS NETWORK
SERVICE PERSONS due to summation of TOUCH CURRENT
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10. Replaceable batteries

applies:

Taiwan EMC Regulations

If an equipment is provided with a replaceable battery, and if replacement by an incorrect
type could result in an explosion (for example, with some lithium batteries), the following

If the battery is placed in an OPERATOR ACCESS AREA, there shall be a marking

close to the battery or a statement in both the operating and the servicing instructions

If the battery is placed elsewhere in the equipment, there shall be a marking close to the

battery or a statement in the servicing instructions

The marking or statement shall include the following or similar text
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11.

i
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I

Warning to service persons

Suitable markings shall be provided on the equipment or a statement shall be provided
in the servicing instructions to alert a SERVICE PERSON to a possible hazard, where
both of the following conditions exist:

- Where a fuse is used in the neutral of single-phase equipment either permanently
connected or provided with a non-reversible plug

- Where, after operation of the fuse, parts of the equipment that remain energized
might represent a hazard during servicing

The following or similar wording is regarded as suitable:
N =
T =

MM/ P HERT BEARR



Index

Numerics

10-Gb cable 29
1-Gb cable 29

A

Access to system 52
Adding an engine 187
Adding hardware 186
Addresses

virtual 122
Administrator

password 195
After 199, 200
AirSpeed switch redundancy 173
Application key

install 92

installed 92
Argentina Conformity 214
Australia EMC regulations 214
Autorun.exe file 88, 144, 145
Avago 208
Avid

online support 13

training services 14

web site 90

B

Binding order 123
Boards, space for changing 52
Button

NMI 25

power 25

system reset 25, 25

C

Cable
10-Gb 29
CX-4 206
interconnect 29
length 206
micron 207
multi-mode fiber
Cable
Specifications 207
OM2, OM3 207
optical 207
remove interconnect 43
Cables
Category 5 or 6 206
connecting 43
discribed 43
space for connecting 52
supported 206
Canadian
interference causing equipment regulations 211, 215
Category 5 or 6 cables 206
Chassis See Engine
Checklist
health of system 137, 186
new install 18
preupgrade 159
software 15
Chunk sizes 30
CIM Browser utility
RAID utility 156
Cisco 208
Clearance 52
Client
architecture 36
maximum 36



Index

Client Manager

documentation 13, 87
Client Manager maintenance 184
Complete shutdown 185
Components, space for changing 52
Configure

Windows operating system 199, 200
Configure the Virtual Addresses 122
Connecting cables 43, 52
Connector

interconnect 30

USB 25
Control panel, System Director 24, 180
Crossover connection validation 121
CX-4 cable 206

D

Daily maintenance 179
Diagnostics

switch 181

switch infrastructure 158
Dimensions 204
Documentation

client software 13, 87
Drive

activity 25

flash 195
DVD

software installer 87

E

EIA rack units 51
Engine
adding 187
front view 27
interconnect 30
interconnect cable removal 43
power supplies 28
rear view 28
replacement 189
Environmental requirements 204
Ethernet switches 29
European Union notice 212

222

F

Failover
binding order 123
described 26
process for workgroup servers 172
servers 172
System Director 182
Fans 28
FCC notice 210
File system 20
Finisar 208
Firmware
incompatible 186
utility 165
Flash drive
recovery 195
USB 87
Foundry 29, 208, 208
Front panel controls, System Director 24
Full Redistribution 182, 182

G

Green LEDs 25

H

Hardware
adding components 186
Health check 137, 186
Health Monitor 123
HSRP (Hot Standby Routing Protocol) 172

Image version file 139
Infrastructure diagnostics 158, 181
Install software 87
Installation, in a rack 51
Installer

splash screen 88
Installer kit 87
Integrated switch 29
Interconnect

cable 29

connectors 30



Internal
space for changing drives 52
system drives 156
ISB (ISIS Storage Blade)
described 21
function 27, 27
password 72, 77
slot positions 27
ISIS Client Installers 90
ISIS SNMP Extension Agent 90
ISS (ISIS Integrated Switch)
described 22
LED 29
location 28
IXS (ISIS Expansion Switch)
described 22, 30
function 27
LEDs 30
location 28

J
JDSU 208

K
KVM switch 65

L
LED

IXS (ISIS Expansion Switch) 30

system drive 25

system ID 25

system status 25
Length, cable 206
Loading software 87

Maintenance
check system health 137, 186
Client Manager 184
daily 179
monthly 182
weekly 181
Management connection 29

Index

Maximum
number of clients 36
storage 30
Maximum length 206
Micron cable 207
Modal bandwidth 207
Monitor
VGA connector 65
Monthly maintenance 182
Multi-mode fiber cable 207

N

Naming convention 21
Network

activity LEDs 25

Teaming 174

zones 37
Network connection

binding order

Interplay Framework 123

New install checklist 18
New Zealand EMC regulations 214
NMI (non-maskable interrupt) button 25
Nomenclature 21

(0

Online support 13
Operating system
configure 199, 200
reinstall 198
Optical cable 29, 207
Optical transceivers 208, 208

P

Packets received 122
Password
administrator 195
ISB 72,77
storage blade 135
switch 135
System Director 24, 72, 135
PathDiag Tool 157
Picolight 29, 208
Port, management 29
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Power
button 25
cord connection 67
specifications 205
Power supply
described 28
location 28
Preupgrade information 159
Product descriptions 21
Product recovery, flash drive 195

R

Rack

installation 61

mounting instructions 51

position 54

rack units 54

requirements 52
Rack-mount

installation 51

requirements 52
RAID controllers 156
Rear panel, System Director 26
Received packets 122
Recommended maintenance 179
Recovery flash drive 195
Recreating file system 20
Red LED

System error 25
Redistribution 182, 182
Regulatory information 210
Reinstall Windows 198
Replace

engine 189

switch 187
Requirements for rack mounting 52

S

Safety information 210
Server room shutdown 185
Server Teaming 174
Servicing, space for 52
SFP+ 29, 208, 208
Shutdown server room 185
Snapshot tool 182

224

Software
installer described 89, 90
loading 87
Software upgrade 15, 139
Space for changing components 52
Specifications
dimensions and weights 204
environmental 204
power 205
Splash screen 88
Status messages
storage elements 180
Storage blade password 72, 77, 135
Storage elements 30
See also ISB
status 180
Storage Groups
adding ISBs 31
moving workspaces 32
Storage groups
size 30
Storage limit 30
Supported cables 206
Switch
adding 186
described 29
diagnostics 158
firmware utility 165
infrastructure diagnostics 181
KVM 65
redundancy AirSpeed configuration 173
replacement 186, 187
Switch blade password 135
System
drive LED 25
ID LED 25
reset button 25, 25
status LED 25
System Director
2U rack size 23
Control Panel 180
drives 156
failover 182
front control panel 24
front panel 24
image version 139
password 24, 72, 135



rear panel 26
recovery 195
second 26
software 90
System disk 24

T

Taiwan EMC regulations 215
Teaming 174
Training services 14
Transceivers 29, 207, 208
Troubleshooting 13
check health 137, 186
recommended maintenance 179

U

Upgrade
checklist 15
firmware utility 165
post upgrade verification 156
preupgrade checklist 159
procedure 139
See also Upgrade Utility
software 15, 139
Upgrade utility
functional description 165
location 170
main window 167
overview 165
procedure for running 170
software interface 167
USB (universal serial bus)
connector 25
flash drive 87, 195
keyboard and mouse 65
port described 25
Utility 156
list of available tools 184
upgrade firmware 165

Vv

Validate crossover connection 121
Verification of upgrade 156
Version of image 139

Index

VGA monitor 65
Virtual Addresses, configure 122

w

Weekly maintenance 181
Weight 204
Windows
event logs 181
reinstall 198
Workgroup server failover 172

X
XEP 29, 208, 208

Y4

Zone
examples 37
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